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1 Introduction

1.1 About this Manual

This manual describes how to set up and configure Slave devices, which
are described with GSDML files. These devices can be configured by use
of the netSLAVE DTM within a FDT Framework.

The manual provides information on how to set and configure the device
parameters of a Slave device using the netSLAVE DTM, and what can be
read from the diagnosis panes.

Descriptions for Gateway Devices

For gateway applications this manual provides descriptions of the
configuration and diagnosis of the primary network and secondary network
protocols of the different protocol conversions, which also can include
Master functionalities.

~ For the description of the configuration of the gateway and the driver
. settings as well as of the device assignment procedure for the respective

gateway application refer to the netGateway help.

Dialog Panes
The table below gives an overview for the individual dialog panes

descriptions:

Section Subsection Manual Page
Settings Overview Settings 31
Driver 34
Device Assignment 44
Firmware Download 50
Configuration Overview Configuration 57
Parameters of the Protocol — Overview Configuration Parameters 59
Real-Time Ethernet Systems 60
Fieldbus Systems 75
Serial Protocols 85
Overview Command Table and Signal Configuration 59
Command Table (Gateway) 110
Signal Configuration (Gateway) 105
Diagnosis Overview Diagnosis 127
Firmware Diagnosis 130
General Diagnosis 128
Extended Diagnosis Overview Extended Diagnosis 131
Tools Overview Tools 229
Packet Monitor 230
10 Monitor 233

Table 1: Descriptions Dialog Panes

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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1.1.1 Online Help
The netSLAVE DTM contains an integrated online help facility.
» To open the online help, click on Help or press the F1 key.
1.1.2 List of Revisions
Inde | Date Version Component Chapter | Revision
X
18 15-10-22 | 1.505.x.x netSlaveDTM.dII Safety information added throughout the
1.505.x.x netSlaveGUIl.ocx document.:

2,3.3, Chapter Safety, section Safety Messages on
Firmware or Configuration Download, section

4.5, Firmware Download and further safety
messages according to firmware and
configuration download.

6 Chapter Online Functions: Safety messages
according to firmware and configuration
download added.

19 17-03-27 | 1.1000.x.x netSlaveDTM.dII 1.4.1, Section Requirements Internet access added,
1.1000.x.x | netSlaveGUI.ocx Windows 8.1 and Windwos 10 added.

534 Section CC-Link Slave Parameters — Software

Version, Model Type updated.

Terminology adapted to current Sercos
convention (“Sercos” => “Sercos”).

Table 2: List of Revisions

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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1.1.3 Conventions in this Manual

Notes, operation instructions and results of operation steps are marked as
follows:

Notes

Important: <important note you must follow to avoid malfunction>

Note: <general note>

<note, where to find further information>

®@HNeQ

Operation Instructions

1. <instruction>

2. <instruction>
or

»  <instruction>

Results

D <result>

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Introduction

9/266

1.2 Legal Notes

Copyright
© Hilscher Gesellschaft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying materials (in the
form of a user's manual, operator's manual, Statement of Work document
and all other document types, support texts, documentation, etc.) are
protected by German and international copyright and by international trade
and protective provisions. Without the prior written consent, you do not
have permission to duplicate them either in full or in part using technical or
mechanical methods (print, photocopy or any other method), to edit them
using electronic systems or to transfer them. You are not permitted to make
changes to copyright notices, markings, trademarks or ownership
declarations. lllustrations are provided without taking the patent situation
into account. Any company names and product designations provided in
this document may be brands or trademarks by the corresponding owner
and may be protected under trademark, brand or patent law. Any form of
further use shall require the express consent from the relevant owner of the
rights.

Important notes

Utmost care was/is given in the preparation of the documentation at hand
consisting of a user's manual, operating manual and any other document
type and accompanying texts. However, errors cannot be ruled out.
Therefore, we cannot assume any guarantee or legal responsibility for
erroneous information or liability of any kind. You are hereby made aware
that descriptions found in the user's manual, the accompanying texts and
the documentation neither represent a guarantee nor any indication on
proper use as stipulated in the agreement or a promised attribute. It cannot
be ruled out that the user's manual, the accompanying texts and the
documentation do not completely match the described attributes, standards
or any other data for the delivered product. A warranty or guarantee with
respect to the correctness or accuracy of the information is not assumed.

We reserve the right to modify our products and the specifications for such
as well as the corresponding documentation in the form of a user's manual,
operating manual and/or any other document types and accompanying
texts at any time and without notice without being required to notify of said
modification. Changes shall be taken into account in future manuals and do
not represent an obligation of any kind, in particular there shall be no right
to have delivered documents revised. The manual delivered with the
product shall apply.

Under no circumstances shall Hilscher Gesellschaft flir Systemautomation
mbH be liable for direct, indirect, ancillary or subsequent damage, or for
any loss of income, which may arise after use of the information contained
herein.

Liability disclaimer

The hardware and/or software was created and tested by Hilscher
Gesellschaft fur Systemautomation mbH with utmost care and is made
available as is. No warranty can be assumed for the performance or

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017
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flawlessness of the hardware and/or software under all application
conditions and scenarios and the work results achieved by the user when
using the hardware and/or software. Liability for any damage that may have
occurred as a result of using the hardware and/or software or the
corresponding documents shall be limited to an event involving willful intent
or a grossly negligent violation of a fundamental contractual obligation.
However, the right to assert damages due to a violation of a fundamental
contractual obligation shall be limited to contract-typical foreseeable
damage.

It is hereby expressly agreed upon in particular that any use or utilization of
the hardware and/or software in connection with

e Flight control systems in aviation and aerospace;

¢ Nuclear fusion processes in nuclear power plants;

e Medical devices used for life support and

¢ Vehicle control systems used in passenger transport

shall be excluded. Use of the hardware and/or software in any of the
following areas is strictly prohibited:

e For military purposes or in weaponry;

e For designing, engineering, maintaining or operating nuclear systems;

¢ In flight safety systems, aviation and flight telecommunications systems;
¢ In life-support systems;

e In systems in which any malfunction in the hardware and/or software
may result in physical injuries or fatalities.

You are hereby made aware that the hardware and/or software was not
created for use in hazardous environments, which require fail-safe control
mechanisms. Use of the hardware and/or software in this kind of
environment shall be at your own risk; any liability for damage or loss due
to impermissible use shall be excluded.

Warranty

Hilscher Gesellschaft fir Systemautomation mbH hereby guarantees that
the software shall run without errors in accordance with the requirements
listed in the specifications and that there were no defects on the date of
acceptance. The warranty period shall be 12 months commencing as of the
date of acceptance or purchase (with express declaration or implied, by
customer's conclusive behavior, e.g. putting into operation permanently).

The warranty obligation for equipment (hardware) we produce is 36
months, calculated as of the date of delivery ex works. The aforementioned
provisions shall not apply if longer warranty periods are mandatory by law
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a
(1) BGB [Burgerliches Gesetzbuch; German Civil Code] If, despite of all
due care taken, the delivered product should have a defect, which already
existed at the time of the transfer of risk, it shall be at our discretion to
either repair the product or to deliver a replacement product, subject to
timely notification of defect.

The warranty obligation shall not apply if the notification of defect is not
asserted promptly, if the purchaser or third party has tampered with the
products, if the defect is the result of natural wear, was caused by
unfavorable operating conditions or is due to violations against our

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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operating regulations or against rules of good electrical engineering
practice, or if our request to return the defective object is not promptly
complied with.

Costs of support, maintenance, customization and product care

Please be advised that any subsequent improvement shall only be free of
charge if a defect is found. Any form of technical support, maintenance and
customization is not a warranty service, but instead shall be charged extra.

Additional guarantees

Although the hardware and software was developed and tested in-depth
with greatest care, Hilscher Gesellschaft fir Systemautomation mbH shall
not assume any guarantee for the suitability thereof for any purpose that
was not confirmed in writing. No guarantee can be granted whereby the
hardware and software satisfies your requirements, or the use of the
hardware and/or software is uninterruptable or the hardware and/or
software is fault-free.

It cannot be guaranteed that patents and/or ownership privileges have not
been infringed upon or violated or that the products are free from third-party
influence. No additional guarantees or promises shall be made as to
whether the product is market current, free from deficiency in title, or can be
integrated or is usable for specific purposes, unless such guarantees or
promises are required under existing law and cannot be restricted.

Confidentiality

The customer hereby expressly acknowledges that this document contains
trade secrets, information protected by copyright and other patent and
ownership privileges as well as any related rights of Hilscher Gesellschaft
fir Systemautomation mbH. The customer agrees to treat as confidential all
of the information made available to customer by Hilscher Gesellschaft fur
Systemautomation mbH and rights, which were disclosed by Hilscher
Gesellschaft fir Systemautomation mbH and that were made accessible as
well as the terms and conditions of this agreement itself.

The parties hereby agree to one another that the information that each
party receives from the other party respectively is and shall remain the
intellectual property of said other party, unless provided for otherwise in a
contractual agreement.

The customer must not allow any third party to become knowledgeable of
this expertise and shall only provide knowledge thereof to authorized users
as appropriate and necessary. Companies associated with the customer
shall not be deemed third parties. The customer must obligate authorized
users to confidentiality. The customer should only use the confidential
information in connection with the performances specified in this
agreement.

The customer must not use this confidential information to his own
advantage or for his own purposes or rather to the advantage or for the
purpose of a third party, nor must it be used for commercial purposes and
this confidential information must only be used to the extent provided for in
this agreement or otherwise to the extent as expressly authorized by the
disclosing party in written form. The customer has the right, subject to the
obligation to confidentiality, to disclose the terms and conditions of this
agreement directly to his legal and financial consultants as would be
required for the customer's normal business operation.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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Export provisions

The delivered product (including technical data) is subject to the legal
export and/or import laws as well as any associated regulations of various
countries, especially such laws applicable in Germany and in the United
States. The products / hardware / software must not be exported into such
countries for which export is prohibited under US American export control
laws and its supplementary provisions. You hereby agree to strictly follow
the regulations and to yourself be responsible for observing them. You are
hereby made aware that you may be required to obtain governmental
approval to export, reexport or import the product.

1.3 Registered Trademarks
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1
and Windows® 10 are registered trademarks of Microsoft Corporation.

CANopen® is a registered trademark of CAN in AUTOMATION -
International Users and Manufacturers Group e.V (CiA), Nirnberg.

CC-Link is a registered trademark of Mitsubishi Electric Corporation, Tokyo,
Japan.

CompoNet™, DeviceNet™ and EtherNet/IP™ are trademarks of ODVA
(Open DeviceNet Vendor Association, Inc).

EtherCAT® is a registered trademark and a patented technology of
Beckhoff Automation GmbH, Verl, Germany, formerly Elektro Beckhoff
GmbH.

Modbus is a registered trademark of Schneider Electric.

POWERLINK is a registered trademark of B&R, Bernecker + Rainer
Industrie-Elektronik Ges.m.b.H, Eggelsberg, Austria

PROFIBUS® und PROFINET® are registered trademarks of PROFIBUS &
PROFINET International (PI), Karlsruhe.

Sercos and Sercos interface are registered trademarks of Sercos
international e. V., Suessen, Germany.

All other mentioned trademarks are property of their respective legal
owners.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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1.4 About netSLAVE DTM

You can use the netSLAVE DTM to configure the Slave device within a
FDT Framework.

Devices and Protocols

Using netSLAVE DTM devices can be configured for the following
protocols:

As a Slave device: As a gateway device:

= Open-Modbus/TCP = EtherCAT
POWERLINK = EtherNet/IP
VARAN = Open-Modbus/TCP
» CC-Link = POWERLINK
= CompoNet = PROFINET IO

= Sercos

= VARAN

= PROFIBUS DP

= CANopen

= DeviceNet

» CC-Link

= CompoNet

= Modbus-RTU

= 3964R

= ASCII

= netSCRIPT

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
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141 Requirements

System Requirements

PC with 1 GHz processor or higher

Windows® XP SP3,

Windows® Vista (32 hit) SP2,
Windows® 7 (32 bit und 64-Bit) SP1,
Windows® 8 (32-Bit und 64-Bit),
Windows® 8.1 (32-Bit und 64-Bit),
Windows® 10 (32-Bit und 64-Bit)

Administrator privilege required for installation
Internet Explorer 5.5 or higher

RAM: min. 512 MByte, recommended 1024 MByte
Graphic resolution: min. 1024 x 768 pixel
Keyboard and Mouse

Restriction: Touch screen is not supported.

Note: If the project file is used on another PC,

= the other PC must also comply to these system requirements,

= the device description files of the devices used in the project must be

imported to the configuration software SYCON.net on the other PC,

= respectively the DTMs of the devices used in the project must be

installed on the other PC.

Requirements netSLAVE DTM

To configure a Slave device with the DTM the following requirements have
to be accomplished:

Completed hardware installation of a DTM-compatible cifX Slave device,
inclusive loaded firmware and loaded cifX configuration file

Installed FDT/DTM V1.2 compatible Frame application
Loaded DTM in the Device Catalog of the FDT frame application

: "_'\_ For more information to the hardware installation, please refer to the
|. ) corresponding User Manual of your device.
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1.5 Dialog Structure of the netSLAVE DTM

The graphical user interface of the DTM is composed of different areas and
elements listed hereafter:

1. A header area containing the General Device Information,

2. The Navigation Area (area on the left side),
3. The Dialog Pane (main area on the right side),
4. OK, Cancel, Apply, Help,
5. The Status Line containing information e. g. the online-state of the
utility.
General Device Information
Navi
gation :
Area Dialog Pane
OK Cancel Apply Help
Status Line

Figure 1: Dialog Structure of netSLAVE DTM
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151 General Device Information

Parameter Meaning

10 Device Name of the device

Vendor Vendor name of the device

Device ID Identification number of the device
Vendor ID Identification number of the vendor

Table 3: General Device Information

152 Navigation Area

The Navigation Area contains folders and subfolders to open the dialog
panes of the DTM.

Navigation Area =

Settings
= Driver
Device Assignment
Firmware Download
Configuration

Figure 2: Navigation Area

» Select the required folder and subfolder.

2 The corresponding Dialog pane is displayed.

Hide / display Navigation

(]| Hiding the navigation area (above right side).

M  show navigation area Opening the navigation area (below left side).

Gateway Devices

Navigation Area =

Configuration
= Configuration
Command Table*
Signal Configuration

Figure 3: Navigation Area - Configuration for Protocol Conversions
(*for devices with Master functionality)
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153 Dialog Pane

At the dialog pane the setting, the configuration or the diagnostic pane is
opened via the corresponding folder in the navigation area.

Settings

Driver

On the pane Driver you can select a driver from the driver list. For further information,
refer to section Driver on page 34.

Device Assignment

On the pane Device Assignment you select the device and assign the device to the
driver. For further information, refer to section Device Assignment on page 44.

Firmware Download

The dialog on the pane Firmware Download is used to load a new firmware into the
device. A detailed description can be found in section Firmware Download on page 50.

Configuration

Configuration

In the Configuration pane the parameters of the currently loaded firmware are displayed
and can be edited there, provided that a firmware has already been loaded. For further
information see section Overview Configuration on page 57.

Command Table

For Gateway applications with Master or Client functionality in the Command Table
pane you can define which data of the connected Slave or Server devices you want to
read or write automatically. For further information see section Command Table on page
110.

Signal Configuration

At the pane Signal Configuration the data structure of the in- and output signals is
provided. For further information see section Signal Configuration on page 105.

Diagnosis

Diagnosis/
Extended Diagnosis

At the Diagnosis panes diagnosis information can be read. For further information, refer
to section Overview Diagnosis on page 127 or section Overview Extended Diagnosis on
page 131.

Tools
Packet Monitor/ Under Tools the Packet Monitor and the 10 Monitor are provided for test and diagnosis
10 Monitor purposes. For further information, refer to section Packet Monitor on page 230 or

section IO Monitor on page 233.

Table 4: Overview Dialog Panes

online connection from the netSLAVE DTM to the Slave device .

Note: Accessing the Diagnosis panes of the netSLAVE DTM requires an
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154 OK, Cancel, Apply and Help

OK, Cancel, Apply and Help you can use as described hereafter.

Meaning

OK To confirm your latest settings, click OK. All changed values will be applied on the frame application
database.
The dialog then closes.

Cancel To cancel your latest changes, click Cancel.

Answer to the safety query Configuration data has been changed. Do you want to save the data?
by Yes, No or Cancel.

Yes: The changes are saved or the changed values are applied on the frame application database.
The dialog then closes.

No: The changes are not saved or the changed values are not applied on the frame application
database.
The dialog then closes.

Cancel: Back to the DTM.

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application
database.
The dialog remains opened.

Help To open the DTM online help, click Help.
Table 5: OK, Cancel, Apply and Help

155 Table Lines

In the DTM dialog pane table lines can be selected, inserted or deleted.

Meaning

4 To select the first line of a table use First Line.

To select the previous line of a table use Previous Line.

To select the next line of a table use Next Line.

b To select the last line of a table use Last Line.

Create a new Line inserts new lines into the table.

Delete selected Line deletes the selected line from the table.

R

Table 6: Selecting, inserting, deleting Table Line
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1.5.6 Status Bar

The Status Bar displays information about the current state of the DTM.
The current activity, e.g. download, is signaled graphically via icons in the

status bar.
=1[= Disconnected O Daba Set
1 2 3456
Figure 4: Status Bar — Status Fields 1 to 6
Status | Icon /Meaning
Field
1 DTM Connection States
ﬂf Connected: Icon closed = Device is online
<Jp= | Disconnected: Icon opened = Device is offline
2 Data Source States
[] Data set: The displayed data are read out from the instance data set
(database).
_['B_ Device: The displayed data are read out from the device.
3 States of the instance Date Set
/ Valid Modified: Parameter is changed (not equal to data source).
4 Changes directly made on the Device
'@ Load/configure diagnosis parameters: Diagnosis is activated.
6 Device Diagnosis Status
] Save operation succeeded: The save operation has been successful.
Further messages due to successful handling of device data.
@ Firmware Download: Firmware Download is running
@ Save operation failed: The save operation has failed.
Further fail operation messages due to incorrect communication due to
malfunction in the field device or its peripherals.

Table 7: Status Bar Icons [1]

Offline State

Save operation
succeeded

Firmware Download

Firmware Download
successful

Online State and
Diagnosis

2)l= Disconnected () Data Set

<)0= Disconnected | [ Data Set f sl |5awe operation succeeded
= Discannected [ Data Set (1 Firmware Dawnload

<)l= Disconnected [ Data Set |seall

ﬂ&: Connected i Cevice L

Figure 5: Status Bar Display Examples
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2 Safety
2.1 General Note

The documentation in the form of a user manual, an operating instruction
manual or other manual types, as well as the accompanying texts have
been created for the use of the products by educated personnel. When
using the products, all Safety Messages, Integrated Safety Messages,
Property Damage Messages and all valid legal regulations must be obeyed.
Technical knowledge is presumed. The user has to assure that all legal
regulations are obeyed.

2.2 Intended Use

The netSLAVE DTM serves for configuration and diagnosis of Slave
devices.

2.3 Personnel Qualification

Personnel responsible for the application of the network system shall be
aware of the system behavior and shall be trained in using the system.
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2.4 Personal Injury

To ensure your own personal safety and to avoid personal injury, you
necessarily must read, understand, and comply with the safety instructions
and safety messages in this manual before you configure your system.

24.1 Communication Stop

If you perform a firmware download or a configuration download via the

netSLAVE DTM be aware of the following:

e Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established

connections will drop.

e If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

¢ Unexpected equipment operation may cause personal injury.

e Stop the application program before starting upgrading the firmware or

downloading the configuration.

¢ Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware or downloading a configuration.

You find the description about the firmware download in section Firmware
Download on page 50 and about the configuration download in section

Download Configuration on page 125.

2.4.2 Mismatching System Configuration

Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected

equipment operation may cause personal injury.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Safety

22/266

2.5 Property Damage

To avoid property damage respectively device destruction and damage to
your system or to your equipment, you necessarily must read, understand,
and comply with the safety instructions and safety messages in this manual
before you configure your system.

2.5.1 Communication Stop

If you perform a firmware download or a configuration download via the
netSLAVE DTM be aware of the following:

Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

Damage of Equipment

Unexpected equipment operation may cause property damage.

Stop the application program before starting upgrading the firmware or
downloading the configuration.

Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before upgrading the firmware or downloading a configuration.

Loss of Device Parameters

Both the firmware download and the configuration download erase the
configuration data base. The firmware download overwrites the existing
firmware in the network device.

Device parameters that have not been saved non-volatile are getting lost
during the reset.

To complete the firmware update and to make the device operable
again, re-download the configuration when the firmware update has
been finished.

25.2 Invalid Firmware

Loading invalid firmware files could render your module unusable.

2.5.3 Mismatching System Configuration

Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause damage of equipment.
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2.6 Labeling of Safety Messages
e The Section Safety Messages at the beginning of a chapter are
pinpointed particularly and highlighted by a signal word according to the
degree of endangerment. The kind of danger is specified exactly by the
safety message text
e The Integrated Safety Messages within an instruction description are
highlighted with a signal word according to the degree of endangerment.
The kind of danger is specified exactly by the safety message text.
Signal Word Meaning (international) Meaning (USA)
Indicates a direct hazard with high risk, which Indicates a Hazardous Situation Which if not
will have as consequence death or grievous Avoided, will Result in Death or Serious Injury.
bodily harm if it isn't avoided.
Indicates a possible hazard with medium risk, Indicates a Hazardous Situation Which if not
which will have as consequence death or Avoided, could Result in Death or Serious
(grievous) bodily harm if it isn't avoided. Injury.
Indicates a minor hazard with medium risk, Indicates a Hazardous Situation Which if not
which could have as consequence simple Avoided, may Result in Minor or Moderate
battery if it isn't avoided. Injury.
Table 8: Signal Words in Safety Messages on Personal Injury
Signal Word Meaning (international and USA)
NOTICE Indicates a Property Damage Message.
Table 9: Signal Words in Safety Messages on Property Damage
In this document all Safety Instructions and Safety Messages are designed
according both to the international used safety conventions as well as to
the ANSI Z535.6 standard, refer to reference safety [S1].
In this document the signal words ‘WARNING’, ‘CAUTION' and ‘NOTICE' are used
according to ANSI Z535.6 standard. The meaning given in ISO/IEC 26514 [S4] section
‘11.11 Contents of warnings and cautions’ is not relevant in this manual.
2.7 References Safety

[S1] ANSI z535.6-2006 American National Standard for Product Safety Information in
Product Manuals, Instructions, and Other Collateral Materials

[S4] 26514-2010 - IEEE Standard for Adoption of ISO/IEC 26514:2008 Systems and
Software Engineering--Requirements for Designers and Developers of User

Documentation
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3 Getting started

3.1

Configuration Steps

The following table describes the steps to configure a device with
netSLAVE DTM as it is typical for many cases. At this time it is
presupposed that the hardware installation was done.

# Step Short Description For detailed information Page
see section
1 Load device catalog Depending of the FDT Container: -
For netDevice: (See Operating Instruction
- select Network > Device Catalog, Manual netDevice and
- select Reload Catalog. netProject)
2 Create new project / Depending of the frame application. -
Open existing project | For the configuration software: (See Operating Instruction
- select File > New or File > Open. Manual netFrame)
3 Insert Slave device Depending of the FDT Container: -
into configuration For netDevice: (See Operating Instruction
- in the Device Catalog under Gateway / Manual netFrame)
Stand-Alone Slave click to the Slave device,
- and insert the device via drag and drop
to the root line in the network view.
4 Open the netSLAVE Open the netSLAVE DTM configuration - -
DTM configuration dialog.
dialog - Double click to the device icon of the Slave.
- The netSLAVE DTM configuration dialog is
displayed.
5 Verify or adapt Driver | In the netSLAVE DTM configuration dialog: Settings for Driver and 32
Settings - select Settings > Driver, Device Assignment
¢ Note! For PC cards cifX the cifX and 34
Driver

Device Driver is preset as a
default driver. For all the other
Hilscher devices the netX Driver
is preset as a default driver.Use
the cifX Device Driver if the
netSLAVE DTM is installed on
the same PC as the
Slavedevice.

e Use the netX Driver to establish
a USB, Serial (RS232) or
TCP/IP connection from the
netSLAVE DTM to the Slave
device.

e The 3SGateway Driver for netX
(V3.x) is used only in
relationship with CODESYS.

To search for devices you can
check one or multiple drivers
simultaneously.

- Verify that the default driver is checked.
- If necessary, check another driver or
multiple drivers.
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#

Step

Short Description

For detailed information
see section

Page

Configure Driver

If you use the netX Driver, you respectively
must configure it.

For netX Driver and communication via
TCP/IP set the IP address of the device:

- Select Settings > Driver > netX Driver >
TCP Connection.

-Via[tladd an IP range.

- Under IP Address enter the IP Address of
the device or an IP range.

- Click Save.

Adjust the driver parameters netX Driver
USB/RS232 only if they differ from the
default settings.

Note!

e The cifX Device Driver requires
no configuration.

e The configuration of the
3SGateway Driver for netX
(V3.x) is carried out via the
CODESYS surface.

netX Driver

36

Assign Slave device
(with or without
firmware)

Assign the device to this driver.

In the netSLAVE DTM configuration dialog:
- select Settings > Device Assignment,

- select a Slave device (with or without
firmware),

- therefore check the appropriate checkbox,
- select Apply.

Selecting the Device (with
or without firmware)

a7

Select and download
firmware

If not yet a firmware was loaded to the
device:

- Adhere to the necessary safety precautions
to prevent personnel injury and property
damage that may occur in consequence of a
communication stop.

In the netSLAVE DTM configuration dialog:
- select Settings > Firmware Download,
- select Browse..,

- select a firmwatre file,

- select Open,

- select Download and Yes.

Safety Messages on
Firmware or Configuration
Download

Firmware Download

29

50

Assign Slave device
once more (with
firmware and system
chanal)

For repeated
download this step is
omitted.

In the netSLAVE DTM configuration dialog:
- select Settings > Device Assignment,

- select Scan,

- select the Slave device (with loaded
firmware and defined system channel),

- therefore check the appropriate checkbox,
- select Apply,

- close the netSLAVE DTM configuration
dialog via OK.

Selecting the Device once
more (with Firmware)

48

10

Configure Slave
device

In the netSLAVE DTM configuration dialog:
- select Configuration,

- set the configuration parameters for the
Slave to be used,

- close the netSLAVE DTM configuration
dialog via OK.

Overview Configuration
and

Parameters of the Protocol
— Overview Configuration
Parameters

57

59
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#

Step

Short Description

For detailed information
see section

Page

11

Create Signal
Configuration

In the netSLAVE DTM configuration dialog:
- select Configuration > Signal
Configuration

- Uncheck Disable advanced editing.

- Adjust Signal Names, Define Data Types,
Add Module or Signal.

- select Apply,

- close the netSLAVE DTM configuration
dialog via OK.

Signal Configuration

105

12

Save project

Depending of the frame application.
For the configuration software:
- select File > Save.

(See Operating Instruction
Manual netFrame)

13

Connect device

Depending of the FDT Container.
For netDevice:

- right click to the device icon,

- select Connect.

Connecting/Disconnecting
Device

123

14

Download
Configuration

- Adhere to the necessary safety precautions
to prevent personnel injury and property
damage that may occur in consequence of a
communication stop or in consequence of a
mismatching system configuration.

Depending of the FDT Container.
For netDevice:

- right click to the device icon,,

- select Download.

Safety Messages on
Firmware or Configuration
Download

Download Configuration

29

125

15

Diagnosis

Depending of the FDT Container.

For netDevice:

- right click to the device icon,

- select Diagnosis.

- The netSLAVE DTM diagnosis dialog is
displayed.

(1) Check whether the communication is OK:
Diagnosis > General Diagnosis > Device
status "Communication" must be green!
(2) "Communication" is green: Open thel 10
Monitor and test the input or output data.

(3) "Communication" is not green: Use
Diagnosis and Extended diagnosis for
troubleshooting.

- close the netSLAVE DTM diagnosis dialog
via OK.

Overview Diagnosis

127

16

10 Monitor

Depending of the FDT Container:

For netDevice:

- right click to the device icon of the Slave,
- select Diagnosis,

- select Tools > 10 Monitor.

- Check the input or output data,

- close the 1O Monitor dialog via OK.

10 Monitor

233

17

Disconnect

Depending of the FDT Container.
For netDevice:

- right click to the device icon,

- select Disconnect.

Connecting/Disconnecting
Device

123

Table 10: Getting started - Configuration Steps
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3.2 Configuration Steps for the Gateway

The following table describes the steps how to configure the primary
network and the secondary network protocols of the different protocol
conversions for gateway applications as it is typical for many cases. This
configuration must be done in the DTM dialog of the respective Slave or
Master device.

At this time it is presupposed that the hardware installation was done and
the gateway application is configured in the netGateway DTM dialog
(configuration of the gateway, driver settings and device assignment).

Step Short Description For detailed infor- Page
mation see section

Create new project / Depending of the frame application. -
Open existing project For the configuration software: (See Operating

- select File > New or File > Open. Instruction Manual

netFrame)

Insert Gateway device Depending of the FDT Container: -
into configuration For netDevice: (See Operating

- in the Device Catalog under Gateway / Stand- | Instruction Manual

Alone Slave click to the Gateway device, netFrame)

- and insert the device via drag and drop

to the line in the network view.
Open the Depending of the FDT Container: - -
netGateway DTM For netDevice:
Configuration Dialog - Double click to the device icon of the gateway.

- The netGateway DTM configuration dialog is

displayed.
Select Primary netGateway-DTM-Dialog: (See Operating -
Network and - select Configuration > Settings. Instruction Manual
Secondary Network - under Protocol Combination > Primary netGateway and User
Protocols and apply network (Port X2) select the primary network Manual for the

protocol. Gateway device)

- under Protocol Combination > Secondary

network (Port X3) select the secondary

network protocol.

- close the netGateway DTM configuration

dialog via OK.
If necessary enter If the gateway works as Master at the primary -
Slave into network, insert the Slave device as follows. (See Operating
Configuration at the Depending of the FDT Container: Instruction Manual
Primary Network For netDevice: netFrame)

- in the Device Catalog under Slave click to the

Slave device,

- and insert the device via drag and drop

to the gateway line in the network view.
Open the DTM Depending of the FDT Container: - -
Configuration Dialog For netDevice:
for Primary Network - right click to the device icon of the gateway,

- select Configuration > [Protocol Name

Primary Network].

- The DTM configuration dialog is displayed.
Configure Primary In the DTM configuration dialog: Overview Configuration | 57,
Network Protocol - select Configuration > Configuration, and

- set the configuration parameters for the Parameters of the 59,

respective primary network protocol. Protocol — Overview

If the gateway works as Modbus/TCP Client at Configuration

the primary network: Parameters,

- select Bus > Mode > ,Message Mode". 63,

- select Configuration > Command Table, Open Modbus/TCP

- define which data of the connected Server Parameters, 116

devices shall be read or written automatically, Command Table Open

- close the DTM configuration dialog via OK. Modbus/TCP
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# Step Short Description For detailed infor- Page
mation see section
8 If necessary enter If the gateway works as Master at the secon- -
Slave into dary network, insert the Slave device as follows. | (See Operating
Configuration at the Depending of the FDT Container: Instruction Manual
Secondary Network For netDevice: netFrame)
- in the Device Catalog under Slave click to the
Slave device,
- and insert the device via drag and drop
to the gateway line in the network view.
9 Open the DTM Depending of the FDT Container: - -
Configuration Dialog For netDevice:
for - right click to the device icon of the gateway,
Secondary Network - select Configuration > [Protocol Name
Secondary Network].
- The DTM configuration dialog is displayed.
10 Configure Secondary In the DTM configuration dialog: Parameters of the 59,
Network Protocol - select Configuration > Configuration, Protocol — Overview
- set the configuration parameters for the Configuration
respective secondary network protocol. Parameters,
If the gateway works as Modbus RTU Master at
the secondary network:
- select Bus > Mode > ,Master",
- select Configuration > Command Table, Modbus RTU 85,
- define which data of the connected Slave Parameters,
devices shall be read or written automatically, Command Table 110
- close the DTM configuration dialog via OK. Modbus RTU
11 Open the Depending of the FDT Container: - -
netGateway DTM For netDevice:
Configuration Dialog - Double click to the device icon of the gateway.
- The netGateway DTM configuration dialog is
displayed.
12 Configuration Gateway | - Proceed the Signal Mapping, (See Operating -
- Set the driver, Instruction Manual
- Proceed the device assignment, netGateway and User
- close the netGateway DTM configuration Manual for the
dialog via OK. Gateway device)
Signal Configuration 105
13 Save project Depending of the frame application. (See Operating -
For the configuration software: Instruction Manual
- select File > Save. netFrame)
14 Connect device Depending of the FDT Container. Connecting/Disconnecti | 123
For netDevice: ng Device
- right click to the device icon of the gateway,
- select Connect.
15 Download - Adhere to the necessary safety precautions to Safety Messages on
Configuration prevent personnel injury and property damage Firmware or 29
that may occur in consequence of a Configuration
communication stop or in consequence of a Download
mismatching system configuration.
Depending of the FDT Container.
For netDevice:
- right click to the device icon of the gateway, Download 125
- select Download. Configuration
16 Diagnosis Depending of the FDT Container: Overview Diagnosis 127

For netDevice:

- right click to the device icon of the gateway,
- select context menu Diagnosis > Gateway,
[Protocol Name Primary Network] or
[Protocol Name Secondary Network].

- The DTM diagnosis dialog is displayed.

- Continue with further device diagnosis,

- close the DTM diagnosis dialog via OK.
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# Step Short Description For detailed infor- Page
mation see section
17 Disconnect Depending of the FDT Container. Connecting/Disconnecti | 123

For netDevice: ng Device
- right click to the device icon of the gateway,
- select Disconnect.

Table 11: Getting started - Configuration Steps Gateway

3.3 Safety Messages on Firmware or Configuration Download

If you perform a firmware download or a configuration download via the
netSLAVE DTM adhere to the necessary safety precautions to prevent
personnel injury and property damage that may occur in consequence of a
communication stop or in consequence of a mismatching system
configuration. Also invalid or non-authorized firmware can damage your
device.

Personnel Injury

| A WARNING |
Communication Stop

= Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

= |f you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

= Unexpected equipment operation may cause personal injury.

= Stop the application program before starting upgrading the firmware or
downloading the configuration.

= Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware or downloading a configuration.

Mismatching System Configuration

» Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause personal injury.

For more refere to next page.
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Property Damage

NOTICE

Communication Stop

= Together with the firmware download, an automated device reset is
performed that will interrupt all network communications and established
connections will drop.

= If you attempt to download the configuration during bus operation, the
communication between Master and Slaves is stopped.

Damage of Equipment
= Unexpected equipment operation may cause property damage.

= Stop the application program before starting upgrading the firmware or
downloading the configuration.

= Make sure that your equipment operates under conditions that prevent
property damage . All network devices should be placed in a fail-safe
mode before upgrading the firmware or downloading a configuration.

Loss of Device Parameters

= Both the firmware download and the configuration download erase the
configuration data base and overwrites the existing firmware in the
device.

= Device parameters that have not been saved non-volatile such as a
temporary IP address are getting lost during the reset.

= Before you initiate firmware or a configuration download make sure that
your project configuration data are saved non-volatile in order to prevent
loss of configuration data.

= To complete the update and to make the device operable again, please
re-download the configuration when this operation has finished.

Invalid or non-authorized Firmware

= Loading invalid or non authorized firmware files could render your
module unusable. Only proceed with a authorized firmware update.

Mismatching System Configuration

= Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause property damage.
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4 Settings

4.1 Overview Settings

Settings Dialog Panes

The table below gives an overview for the individual Settings dialog panes
descriptions:

netSLAVE DTM Folder Name / Subsection Manual
Section Page
M avigation Area - Driver 24

Settings Verify or adapt Driver Settings 34

ey Drriver cifX Device Driver 36
Dev:-lcztisz:gner;ent netX Driver 36
Firmwware Dovwnload Configuring netX Driver 37
Navigation Area — Device Assignment 44
Settings (Example) Scanning for Devices 44
g‘iggiltzia(;/zzl drivers can be Scanning for all Devices or for suitable only 46
Selecting the Device (with or without firmware) 47

Selecting the Device once more (with Firmware) |48

Firmware Download 50

Table 12: Descriptions of the Dialog Panes Settings

_) Note: To edit the Settings dialog panes you need User Rights for
“Maintenance”.

Notice the descriptions in the section Settings for Driver and Device
Assignment on page 32.

To access to the online help with the descriptions of the drivers:
» Select Settings > Driver > [Name of the assigned driver].
> Press the F1 key.

For information on the Settings for gateway applications refer to the
Operating Instruction Manual netGateway and the User Manual for the
Gateway device.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Settings

32/266

4.2 Settings for Driver and Device Assignment

The following steps are needed to establish a connection from the
netSLAVE DTM to the Slave device:

Verifying or adapting Driver Settings

Verify the Driver Settings and adapt them if necessary.

1. Open the DTM configuration dialog.
> Inthe FDT container netDevice double click to the Slave device icon.

2. Verify that the default driver is checked and respectively check another
or multiple drivers.

» Select Settings > Driver.

Note! For PC cards cifX the cifX Device Driver is preset as a default
driver. For all the other Hilscher devices the netX Driver is preset as a
default driver.

= Use the cifX Device Driver if the netSLAVE DTM is installed on the
same PC as the Slave device.

= Use the netX Driver to establish an USB, Serial (RS232) or TCP/IP
connection from the netSLAVE DTM to the Slave device.

= The 3SGateway Driver for netX (V3.x) is used only in relationship with
CODESYS.

To search for devices on the network you can check one or multiple
drivers simultaneously.

» Verify that the default driver for your device is checked.

» If necessary, check another driver or multiple drivers.

Configuring Driver

Note!

= The cifX Device Driver requires no configuration.
= The configuration of the 3SGateway Driver for netX (V3.x) is carried
out via the CODESYS surface.

If you use the netX Driver, you respectively must configure it.
3. Configure the netX Driver if necessary.

For the driver netXDriver an individual driver dialog window can be opened
where you can configure the driver.

» Select Settings > Driver > netX Driver.

» For netX Driver and communication via TCP/IP set the IP address of
the device.

Adjust the driver parameters netX Driver USB/RS232 only if they differ
from the default settings.
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Assigning the Slave device to the DTM

4.

>
>
>
>

Scan for and select the devices (with or without firmware).

Select Settings > Device Assignment.

Under Device selection select suitable only or all and then Scan.
In the table check the required devices.

Select Apply.

Selecting and downloading the Firmware

o

© VvV V V

NV VvV Vv

If not yet a firmware was loaded to the device, select and download the
firmware.

Select Settings > Firmware Download.
Select and download the firmware via Download.
Select Apply.

Scan for and select the devices (with firmware and defined system
channel) once more.

For repeated download this step is omitted.
Select Settings > Device Assignment.
Select Scan.

In the table check the required device.
Close the DTM configuration dialog via OK.

Connecting the Device

8.
9.
%

In netDevice put a right-click on the Slave device icon.
Select the Connect command from the context menu.

In the network view the device description at the device icon of the
Slave is displayed with a green colored background. The Slave device
now is connected to the netSLAVE DTM via an online connection.

Further Information

~ For descriptions about these steps refer to the sections following here-
after.
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4.3 Driver

The Driver dialog pane displays the drivers to be used for a netSLAVE
DTM to establish a device communication connection.

Note! A default driver is set in the configuration software.

Driver
| Driver Version | 1D
CIFX Device Driver 1,101.1.9801 {368BEC5B-0E92-4C0E-B4AS-6HF G ZAETAAFA}
[0  3sGateway Driver for netX (V3.x) 0.9.1.2 {787CD3A9-4CF6-4259-8E4D- 109BEASEEAS 1}
[0  net¥Oriver 1.103.2.5183 {B54CBCCTF333-4135-6405-6E 12FCE3EES 2}
Figure 6: Default Driver ,cifX Device Driver’ for PC cards cifX
Parameter Meaning
Driver Name of the driver (for more details see descriptions hereafter)
Version ODMV3 Version of the respective driver
ID ID of the driver (driver identification)

Table 13: Driver Selection List Parameters

To establish a connection from the netSLAVE DTM to the Slave device,
verify if the default driver is checked and respectively check another driver
or multiple drivers.

4.3.1 Verify or adapt Driver Settings

Proceed as follows:
1. Select Settings > Driver in the navigation area.

2 The Driver dialog pane is displayed with the available drivers and the
setting for the default driver.

Driver
| Driver | Versian | 1D
CIFX Device Driver 1,.101.1,9801 {368BECSB-0ES 2-4C0E-B4A-64F6 2AETAAFA}
O 35Gateway Driver for nety (V3.x) 0.9.1.2 {787CD3A9-4CF6-4259-8E40- 109B6AGBEAT 1}
O net Driver 1.103.2,5183 {B54CaCCTF333-4135-8405-6E 1 2FCBBEER T}

Figure 7: Default Driver ,cifX Device Driver’ for PC cards cifX (example)

Driver
| Driver Version | 1D
I:I CIFX Device Driver 1.101.1.9801 {368BECSB-0ES 2-4C0E-B4A-64F 5 2AETAAFA}
D 35Gateway Driver for net¥ (V3.x) 0.9.1.2 {787C03A9-4CF6-4259-5E4D- 109B6ACBEAD 1}
netX Driver 1.103.2.5183 {B54CaCCTF333-4135-8405-6E 1 2FCBBEEA 2}

Figure 8: Default Driver ,netX Driver for Hilscher devices except for PC cards cifX (example)

2. Verify that the default driver is checked.

» Verify that the default driver for your device is checked.
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Default Driver (Pre-settings in the Configuration Software): For PC cards
cifX the cifX Device Driver is preset as a default driver. For all the other
Hilscher devices the netX Driver is preset as a default driver.

3. Respectively check another driver.

Note! The driver used for the connection from the netSLAVE DTM to the
Slave device must be supported by the device and must be available for
the device.

e Use the cifX Device Driver if the netSLAVE DTM is installed on the
same PC as the Slave device.

o Use the netX Driver to establish a USB, Serial (RS232) or TCP/IP
connection from the netSLAVE DTM to the Slave device.

e The 3SGateway Driver for netX (V3.x) is used only in relationship with
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH.

> Check the checkbox for the driver in the selection list.

4. Respectively check multiple drivers.

To search for devices on the network you can check multiple drivers
simultaneously.

Driver

| Driver

| Version | 1D

CIFX Device Driver
O 35Gateway Driver for nety (V3.x) 0.9.1.2 {787CD3A9-4CF6-4259-8E4D- 109B6AGBEAT 1}

nety Driver

1.101.1.9801 {368BECSB-0E92-4C0E-B4AT-04F6 2AETAAFA}
1,103.2.5183 {B54CACCTF333-4135-3405-6E12FC38EER 2}

Figure 9: Manual Selection of multiple drivers (Example)

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Settings 36/266

4.3.2 cifX Device Driver
In the netSLAVE DTM for the cifX Device Driver no driver dialog pane is
available, since for the cifX Device Driver no driver settings are required.

The cifX Device Driver will be used if the netSLAVE DTM is installed in the
same PC as the Slave device.

_) Note: To establish a connection from a DTM to a Slave device via the
cifX Device Driver, the cifX Device Driver must be installed and the
driver must have access to the Slave device.

4.3.3 netX Driver

The netX Driver is used to connect the DTM to the device via different
connection types. The DTM communicates with the device via an USB
connection, a serial (RS232) connection or a TCP/IP connection. The netX
Driver establishes

e via the USB interface of the device and the USB port of the PC an USB
connection to the device,

¢ via the RS232 interface of the device and the COM port of the PC a
serial connection (RS232) to the device

e and via Ethernet a TCP/IP connection to the device.

To connect the DTM to the physical layer of the device the netX Driver
software works in combination with the software components:

e “USB/COM connector” for the USB connection and for the serial
connection (RS232) and

e “TCP/IP connector” for the Ethernet connection.
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4.3.4 Configuring netX Driver

The following steps are required to configure the netX Driver:

USB/RS232 Connection

To set the driver parameters for an USB/RS232 connection note:

Note: Adjust the driver parameters netX Driver USB/RS232 only if they
differ from the default settings. After saving the changed driver
parameters, these parameters are used for the device assignment when
scanning devices.

For setting the driver parameters for an USB connection or a serial
connection:

1. Select Settings > Driver > netX Driver > USB/RS232 Connection.
» Set the driver netX Driver USB/RS232 parameters.

TCP/IP Connection

For setting the driver parameters for a TCP/IP connection:

1. Select Settings > Driver > netX Driver > TCP Connection.
Set IP Address of the device:

2
» Add an IP Range via Select IP Range D
3

Under IP Range Configuration > IP Address enter the IP Address of
the device (Use IP Range is unchecked).

Set IP Range:
Check Use IP Range.

» Under IP Range Configuration > IP Address enter the start address
(left side) and the ending address of the IP scanning range (right side).

5. Click Save, to save the IP address or the IP range.

R After saving the changed driver parameters, these parameters are used
for the device assignment when scanning devices.
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4.3.5 netX Driver - USB/RS232 Connection

The communication from the DTM to the device via an USB/RS232
Connection is used when the DTM is installed on a PC and between the
PC and the device

e an USB connection

e or a serial connection (RS232) exists.

The DTM accesses the device via the USB interface or via the RS232
interface. This requires either to connect an USB port of the PC to the USB

interface of the device using an USB cable or to connect a physical COM
port of the PC to the RS232 interface of the device via a serial cable.

The netX Driver / USB/RS232 Connection supports all physical and
virtual COM ports available on the PC.

Via the RS232 interface or USB interface, the device is configured or
diagnosis is performed.
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4351

Driver Parameters for netX Driver - USB/RS232 Connection

The settings of the driver parameters for the USB/RS232 connection are
made via the netX Driver / USB/RS232 Connection configuration dialog.

» Open the USB/RS232 Connection dialog via navigation area Settings
> Driver > netX Driver.

2 The USB/RS232 Connection dialog is displayed:

USE/RS232 Connection | TCP Connection |

[v Enable USE/R3232 Connector (Restart of QDM required)

[COM1 |

Port Configuration
[ Disable Port

Select Part:

BaudRate:  |115.2 kaitjs | Byte Size: |5 Biyte

El

Skop Bits: Parity:

|1 Stopbit |

Send Timeouk: | 1000 i‘ s
Reset Timeout: | 10000 i‘ ms

|N|:| Paritw

Keep Alive Timeouk: | 2000 i‘ s

El

Reskore Save

| Save All |

Figure 10: netX Driver > USB/RS232 Connection

Parameter Meaning

Range of Value /
Default Value

Enable USB/RS232
Connector (Restart of
ODM required)

checked: The netX Driver can communicate via the
USB/RS232 interface.

unchecked: The netX Driver can not communicate via the
USB/RS232 interface.

If the check mark for Enable USB/RS232 Connector is set
or removed, then the ODM server must be restarted?, to
make the new setting valid.

1 Restart the ODM server via the ODMV3 Tray Application:

-In the foot line click on m using the right mouse key.
- In the context menu select Service > Start.

checked,
unchecked;
Default:
unchecked

Select Port Depending on the COM ports (interfaces) available on the

PC, they will be listed under Select Port.

COM1to COMN

Port Configuration

The device must support the baud rate.

Disable Port checked: No connection. checked,
unchecked: The netX Driver tries to establish a connection unchecked (Default)
using the configured USB/RS232 interface.

Baud rate Transfer rate: number of bits per second. 9.6, 19.2,38.4, 57.6 or

115.2 [kBit/s];
Default (RS232): 115.2
[kBit/s]
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Parameter Meaning Range of Value /
Default Value
Stop bits Number of stop bits sent after the transfer of the send data Stop bit: 1, 1.5, 2;

for synchronization purposes to the receiver.

Default (RS232): 1

Send Timeout

Maximum time before the transfer of the transmission data is
canceled, when the send process fails, for example, because
of the transfer buffer is full.

100 ... 60.000 [ms];
Default (RS232 and
USB): 1000 ms

Reset Timeout

Maximum time for a device reset, including the re-
initialization of the physical interface used for the
communication.

100 ... 60.000 [ms];
Default (RS232 and
USB): 5000 ms

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit;
Default (RS232): 8 Bit

Parity In the error detection in data transmission using parity bits, No Parity,

"parity" describes the number of bits occupied with 1 in the Odd Parity,

transmitted information word. Even Parity,

No Parity: no parity bit Mark Parity,

Odd Parity: The parity is "odd" if the number of bits occupied | Space Parity;

with 1 in the transmitted information word will be odd. Default (RS232):

Even parity: The parity is "even" if the number of bits No Parity

occupied with 1 in the transmitted information word will be
even.

Mark Parity: if the parity bit is always 1, this will be named
mark-parity (the bit does not contain any information).
Space Parity: if the parity bit always 0, this will be named
space-parity (the bit represents an empty space).

Keep Alive Timeout

The "Keep Alive" mechanism is used to monitor whether the
connection to the device is active. Connection errors are
detected using a periodic heartbeat mechanism. The
heartbeat mechanism will be initiated after the set time has
elapsed if the communication has failed.

100 ... 60.000 [ms];
Default (RS232 and
USB): 2000 ms

Restore Resets all settings in the configuration dialog to the default
values.

Save Saving all settings made in the configuration dialog netX
Driver > Save USB/RS232 Connection, i. e. only for the
selected connection type.

Save All Saving all settings made in the configuration dialog netX

Driver, i. e. for all connection types.

Table 14: Parameters netX Driver > USB/RS232 Connection
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4.3.6 netX Driver - TCP/IP Connection

The communication from the DTM to the device via a TCP/IP Connection
is used in the following two typical applications:

Application 1: The device has its own Ethernet interface. The DTM is
installed on a PC and the TCP/IP connection is established from this PC to
the stand-alone device. The IP address of the device is used.

Application 2: The device is installed in a remote PC. The DTM is installed
on an additional PC and the TCP/IP connection is established from this PC
to the remote PC. The IP address of the remote PC is used. For the TCP/IP
connection is made, on the remote PC the cifX TCP/IP server must be
started. The cifX TCP/IP server allows the remote access to the device via
a TCP/IP connection.

_) Note: An exe file for the cifXTCP/IP server is provided on the product CD
in the Tools directory.

Via the TCP/IP interface of the device or of the remote PC, the device is
configured or diagnosis is performed.
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4.3.6.1

Driver Parameters for netX Driver - TCP/IP Connection

The settings of the driver parameters for the TCP/IP connection are made
via the netX Driver / TCP Connection configuration dialog.

» Open the TCP Connection dialog via navigation area Settings >

Driver > netX Driver.
 The dialog netX Driver is displayed:
» Select TCP Connection.

USB{RS232 Connection  TCP Connection ]

[ Enable TCP Connector {Restart of QDM required)

Select IP Range: |IP_R.|:|.NGE|:| ﬂ = Sican Timeout: | 100

IP Range Configuration
[ Disable IP Range

IF Address [ Use IP Range TCP Pork

Address Count

.
:lms
L

|192.168. 1.1 —|

Send Timeouk; |1IZIIZIIZI :‘ ms
Reset Tirmeouk: |2EIEIIZIIZI :‘ s

50111 |1

Keep Alive Timeout: |2EIEIEI :l ms

Restore Save

| Save Al |

Figure 11: netX Driver > TCP Connection

Parameter Meaning

Range of Value /
Default Value

Enable TCP Connector
(Restart of ODM
required)

checked: The netX Driver can communicate via the TCP/IP
interface.

unchecked: The netX Driver can not communicate via the
TCP/IP interface.

If the check mark for Enable TCP Connector is set or
removed, then the ODM server must be restarted?, to make
the new setting valid.

1 Restart the ODM server via the ODMV3 Tray Application:

-In the foot line click on m using the right mouse key.
- In the context menu select Service > Start.

checked,
unchecked;
Default:
unchecked

Select IP Range Via Select IP Range already created IP ranges can be

selected.
Via |:| an additional IP range can be added.

Via L2z an IP range can be deleted.

Scan Timeout [ms] With Scan Timeout can be set, how long to wait for a

response while a connection is established.

10 ... 10000 [ms];
Default: 100 ms
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Parameter

Meaning Range of Value /
Default Value

IP Range Configuration

Disable IP Range

checked: No connection. checked,

unchecked: The netX Driver tries to establish a connection unchecked (Default)

using the configured TCP/IP interface.

IP Address (left)

Enter the IP address of the device, (if Use IP Range is not valid IP address;
checked). Default: 192.168.1.1

Enter the start address of the IP scanning range, (if Use IP
Range is checked).

Use IP Range checked: An IP address range is used. checked,
unchecked: Only one IP address is used. unchecked;
Default:
unchecked
IP Address (right) Enter the ending address of the IP scanning range, (only if valid IP address;
Use IP Range is checked). Default: 0.0.0.0
Address Count Displays the scanning range address count, depending on recommended: 10

the selected IP-start or IP-end address. (For this read the
note given below.)

TCP Port

Identifies the endpoint of a logical connection or addresses a | 0 - 65535;
specific endpoint on the device or PC. Default Hilscher device:
50111

Send Timeout [ms]

Maximum time before the transfer of the transmission datais | 100 ... 60.000 [ms];
canceled, when the send process fails, for example, because | Default (TCP/IP): 1000

of the transfer buffer is full. ms

Reset Timeout [ms] Maximum time for a device reset, including the re- 100 ... 60.000 [ms];
initialization of the physical interface used for the Default (TCP/IP): 2000
communication. ms

Keep Alive Timeout The "Keep Alive" mechanism is used to monitor whether the 100 ... 60.000 [ms];

[ms] connection to the device is active. Connection errors are Default (TCP/IP): 2000
detected using a periodic heartbeat mechanism. The ms

heartbeat mechanism will be initiated after the set time has
elapsed if the communication has failed.

Restore Resets all settings in the configuration dialog to the default
values.

Save Saving all settings made in the configuration dialog netX
Driver > Save TCP/IP Connection, i. e. only for the selected
connection type.

Save All Saving all settings made in the configuration dialog netX

Driver, i. e. for all connection types.

Table 15: Parameters netX Driver > TCP Connection

Note: Do not use large IP ranges in combination with a low scan timeout. Microsoft
introduced in Windows® XP SP2 a limit of concurrent half-open outbound
TCP/IPconnections (connection attempts) to slow the spread of virus and malware from
system to system. This limit makes it impossible to have more than 10 concurrent half-
open outbound connections. Every further connection attempt is put in a queue and
forced to wait. Due to this limitation a large IP range used in combination with a low scan
timeout could prevent the connection establishment to a device.
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4.4 Device Assignment

Note: In the Device Assighment dialog pane you first must assign the
Slave device to the netSLAVE DTM by checking the check box. This is
essential to establish an online connection from the netSLAVE DTM to the
Slave device later, as described in section Connecting/Disconnecting
Device on page 123.

Therefore in the Device Assignment dialog pane you scan for the Slave
device and select it.

If the device did not get a firmware or shall get a new firmware:

1. first you scan for the device (with or without firmware) and select the
device,

then you download a firmware to the device and

subsequently you scan for the device (with firmware) once more and
select the device again.

4.4.1 Scanning for Devices

1. Select Settings > Device Assignment in the navigation area.

2 The dialog pane Device Assighment is displayed.

Scan progress: 35 Devices (Current device: -)

ENEEENEEENNEENNEENEEENEEE
Device seleckion: suikable only -

| Device | Hardware Park nf112;3| Slot nurmber | Setial nurnber | Driver Channel Prokocol | Access path
Cx [Device O --PROFIBUS)- 1 20145 CIFY Device Driver  Undefined Undefined L cifEI_SYs

Access path: |

Figure 12: Device Assignment - detected Devices (* The name of the device class is
displayed.) — Example for a device without firmware

2. Under Device Selection select suitable only.

3. Select Scan, to start the scanning process.

2 In the table all devices are displayed, which can be connected to the
netSLAVE DTM via the preselected driver.

Note: For devices, which have been found via the cifX Device Driver in
the column Access path the indication ...\cifX[OtoN]_SYS is displayed.
This is correct, as long as a device did not get a firmware. After the
firmware download has been completed, in the column Access path the
indication ...\cifX[OtoN]_Ch[0to3] is displayed.
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Parameter

Meaning

Range of Value /
Default Value

Device selection

Selecting suitable only or all devices.

suitable only, all

Device

Device class of the Slave devices.

Hardware Port
0/1/2/3

Shows, which hardware is assigned to which communication interface.

Slot number

Shows the Slot Number (Card ID) preset at the PC card cifX via the Rotary
Switch Slot Number (Card ID).

The indication n/a means that no Slot-Nummer (Card ID) exists. This will
occur if the PC card cifX is not equipped with a Rotary Switch Slot Number
(Card ID) or for PC cards cifX equipped with a Rotary Switch Slot Number
(Card ID) if the rotary switch is set to the value 0 (zero).

1to9,
n/a

Serial number

Serial number of the device

Driver

Name of the driver

Channel Protocol

Shows, which firmware is loaded to which device channel.

The data for the used channel consists of the protocol class and the
communication class.

a.) For devices without firmware: Undefined Undefined,
b.) For devices with firmware: Protocol name corresponding to the used
Firmware

Access path
(last column on
the right)

Depending on the used driver in the column Access path different data to
the device are displayed.

For the cifX Device Driver the following data are displayed:
a.) For devices without firmware: ...\cifX[OtoN]_SYS,
b.) For devices with firmware: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = Board number O to N
Ch[0to3] = Channel number 0 to 3

Depending on the
device and on the
driver:

board or channel
number, IP address
or COM interface

Access path

(at the lower side
of the dialog
pane)

If in the table a device is checked, under Access path (at the lower side of
the dialog pane) the driver identification or depending on the used driver
additional data to the device will be displayed.

For the cifX Device Driver the following data are displayed:
a.) For devices without firmware: ...\cifX[OtoN]_SYS,
b.) For devices with firmware: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = Board number O to N
Ch[0to3] = Channel humber 0 to 3

driver identification
(ID)

depending on the
device and on the
driver:

board or channel
number, IP address
or COM interface

Table 16: Parameters of the Device Assignment
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4411 Scanning for all Devices or for suitable only

all
1. Under Device Selection select all.
2. Select Scan.

Scan progress: 515 Devices (Current device: -)

Scan

Device seleckion: Ell -
| Device | Hardware-Port 0f1/2)3 | Slat number | Serial number | Driver | Channel Prokocol | Access path
O Device ¥ -j-iPROFIBUS)- 1 " z0148 CIF¥ Device Driver  Undefined Undefined  ...\difx3_Svs
O [Device cf  -j-jDevicehst)- nia 20027 CIFY Device Driver  Undefined Undefined .. .\cifX1_S¥S
O bevice - nia 20053 nety Driver Undefined Undefined  ...}192.168.1.,
O [Device ©f  EthernetiEthernet--  nla 202585 CIFY Device Driver  Undefined Undefined .. \cif2_5YS
O Pevicecrl  -j-fCaMopen/- nia 20022 CIFY Device Driver Undefined Undefined . \ciFX0_Svs

Figure 13: Device Assignment - detected Devices (* The name of the device class is
displayed.) Example for Devices without Firmware

> In the table all devices are displayed, which are attainable in the
network and which can be connected to a single DTM each via the
preselected drivers.

Note: During a subsequent firmware download in the selection window
Select Firmware File all files from the selected folder are displayed,
under Files of Type ,All Files (*.*)* is displayed and the check box
Validate the selected firmware file. is unchecked.

suitable only
1. Under Device Selection select suitable only.

2. Select Scan.

2 In the table all devices are displayed, which can be connected to the
netSLAVE DTM via the preselected drivers.

Note: During a subsequent firmware download in the selection window
Select Firmware File only firmware files from the selected folder are
displayed, under Files of Type ,Firmware Files (*.nxm)“ or ,Firmware
Files (*.nxf)* is displayed and the check box Validate the selected
firmware file. is checked.
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4.4.2 Selecting the Device (with or without firmware)

_) Note: A connection with the netSLAVE DTM can only be established with
one Slave device.

To select the physical Slave device (with or without firmware):

1. Check the appropriate device.

Scan progress: 505 Devices (Current dewvice: -]

Device selection: suitable only -

| Device | Hardware Port IZI,|'1,|'2I3| Slok number | Serial number | Driver | Channel Protocal | Access path
[Device CrY  -f-IPROFIBLIS)- 1 20145 CIF¥ Device Driver  PROFIBUS Masker v fE3_SYS
|
Access path: | {368BECSE-0E92-4C0E-B4AD-64FE2AET AAF AP X3 _SYS

Figure 14: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for a device without firmware / one Device is selected

2 Under Access path (below in the dialog pane) the access path to the
device, e. g. the driver identification, or depending on the used driver
additional access data of the device are displayed.

2. Select Apply, to apply the selection.

_) Note: Before an online connection from the netSLAVE DTM to the Slave
device can be established, a firmware must be loaded to the device and
the device must be selected once more.

For further information refer to section to section Firmware Download on
page 50 or to section Selecting the Device once more (with Firmware) on
page 48.
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4.4.3 Selecting the Device once more (with Firmware)

Note: For repeated download this step is omitted.

To select the Slave device (with firmware and defined system channel)
once more, proceed as described hereafter:

Q.

NI

Under Device Selection select all.
Select Scan.

In the table all devices are displayed, which are attainable in the
network and which can be connected to a DTM via the preselected
drivers.

Check the appropriate device.

Scan progress: 5/5 Devices (Current device: -)

Scan

Device selection: I -

| Device | Hardware-Part 0f1/2/3 | Slot number | Serial number Driver | Channe| Protocol | Access path

[l Device cf]  -j-[PROFIEUS/- 1 20148 CIFY Device Driver  PROFIBUS-DP Master  ...\cif3_cChO
O --|Devicelet)- nia 20027 CIFY Device Driver  DeviceMst Master L af¥1_cho
O -1--- nia 20056 nety Driver Undefined Undefined ...\ 192,168, ...
O Ethernet/Ethernet(--  nfa 20285 CIFY Device Driver  PROFINET IO Device ... \cifs2_cho
O Device o  -j-Calopen)- nfa 20022 CIF% Device Driver Undefined Undefined . \cifs0_SYS

|

Access path: | {368BECSB-0E92-4C0E-B4A9-64F62AE7AAFA 3 _ChD

Figure 15: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for Devices with and without Firmware / one Device is selected

Note: After the firmware download has been completed, for the devices which have been
detected via the cifX Device Driver the following data are displayed:

In the column Channel Protocol: the data for the firmware for the used channel

In the column Access path or under Access path (below in the dialog pane):
the data: ...\cifX[0OtoN]_Ch[0to3].

cifX[OtoN] = board number O to N
Ch[0to3] = channel number 0 to 3

Select Apply, to apply the selection.

Or select OK, to apply the selection and to close the DTM interface
dialog.

Connect the DTM to the device using the context menu (right mouse
click).
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Or:

suitable only
Under Device Selection select suitable only.

N

Select Scan.

2 In the table all devices are displayed, which can be connected to the
netSLAVE DTM via the preselected drivers.

3. Check the appropriate device.

Scan progress: 55 Devices (Current device: -)

Device selection: suitable anly -

| Device | Hardware Part EI,I'I,I'Z,I'3| Slot number | Serial number | Driver Channel Prokacal | Access path
Device Cr  -/-PROFIBUS/- 1 Z014a CIF¥ Device Driver  PROFIBUS-DP Master L AcifRE_Cho
|
Access path: | {368BECSE-0E92-4C0E-B4A0-E4FE2AE7AAFAMCIFL3_Cha

Figure 16: Device Assignment - Selecting the Device (* The name of the device class is
displayed.) — Example for a device with firmware / one Device is selected

detected via the cifX Device Driver the following data are displayed:

.i Note: After the firmware download has been completed, for the devices which have been
- Inthe column Channel Protocol: the data for the firmware for the used channel

- Inthe column Access path or under Access path (below in the dialog pane):
the data: ...\cifX[OtoN]_Ch[0to3].

cifX[OtoN] = board number O to N
Ch[0to3] = channel number 0 to 3

Select Apply, to apply the selection.

Or select OK, to apply the selection and to close the DTM interface
dialog.

6. Connect the DTM to the device using the context menu (right mouse
click).

For further information how to establish an online connection from the
netSLAVE DTM to the Slave device, refer to section
Connecting/Disconnecting Device on page 123.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Settings 50/266

45 Firmware Download

Using the Firmware Download dialog a firmware can be transferred to the
device.

_) Note: Prior to the firmware download, you must select the driver and the
Slave device (with or without firmware) and the device must be assigned
to the hardware.

For further information refer to section Overview Settings on page 31.

To load the firmware to the device:
1. Inthe navigation area select Settings > Firmware Download.

2 The dialog Firmware-Download pane is displayed.

Mame: r Erowse, ..

Version:

& CALTION:

The Firmware download

- stops the bus communication,

- erases the configuration database and

- overwrites the existing Firmware in the device,

To complete the update and to make the device operable again, please re-download the
configuration when this operation has finished.

[ inisd

Figure 17: Firmware Download

Element Meaning

Name The path and name of the firmware file selected are displayed.

Version The version and build version of the firmware file selected are displayed.
Browse... Via ‘Browse..." you can select the firmware file for the download.
Download Via ‘Download’ you can download the firmware to the device.

Table 17: Parameter Firmware Download
» Select Browse.

Device is not assigned to the Hardware

If the device is not assigned to the Hardware, the error message ‘The
device is not assigned to the hardware?!’ is displayed:
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Figure 18: Error Message ‘The device is not assigned to the hardware!’

» Click OK and select and assign the Master device as described in
section Device Assignment.

Device is assigned to the Hardware

2 The selection window Select Firmware File is displayed.

» Enlarge the selection window to view the columns Hardware and
Version.
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Lok in: | J. CIFX ~|
= Mame : Firmware Hardware WVersion I
el | ECM
|| Recent Places DECS V4K
| J EIM_mit_QC
- ) PNIM
Desktop | PNSV3.5.X
= ) 53M
= OE cifx2asm.nf AS-Interface Master CIFX [x.x (Build x)]
Libraries ot cifx2dprm.nxf PROFIEUS-DP Master CIFX [x.x (Build x)]
3 cifx2dps.nxf PROFIBUS-DP Slave CIFX [ x (Build x)]
[}E. 0k cifxccs.nf CC-Link Slave CIFX [x.x (Build x)]
Computer Mt cifecom.nxf CAMopen Master CIFX [ (Build x)]
- 3 cifxcosnuf CAMopen Slave CIFX [x.x (Build x)J
Qg ¢k cifxdnm.nxf DeviceMet Master CIFX [x.x (Build x)]
Network ¢k cifudns.nxf DeviceMet Slave CIFX [x.x (Build x)]
o cifxdprm.nxf PROFIBUS-DP Master CIFX [ x (Build x)]
O cifdps.naf PROFIBUS-DP Slave CIFX [ x (Build x)]
Ok cifxecrn.nxf EtherCAT Master CIFX [ (Build x)]
0k cifxecs.nxf EtherCAT Slave CIFX [x.x (Build x)J
O cifieim. naf EtherMet/IP Scanner CIFX [ x (Build x)J
Ok cifxeis.nuxf EtherMet/IP Adapter CIFX [x.x (Build x)]
Mcif’xmpi.nxf PROFIBUS-MPI Messaging CIFX [x.x (Build x)f
ok cifxornb.nf Open Modbus/TCP Messaging CIFX Ly (Build x)]
13 cifxpls.nuxf POWERLIME Controlled MNode CIFX [x.x (Build x)J
i3 cif {pnm.nxf PROFIMNET-IC IO Controller CIFX [x.x (Build x)J
ok cifxpns, nuf PROFIMET-I0 10 Device CIFX [ x (Build x)]
0 cifesIm.nuf SERCOS I Master CIFx [ x (Build x)]
ek cifes3s.nd SERCOS I Slave CIFX [ x (Build x)]
0L cifiovrs.nuf YVARAM Slave CIFX [ (Build x)]
File name: |ﬂ'u'ame of the Firmware Filel nxf or nxm j Open I
Files of type: |F|n1'|ware Files {*.rof ;™ room) ﬂ Cancel |
Recent folders: | [Path of the last used Folder] | Help |
Firmware: [Firmware Mame, Version, Device Class]
Figure 19: Window ‘Select Firmware File’ (Example CIFX)
Parameter Meaning Range of Value /
Default Value
Column Name | File name of the firmware file nxf, nxm
To sort the entries of the window Select Firmware File by name click to
the column head MNeme
Column Name of the firmware (consisting of the protocol name and protocol class)
Firmware
Column Device class of the associated hardware e. g. CIFX,
Hardware COMX, COMX 51,
NETJACK 10,
NETJACK 50,
NETJACK 51,
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NETJACK 100,
NETTAP 50 (Gateway),
NETTAP 100 (Gateway),
NETBRICK 100 (Gateway)
Column Firmware version x.X (build x)
Version
Tooltip To view the tooltip information move with the mouse pointer over the
selected firmware line.
Type: Hilscher firmware file for neti-based targets (NXF)
Size: 563 KB
Date of change: 2013/03/26 11:10
Files of Type |,All Files (*.*)" if before in the Device Assignment pane under Device All Files (*.%),
selection all was selected. Firmware Files (*.nxm),

, Firmware Files (*.nxm)* or Firmware Files (*.nxf) if before in the Device | Firmware Files (*.nxf)

Assignment pane under Device selection suitable only was selected.

Recent folders

Path of the recently opened folder

Firmware As soon as the firmware file has been selected, under Firmware the Name, Version, Build
name, the version and the build version as well as the device class for the | Version, Device Class
selected firmware is displayed. for the selected firmware

Help Button, to open the online help of the DTM.

Table 18: Parameters Select Firmware File

,  Further descriptions to the selection window Select Firmware File are
| included in the context sensitive help (F1 key) of the Microsoft
»  Corporation.

has been set, during a subsequent firmware download in the selection window Select

.3 Note: After in the Device Assignment pane under Device selection all or suitable only
Firmware File the following data are displayed or set:

(for list box entry —) all suitable only
In the selection window all files from the only firmware files from the
Select Firmware File: selected folder selected folder
Under Files of Type*: LAl Files (*.%)" JFirmware Files (*.nxm),
JJFirmware Files (*.nxf)*
Validation: A restricted validation | A validation is made whether
will be performed if the firmware file is suitable for

the selected firmware | the netSLAVE Master DTM.
is applied for the
download.

*These settings in the selection window Select Firmware File can also be changed
manually.

3. In the selection window mark the firmware file to be loaded using the
mouse.

2 In the selection window under Firmware the name and the version of
the firmware are displayed.

4. In the selection window select the Open button.

Validation

2 A validation is made, whether the selected firmware file is suitable for
the netSLAVE Master device.
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Invalid Firmware

NOTICE

Device Destruction caused by invalid Firmware

Loading invalid firmware files could render your device unusable.

2 If a firmware file is selected, which is not valid for the assigned device,
the request Select Firmware File will be displayed.

‘Invalid firmware for assigned device!
[detailed explication]

Shall firmware file nevertheless be applied for the download?’

Select Firmware File [%|

'T Ireealid Firmware for the assigned device!
L

The hardware options do nat makch,
Reqguired: -/-/CaANopen/-
Firrmmare file: -f-/PROFIBUS)-

The prokocol classes do nok match,
Required: CAMopen
Firrmware file: PROFIBUS-DP

Shall the Firmware file nevertheless be applied
for the download?

Yes

Figure 20: Request Select Firmware File - Example Invalid Firmware

» Answer to the request with No and select a valid firmware.

R The selection window is closed.

Valid Firmware

2 The selection window is directly closed (without dialog).

5. Start firmware upgrade.

| & WARNING|

Personnel Injury in Consequence of a Communication Stop

= Stop your application program before starting upgrading the firmware.

= Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before upgrading the firmware.

= Unexpected equipment operation may cause personal injury.
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NOTICE

Damage of Equipment and Loss of Device Parameters in
Consequence of a Communication Stop

= Stop your application program before starting upgrading the firmware.

= Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before upgrading the firmware.

= Unexpected equipment operation may cause property damage.

= Before you initiate firmware download make sure that your project
configuration data are saved non-volatile in order to prevent loss of
configuration data.

Invalid or non-authorized Firmware

= Loading invalid or non authorized firmware files could render your
module unusable. Only proceed with a authorized firmware update.

» In the dialog pane Firmware Download click to the Download button,
to download the firmware.

 The request Do you really want to download the firmware? is

displayed.
\‘ii/ Do wiou really wank to download the new Firmware?

ves |

Figure 21: Request - Do you really want to download the firmware?

Click Yes.

If you are sure, that you have selected the appropriate firmware file
answer to the request with Yes otherwise with No.

v o

2 During the download a progress bar is displayed (‘Download active,
device performs initialization...”), in the status line a clock / green hook
symbol is displayed and in the dialog pane Firmware Download
Download is grayed out.

netDevice

Device: Device Name [Description] =Station Addresss (Network 10)
Downlaad active, device perfarms inikialisation. ..

29 % complete

Figure 22: Firmware Download - Progress Bar
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=05 () (T} Firmware Dawrload

=0 | i

Figure 23: Clock Symbol and Hook Symbol green

2 In the Firmware-Download dialog pane the path and name as well as
the version of the selected firmware file are displayed.

Mame: IName of the Firmware File]

Version: Iiersion and Boild Wersion of the Firmware]

& CAUTION:
The firmware download

- skops the bus communication,
- erases the configuration database and
- overwrites the existing firmware in the device.

Tao camplete the update and ko make the device operable again, please re-dawnload the

configuration when this operation has finished,
Download

Figure 24: Firmware Download — Download
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5 Configuration

5.1 Overview Configuration

The current parameters of the selected firmware protocol are displayed in
the Configuration pane. The configuration parameters can be edited.

» Click in the navigation area to the Configuration folder to open the
Configuration pane.

Mavigation area =
[_7) Settings

= Configurstion

iy Configuration
Signal Cenfiguration

Figure 25: Navigation Area - Configuration

®  Parameters of the
In the Configuration pane the current Protocol

parameters of the selected firmware protocol
are displayed.

Default

Figure 26: netX Configuration Tool - Configuration Pane

The descriptions of the user interface of the single protocols are listed in
the table in the next subsequent section.

Default

With the Default button the parameters can be reset to the default state.

Enable

If ‘Enabled’ is unchecked, the default value is used.

Error during Data Input

Error Action
Parameter validation error! Input field cannot be empty. Enter data.
Input validation error! Input field accepts only digits. Enter only digits.

Input validation error! Input field accepts only digits and letters Enter only digits and
from A to F. letters from Ato F.

Table 19: Error during Data Input
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Gateway Devices

Mavigation area =

=Y contgution

= Configuration
Signal Configuration
Command Table

Figure 27: Navigation Area - Configuration for Protocol Conversions

For gateway applications for the configuration of the primary network and
secondary network protocols of the different protocol conversions the
following dialogs are provided:

e Configuration
¢ Signal Configuration
e Command Table (for devices with Master functionality)

The corresponding descriptions are listed in the table in the next
subsequent section.

Note: In order to transfer the configuration to the Slave device, download
the data of the configuration parameters in the Slave device. See section
Download Configuration on page 125.
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511 Parameters of the Protocol - Overview Configuration
Parameters

\ Any Parameters of the Protocol are described in the subsections listed
. in the table hereafter.

Folder Name | Section Subsection Page
Configuration | Real-Time Ethernet Systems EtherCAT Slave Parameters* 60
EtherNet/IP Adapter Parameters* 61
Open Modbus/TCP Parameters 63
POWERLINK Controlled Node/Slave Parameters 65
PROFINET IO-Device Parameters* 67
Sercos Slave Parameters* 68
VARAN-Client (Slave) Parameters 72
Fieldbus Systems PROFIBUS DP Slave Parameters* 75
CANopen Slave Parameters* 77
DeviceNet Slave Parameters* 79
CC-Link Slave Parameters 81
CompoNet Slave Parameters 83
Serial Protocols Modbus RTU Parameters* 85
3964R-Parameter* 87
ASCII Settings* 89
ASCII Parameters* 89
netSCRIPT Settings* 104

Table 20: Descriptions Configuration Parameters (*only Gateways)

5.1.2 Overview Command Table and Signal Configuration

_\ The available descriptions about the Command Table and Signal
| Configuration for Gateways are listed in the table hereafter.

Folder Name Section Subsection Page

Signal Configuration Signal Configuration 105

Command Table Command Table Command Table Modbus RTU 110
Command Table Open Modbus/TCP 116

Table 21: Descriptions Command Table and Signal Configuration for Gateways
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5.2 Real-Time Ethernet Systems

521 EtherCAT Slave Parameters

Parameter

|Meaning

| Range of Value/Value

Interface

Bus Startup

Communication starts automatically

Automatic (Default)

Watchdog Time
[ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0O Data Status

Status of the input or the output data.

For each input and output data the following status information (in Byte) is
memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

None, (1 Byte, 4 Byte)
Default: None

Ident

Enabled

If ‘Enabled’ is unchecked, for the single Ident parameters each the
respective default value is used.

Vendor ID

Identification number of the manufacturer

0x00000000 ...
OXFFFFFFFF (hex)

Primary Hilscher
Vendor ID:
0x00000044 (hex)

Default: Secondary
Hilscher Vendor ID:
OXE0000044 (hex)

Product Code

Product code of the device as specified by the manufacturer

0x00000000 ...
OXFFFFFFFF (hex),
Default:

NT 100-RE/ECS:
0x0000000D (hex),
NB 100-RE/ECS:
0x00000019 (hex)

Revision
Number

Revision number of the device as specified by the manufacturer

0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00000000 (hex)

Serial Number

Serial number of the device

0x00000000 ...
OXFFFFFFFF (hex)

Bytes

Data

Input Data Length of the input data in Byte 0 ... 200 Byte
Bytes Default: 200 Byte
Output Data Length of the output data in Byte 0 ... 200 Byte

Default: 200 Byte

Table 22: EtherCAT Slave Parameters
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5.2.2 EtherNet/IP Adapter Parameters
Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication starts automatically

Automatic (Default)

Watchdog time
[ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0 data status

Status of the input or the output data.

For each input and output data the following status information (in Byte)
is memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Ident

Enable

If ‘Enable’ is unchecked, for the single Ident parameters each the
respective default value is used.

Vendor ID

Identification number of the manufacturer

0x00000000 ...
0x0000FFFF (hex),
Hilscher:
0x00000011B (hex)

Product Code

Product code of the device as specified by the manufacturer

0x00000000 ...
0x0000FFFF (hex),
Default

NT 50-EN/EIS:
0x000000113 (hex),
NT 100-RE/EIS:
0x00000010F (hex),
NB 100-RE/EIS:
0x000000111 (hex)

Product Type

Communication Adapter

0x00000000 ...
0x0000FFFF (hex),
Default:
0x00000000C (hex)

Major revision | Major revision of the EtherNet/IP Adapter device according to the 0 ... 255,
EtherNet/IP specification. Default: 1

Minor revsion Minor revsion of the EtherNet/IP Adapter device according to the 0...255,
EtherNet/IP specification. Default: 1

Device name Device name of the device station as character string, 0 - 31 ASCII characters,
e. g. EtherNet/IP Adapter (Slave). Examples: NT 50-EN/EIS,
NT 100-RE/EIS,
NB 100-RE/EIS
Bus
IP Address Valid IP Address for the device Valid IP address
If ‘Enable’ is unchecked (Default setting), the device obtains its IP Default: unchecked
Address from a DHCP server or also from a BOOTP server, if this one is
checked.
If ‘Enable’ is checked, the device uses the manually entered value.
Netmask Valid Network mask for the device Valid network mask
If ‘Enable’ is unchecked (Default setting), the device obtains its Netmask | Default: unchecked
from a DHCP server or also from a BOOTP server, if this one is checked.
If ‘Enable’ is checked, the device uses the manually entered value.
Gateway Valid Gateway Address for the device Valid gateway address

If ‘Enable’ is unchecked (Default setting), the device obtains its Gateway
Address from a DHCP server or also from a BOOTP server, if this one is
checked.

If ‘Enable’ is checked, the device uses the manually entered value.

Default: unchecked
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Parameter Meaning Range of Value/Value
There are three methods available, how the device can obtain its
IP Address, Netmask and Gateway Address, one of which must be
selected.
These methods can also be combined.
The device performs the following sequence in order to obtain the
addresses:
1. from a DHCP server if DHCP is checked (if a DHCP server provides
the requested addresses to the device, then the device uses these
addresses)
2. from a BootP server if BootP is checked (if a BootP server provides
the requested addresses to the device, then the device uses these
addresses)
3. the addresses manually set are used. If the IP Address is set manually
also the Network Mask must be set manually. The manually set Gateway
Address is optional.
If no DHCP server and no BootP server and no manually set addresses
exist, then the protocol is not ready for initialization or for operation.
Extras BootP: Default: unchecked
If checked, the device obtains its IP Address, Netmask, Gateway
Address from a BOOTP server.
DHCP: Default: checked
If checked, the device obtains its IP Address, Netmask, Gateway
Address from a DHCP server.
100Mbit: Speed Selection, Default: unchecked
If checked, the device will operate at 100 MBit/s, else at 10 MBit/s. This
parameter will not be in effect, when auto-negotiation is active.
FullDuplex: Duplex Operation, Default: unchecked
If checked, full-duplex operation will be used. The device will operate in
half-duplex mode, if this parameter is set to zero. This parameter will not
be in effect, when auto-negotiation is active.
Auto-neg.: Auto-Negotiation, Default: checked
If checked, the device will auto-negotiate link parameters with the remote
hub or switch.
Data

Produced data
length

Maximum allowed length of the input data in Byte. This parameter should
be equal to or higher than the complete projected input data length,
otherwise the EtherNet/IP device will reject the cyclic communication
requests.

0 ... 504 Byte
Default: 32 Byte

Consumed data
length

Maximum allowed length of the output data in Byte. This parameter
should be equal to or higher than the complete projected output data
length, otherwise the EtherNet/IP device will reject the cyclic
communication requests.

0 ... 504 Byte
Default: 32 Byte

Table 23: EtherNet/IP Adapter Parameters (Part 2)
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5.2.3 Open Modbus/TCP Parameters

Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication starts application controlled or automatic.

Default: Automatic

Watchdog time
[ms]

Watchdog time within which the device watchdog must be retriggered from
the application program while the application program monitoring is
activated.

When the watchdog time value is equal to O the application program
monitoring is deactivated.

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

Protocol mode

Mode of data exchange: 'Client' (Message Mode) or 'lO Server'

10 Server (default),

watchdog time

For the 'Client' mode in the navigation area 'Command Table' is Client
displayed. For the Open Modbus/TCP Client the Command Table is a list
with commands for the reading or writing of data.
For the 'lO Server' mode, the communication partner has read/write
access to the process data memory of the device from outside using of the
function codes.
Data swap Data-storage mode: Yes, No,
No: Data will not be swapped Default
Yes: Data will be swapped. CIFX RE/OMB,
COMX 51XX-RE/OMB,
COMX 100XX-RE/OMB,
NJ 50X-RE/OMB,
NJ 51X-RE/OMB,
NJ 100XX-RE/OMB: No,
NT 50-EN/OMB,
NT 100-RE/OMB,
NB 100-RE/OMB: Yes
Map FC1 If ,unchecked’, data are read from the intput area using FC1, FC3 and checked,
and FC3 FC23. unchecked,
If checked, data are read from the output area using FC1, FC3 and FC23. | Default: unchecked
FC1 then can be used instead of FC2 and FC3 instead of FC4.
Bus
Provided server | Number of sockets to provide for server requests* Sockets: 0 ... 16,
connections *A value of 0 means that the Open Modbus/TCP task exclusively works as TCP Client. A value Default: 4
of 16 means that the Open Modbus/TCP task exclusively works as Server in the Message-
Mode. With the default value 4 there are 4 Server connections provided. Then still up to 12 TCP
client connections are available.
The parameters ‘Send Acknowledgement Timeout’ (Send Timeout), ‘Connect Acknowledgement
Timeout’ (Connect Timeout) and ‘Close Acknowledgement Timeout’ (Close Timeout) are for the
Timeout between the Open Modbus/TCP Task and the TCP Task.
Client Only for client jobs in Message Mode (packet mode). The connection to 100 ... 6,000,000 ms,
connection the destination-device stays open, until timeout is expired. Default: 1000 ms

Note: This timeout starts, after receiving the answer to a command

For interface programming via Open Modbus/TCP, the value for Client
Connection Watchdog Time (Omb Open Time) must be divided by the
factor of 100. (Value range for the interface programming: 1 ... 60,000)

Response
timeout

Only for client jobs in Message Mode (packet mode). After expiration of
this time, the job will be canceled and an error is send to the application.
Note: This timeout starts after command is send to the destination device
via TCP.

For interface programming via Open Modbus/TCP, the value for Response
Timeout must be divided by the factor of 100. (Value range for the
interface programming: 1 ... 60,000)

100 ... 6,000,000 ms,
Default: 2,000 ms

Send
acknowledge-
ment timeout*

Parameter for TCP task (in milliseconds) . Used OMB task internal. It
specifies the timeout for trying to send messages via TCP/IP

If the value 0 is selected, the default value of 31,000 milliseconds is used.

0 ... 2,000,000,000 ms,
Default: 31,000 ms
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Parameter Meaning Range of Value/Value
Connect Parameter for TCP task (in milliseconds). Used OMB task internal. It 0 ... 2,000,000,000 ms,

acknowledge-
ment timeout*

specifies the timeout for trying to establish a connection with the TCP task.
If the value O is selected, the default value of 31,000 milliseconds is used.

Default: 31,000 ms

Close
acknowledge-
ment timeout*

Parameter for TCP task (in milliseconds). Used OMB task internal. It
specifies the timeout for trying to close a connection with the TCP task.

If the value O is selected, the default value of 13,000 milliseconds is used.

0 ...2,000,000,000 ms,
Default: 13,000 ms

IP address

Valid IP address for the device

If ‘Enable’ is unchecked (Default setting), the device obtains its IP Address
from a DHCP or BOOTP server.

If ‘Enable’ is checked, the device uses the manually entered value.

Valid IP address
Default: unchecked

Net mask

Valid Network mask for the device

If ‘Enable’ is unchecked (Default setting), the device obtains its Netmask
from a DHCP or BOOTP server.

If ‘Enable’ is checked, the device uses the manually entered value.

Valid network mask
Default: unchecked

Gateway

Valid Gateway address for the device

If ‘Enable’ is unchecked (Default setting), the device obtains its Gateway
Address from a DHCP or BOOTP server.

If ‘Enable’ is checked, the device uses the manually entered value.

There are three methods available, how the device can obtain its
IP Address, Netmask and Gateway Address, one of which must be
selected.

These methods can also be combined.

The device performs the following sequence in order to obtain the
addresses:

1. from a DHCP server if DHCP is checked (if a DHCP server provides the
requested addresses to the device, then the device uses these addresses)

2. from a BootP server if BootP is checked (if a BootP server provides the
requested addresses to the device, then the device uses these addresses)

3. the addresses manually set are used. If the IP Address is set manually
also the Network Mask must be set manually. The manually set Gateway
Address is optional.

If no DHCP server and no BootP server and no manually set addresses
exist, then the protocol is not ready for initialization or for operation.

Valid gateway address
Default: unchecked

Extras

BootP:
If checked, the device obtains its IP Address, Netmask, Gateway Address
from a BOOTP server.

Default: unchecked.

DHCP:
If checked, the device obtains its IP Address, Netmask, Gateway Address
from a DHCP server.

Default: checked.

Table 24: Open Modbus/TCP Parameters

Note: *This parameter is only applicable for client jobs in Message-Mode
and does not work in in 10 Server mode and Command table mode.
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5.2.4 POWERLINK Controlled Node/Slave Parameters

Parameter ‘ Meaning | Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Default: Automatic

Watchdog time [ms]

Watchdog time within which the device watchdog must be
retriggered from the application program while the application
program monitoring is activated.

When the watchdog time value is equal to 0 the application
program monitoring is deactivated.

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0 data status

Status of the input or the output data.

For each input and output data the following status information (in
Byte) is memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Disable host-
triggered input data
exchange

Decides, whether host-triggered update for input data exchange is
enabled (hook checked) or disabled (hook unchecked).

Default: unchecked

Disable host-
triggered output
data exchange

Decides, whether host-triggered update for output data exchange
is enabled (hook checked) or disabled (hook unchecked).

Default: unchecked

Ident
Enable If ‘Enable’ is unchecked, for the single Ident parameters each the
respective default value is used.
Vendor ID Identification number of the manufacturer 0x00000000 ...

OXFFFFFFFF (hex),
Hilscher:
0x00000044 (hex)

Serial number

Serial number of the device

0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00000000 (hex)

Product code

Product code of the device as specified by the manufacturer

0x00000000 ...
OXFFFFFFFF (hex),
Default:

CIFX RE/PLS:
0x00000001 (hex),
COMX 51XX-RE/PLS:
0x0000001C (hex),
COMX 100XX-RE/PLS:
0x00000003 (hex),
NJ 50X-RE/PLS:
0x00000023 (hex),
NJ 51X-RE/PLS:
0x0000001B (hex),
NJ 100XX-RE/PLS:
0x00000024 (hex),
NXSTK 50-RE/PLS:
0x0000000B (hex),
NIC 50-RE/PLS:
0x00000008 (hex),
NETX 500 RE/PLS:
0x00000106 (hex),
NETX 100 RE/PLS:
0x00000109 (hex) ,
NETX 50 RE/PLS:
0x00000107 (hex),
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Parameter

Meaning

Range of Value/Value

Product code
(continued)

NT 100-RE/PLS:
0x00000018 (hex),
NB 100-RE/PLS:

0x00000017 (hex)

Revision number Revision number of the device as specified by the manufacturer 0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00000000 (hex)

Bus

Node Id EPL Node ID (EPL = Ethernet POWERLINK) 1...239, Default: 1

DNS node name

DNS-compatible name of the POWERLINK Controlled
Node/Slave (optional)

Gateway address

Gateway address for IP stack

Default:
192.168.100.254

Data

Input data bytes Length of the input data in byte 1... 1490 Byte,
Default: 4 Byte

Output data bytes Length of the output data in byte 1... 1490 Byte,
Default: 4 Byte

Disable PDO Decides, whether PDO mapping version is checked (hook Default: checked

mapping version checked) or not checked (hook unchecked).

check

Select for netTAP and netBRICK devices always unchecked.

Configure default
objects

Decides, whether default objects are created (hook checked) or
not (hook unchecked).

If the objects will be created, the old set of previously existing
objects will be cleared

Default: checked

Delete application
objects

Decides, whether application objects are deleted (hook checked)
or not (hook unchecked). When "Configure Default Objects’ is
checked, then the firmware automatically does a 'Delete
Application Objects’.

Default: checked

Table 25: POWERLINK Controlled Node/Slave Parameters

Note: To configure the Managing Node/Master, an XDD file (device

description file) is required. The settings

in the used Managing

Node/Master must comply with the settings in the Controlled Node/Slave,
to establish communication. Important parameters are: Vendor ID, Product
Code, Serial Number, Revision Number, Node ID, Output and Input

length.
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525 PROFINET IO-Device Parameters
Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication starts automatic

Default: Automatic

Watchdog time [ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms, default =
1000 ms, 0 = Off

1/0O data status

Status of the input or the output data.

For each input and output data the following status information
(in Byte) is memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Ident

Enable

If ‘Enable’ is unchecked, for the single Ident parameters each
the respective default value is used.

Vendor ID

Identification number of the manufacturer, assigned by
PROFIBUS Nutzerorganisation e. V.

0x00000000 ...
OXFFFFFFFF (hex),
Hilscher: 0x00000011E (hex)

Device ID

Identification number of the device, fixed for every device.

0x00000000 ...
0x0000FFFF (hex),
Default:

NT 50-EN/PNS (Gateway):
0x0000010F (hex),

NT 100-RE/PNS (Gateway)
0x00000010B (hex),

NT 100_RE/PNS (Proxy)
0x000000106 (hex),

NB 100-RE/PNS (Gateway)
0x00000010E (hex)

Device type

Description of the device type, freely eligible

Character string,
0 ... 25 characters

Order ID

Hilscher device number or order description of the customer
for its device

Character string,
0 ... 20 characters

Name of station

Station name of the PROFINET IO-Device station. It has to
match the station name configured in the PROFINET IO-
Controller for this device. Must be DNS compatible name.

Character string,
1 ... 240 characters

Default:

NT 50-EN/PNS (Gateway):
nt50enpns,

NT 100-RE/PNS (Gateway)
nt100repns,

NT 100_RE/PNS (Proxy)
nt100reproxy,

NB 100-RE/PNS (Gateway)
nb100repns

Type of station

Type name of the PROFINET station; name can be assigned
freely.

Character string,
1 ... 240 characters
Default: Default.Station. Type

Data

Output data bytes

Maximum allowed length of the input data in Byte. This
parameter should be equal to or higher than the complete
projected input data length, otherwise the 10 Device will reject
the cyclic communication requests.

0 ... 1024 Byte
Default: 128 Byte

Input data bytes

Maximum allowed length of the output data in Byte. This
parameter should be equal to or higher than the complete
projected output data length, otherwise the 10 Device will

reject the cyclic communication requests.

0 ... 1024 Byte
Default: 128 Byte

Table 26: PROFINET IO-Device Parameters
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5.2.6 Sercos Slave Parameters
Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Default: Automatic

Watchdog time
[ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
Default = 1000 ms,
0 = Off

Ident

Device ID

Identification number of the device. This is a unique device ID managed
by the vendor and identifies the component number. The device ID is
fixed for every device.

Device ID according to the Sercos third generation specification as
defined in IDN S-0-1300.x.05.

The device ID can be changed by the user, if an other device ID than the
default is useful for the used Sercos network.

Note: The Device ID is part of the SDDML device description file. If you
use a Sercos Master which is using SDDML files for configuration and
the default device ID was changed, then you have to export via Export
SDDML a new updated SDDML file from the Slave configuration
software and import this SDDML file into the configuration software for
the Sercos Master.

Default:

Vendor code

Identification number of the manufacturer, assigned by Sercos
International.

Vendor code according to the Sercos third generation specification as
defined in IDN S-0-1300.x.03.

Note: The Vendor code is part of the SDDML device description file. If
you use a Sercos Master which is using SDDML files for configuration
and the default vendor code was changed, then you have to export via
Export SDDML a new updated SDDML file from the Slave configuration
software and import this SDDML file into the configuration software for
the Sercos Master.

0x00000000 ...
OXFFFFFFFF (hex),
Hilscher:
0x0000003E8 (hex)

If ‘Enable’ is unchecked (Default setting), the device obtains its IP
address from a DHCP or BOOTP server.
If ‘Enable’ is checked, the device uses the manually entered value.

This function is not supported.

Version Version of the Sercos Communication Profile SYNC 0... 255,

of SCP Sync | g = syNC deactivated. With this setting the configuration parameter for | Default: 0
Sercos Communication Profile Class SCP_Sync are not relevant and are | Possible values: 0, 1
displayed grayed out.
1 = SYNC activates version 1. If the Sercos Master uses the telegram
sequence MDT, then NRT and then AT, the gateway device requires that
the value is set to 1.

Version Version of the Sercos Communication Profile NRT 0...255,

of SCP NRT 0 = NRT deactivated. With this setting the configuration parameter for IP Default: 0
communication are not relevant and are displayed grayed out. Possible values: 0, 1
1 = NRT version 1 is activated.
Use always value 0, because the NRT channel is not useable with
gateway devices.

Bus
Configuration parameter for IP communication

Enable If ‘Enable’ is unchecked, for the single Ident parameters each the checked, unchecked
respective default value is used.

IP address Valid IP address for the device Valid IP address,

Default for ‘Enable’:
unchecked

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017

NT_100-RE_S3S_FIXCFG,
NB_100-RE_S3S_FIXCFG




Configuration

69/266

Netmask Valid Network mask for the device Valid network mask,
If ‘Enable’ is unchecked (Default setting), the device obtains its Netmask | nafauit for ‘Enable’
from a DHCP or BOOTP server. '

) - unchecked
If ‘Enable’ is checked, the device uses the manually entered value.
This function is not supported.

Gateway Valid Gateway address for the device Valid gateway address,
If ‘Enable’ is unchecked (Default setting), the device obtains its Gateway | pefault for ‘Enable’
Address from a DHCP or BOOTP server. '

: . unchecked
If ‘Enable’ is checked, the device uses the manually entered value.
This function is not supported.
There are three methods available, how the device can obtain its IP
address, Netmask and Gateway Address, one of which must be
selected.
These methods can also be combined.
The device performs the following sequence in order to obtain the
addresses:
1. from a DHCP server if DHCP is checked (if a DHCP server provides
the requested addresses to the device, then the device uses these
addresses)
2. from a BootP server if BootP is checked (if a BootP server provides
the requested addresses to the device, then the device uses these
addresses)
3. the addresses manually set are used. If the IP address is set manually
also the Network Mask must be set manually. The manually set Gateway
Address is optional.
If no DHCP server and no BootP server and no manually set addresses
exist, then the protocol is not ready for initialization or for operation.

TCP flags BootP: checked, unchecked,
If checked, the device obtains its IP address, Netmask, Gateway Default: unchecked
Address from a BOOTP server.

This function is not supported.

DHCP: checked, unchecked,
If checked, the device obtains its IP address, Netmask, Gateway Default: unchecked
Address from a DHCP server.

This function is not supported.

Configuration Data Parameters of the Sercos Communication

Profile Class SCP_Sync

ConClk pulse Control Clock pulse length: This timing parameter defines the time how | >= 1000 ns,

length* long the communication synchronized hardware output signal CON_CLK | Default: 1000 ns
is set. The maximum valid value of the ,,ConClk pulse length* depends
on the configured cycle time. In general the signal CON_CLK must go to
inactive again before the next cycle starts.

DivClk pulse Divided Control Clock pulse distance: This timing parameter defines the [0 ... 16.777.210 ns,

distance * delay time from the start of the communicatin cycle to the first pulse of Default: 1000 ns
the communication synchronized hardware output signal DIV_CLK.

DivClk Delay* | Divided Control Clock delay: This timing parameter defines the delay 0...6.710.860 ns,
time respectively the distance between two pulses of the communication | Default: 1000 ns
synchronized hardware output signal DIV_CLK. In the ,DivCIk
mode“Mode 1 this parameter is ignored.

DivCIk pulse Divided Control Clock pulse length: This timing parameter defines the 1000 ... 20.000 ns,

length* pulse length, i. e. how long the communication synchronized hardware Default: 1000 ns
output signal DIV_CLK is set.

*All timing values are handled as multiple of 10 ns (e. g. ConClk pulse

length = 1005 ns is handled as 1000 ns).
DivClk Divided Control Clock multiplier: 1...255,
multiplier For ,DivClk mode* Mode 0: Here the parameter indicates the number of | Default: 100

pulses of the communication synchronized hardware output signal
DIV_CLK within a communication cycle.

For ,DivClk mode“Mode 1: Here the parameter indicates the number of
communication cycles.
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DivClk polarity

Divided Control Clock Polarity: This communication synchronization flag
defines the output state of the communication synchronized hardware
output signal DIV_CLK.

Disabled, High Activity,
Low Activity,
Default: High Activity

DivClk mode

Divided Control Clock Mode: This communication synchronization flag
defines the mode of the communication synchronized hardware output
signal DIV_CLK.

Mode 0: The DIV_CLK signal becomes active several times within a

communication cycle. The following condition must be fulfilled in mode O:

,DiVCIk pulse length* + 100 <= ,DivClk Delay".

Mode 1: The DIV_CLK signal becomes active once after N
communication cycles.

Mode 0, Mode 1,
Default: Mode 0

ConCIk polarity

Control Clock Polarity: This communication synchronization flag defines
the output state of the communication synchronized hardware output
signal CON_CLK.

Disabled, High Activity,
Low Activity,
Default: Disabled

Slave Configuration

configuration
type

0x0101 - SCP_FixCFG Version 1.1.1,
0x0201 - SCP_VarCFG Version 1.1.1,
0x0202 - SCP_VarCFG Version 1.1.3

According to the Sercos specification third generation the Sercos
Communication Profiles Classes SCP-FixCFG and SCP-VarCFG define
the basic communication and are mutually exclusive.

SCP-FixCFG: Exact two connections are supported, one as consumer
and one as producer. The content of the connections is defined by the
Slave and cannot be changed by the Master.

SCP-VarCFG: A certain number of connections is supported. The Slave
defines this number and provides it to the Master. The content of all
connections has to be configured (e.g. by the Master). The Slave
provides lists of IDNs, that can be cyclically produced and consumed, so
the Master can find it out.

Number of The number of used Sercos addresses For NT 100-RE/S3S,
slaves : : ; NB 100-RE/S3S: 1
Fix setting for Gateway devices. '
X "9 way aevi Default: 1
Slave 1
Sercos address | Address for the Sercos Slave. 1...511,
The address range is from 1 to 511. Default: 1
FSP type Function Specific Profile Type according to IDN S-0-1302.x.01 FSP type |10 V1, Drive V1,
& Version: The FSP type indicates the function specific type of the Default: 10 V1
resource.
Supported FSP profiles: FSP_IO, FSP_Drive
FSP 10: A specification for IO Devices to be controlled by Sercos,
FSP Drive: A specification for mechanical drives to be controlled by
Sercos
SCP SCP config type according to Sercos specification third generation: Fix. Version 1.1.1,

Var. Version 1.1.1,
Var. Version 1.1.3
Default

Fix. Version 1.1.1

Output data
size for FixCfg

Output data size for Fixed Configuration in Byte for ,SCP configuration
type" / ,Fix. Version 1.1.1¢

Note: The output data size is part of the SDDML device description file.
If you use a Sercos Master which is using SDDML files for configuration
and the default output data size was changed, then you have to export a
new updated SDDML file from the Slave configuration software and
import this SDDML file into the configuration software for the Sercos
Master.

0 ... 200 Byte,
Default: 2 Byte

Input data size
for FixCfg

Input data size for Fixed Configuration in Byte for ,SCP configuration
type“ / ,Fix. Version 1.1.1*

Note: The input data size is part of the SDDML device description file. If
you use a Sercos Master which is using SDDML files for configuration
and the default input data size was changed, then you have to export a
new updated SDDML file from the Slave configuration software and
import this SDDML file into the configuration software for the Sercos
Master.

0 ... 200 Byte,
Default: 2 Byte
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User SCP types

Up to 20 User SCP types are possible. The following User SCP types
are already defined:

0x0401 - SCP_WD Version 1.1.1 for monitoring connections,

0x0501 - SCP_Diag Version 1.1.1 for bus-diagnosis,

0x0601 - SCP_RTB Version 1.1.1 for using Real time bits,

0x0901 - SCP_Mux Version 1.1.1 for multiplexed cyclic data,

0x0BO01 - SCP_Sig Version 1.1.1 for using signal status/control words

For gateway devices no user SCP types are supported. Therefore do not
select any type.

SCP_WD Version 1.1.1,

SCP_Diag Version 1.1.1,
SCP_RTB Version 1.1.1,
SCP_Mux Version 1.1.1,
SCP_Sig Version 1.1.1

Slave flags

Use a default object dictionary
For gateway devices check always.

For NT 100-RE/S3S,
NB 100-RE/S3S:
checked, unchecked,
Default: checked

Delete objects created by application on reset
For gateway devices check always.

For NT 100-RE/S3S,
NB 100-RE/S3S:
checked, unchecked,
Default: checked

Master is not allowed to change Sercos address:
enables (unchecked) or disables (checked) that the Master changes the
Sercos address.

For gateway devices check always.

For NT 100-RE/S3S,
NB 100-RE/S3S:
checked, unchecked,
Default: checked

Slave Connections 1, 2, 3 and 4

Connection
Control offset

Connection Control Offset for the Slave connections 1, 2, 3 and 4

Connection Control Offset 1 (slave -> master):
For gateway/proxy devices use 0,

Connection Control Offset 2 (master -> slave):
For gateway/proxy devices use 0,

Connection Control Offset 3 (not supported):
For gateway/proxy devices use 0,

Connection Control Offset 4 (not supported):
For gateway/proxy devices use 0.

0...5.758,
Default: O

Real Time Data
offset

Real Time Data Process Image Offset for the Slave connections 1, 2, 3
and 4

Real Time Data Offset 1 (slave -> master):
For gateway/proxy devices use 2,

Real Time Data Offset 2 (master -> slave):
For gateway/proxy devices use 2,

Real Time Data Offset 3 (not supported):
For gateway/proxy devices use 0,

Real Time Data Offset 4 (not supported):
For gateway/proxy devices use 0.

0...5.760,
Default: 2

Maximum
allowed Real
Time Data
length

Maximum allowed Real Time Data length for the Slave connections 1, 2,
3 and 4.

0 ... 126 Byte,
Default

NT 100-RE/S3S,

NB 100-RE/S3S:
Connections 1 to 4:
126 Byte

Table 27: Sercos Slave Parameter

communication.

Note: To configure the Master, an XML file (device description file) is required. The
settings in the used Master must comply with the settings in the Slave to establish
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5.2.7 VARAN-Client (Slave) Parameters
Parameter | Meaning Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Application controlled,
Automatic;
Default: Automatic

Client watchdog time
[ms]

Watchdog time within which the device watchdog must be retriggered
from the application program while the application program monitoring
is activated. When the watchdog time value is equal to0 the application
program monitoring is deactivated.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0 data status*

Status of the input or the output data.
*(not supported)

This value is specific for every single vendor.

Ident

Check box If the box is unchecked, for the single Ident parameters each the Checked, unchecked,
respective default value is used. Default: unchecked

Vendor ID Vendor Identifier: Identification number of the manufacturer. 0x00000000 ...

OXFFFFFFFF (hex),
Hilscher:
0x0000001D(hex)

Vendor name

Name of the manufacturer, specific for every single vendor.

Character string,
0 ... 64 characters,
Default: Hilscher

GmbH
Device ID Device Identifier: Identification number of the device as indicated by 0x00000000 ...
the VARAN-BUS-NUTZERORGANISATION. This value is specific for | OXFFFFFFFF (hex),
every single device type and is fixed for every device. In case of an Default for
unknown device ID the manager rejects the client. CIFX RE/VRS:

0x0000048C (hex),
COMX 51XX-RE/VRS:
0x00000000 (hex),
COMX 100XX-RE/VRS:
0x0000048A (hex),
NETX 50 RE/VRS:
0x000003FD (hex),
NETX 100 RE/VRS:
0X000003FD (hex),
NETX 500 RE/VRS:
0x000003FD (hex),

NJ 50X-RE/VRS:
0x00000488 (hex);

NJ 51X-RE/VRS:
0x00000000 (hex);

NJ 100XX-RE/VRS:
0x00000489 (hex)

Device name

Name of the device as indicated by the VARAN-BUS-
NUTZERORGANISATION.

Character string,

0 ... 64 characters,
Default:

CIFX RE/VRS,
COMX RE/VRS,
NETX 50 RE/VRS,
NETX 100 RE/VRS,
NETX 500 RE/VRS,
NJ50x-RE/VRS;
NJ100xx-RE/VRS

Product version

Version of the device as specified by the manufacturer.

0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00000000 (hex)

Order number

Order number of the device as specified by the manufacturer.

0x00000000 ...
OXFFFFFFFF (hex) ,
Default:
0x00000000 (hex)

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017




Configuration

73/266

Parameter

Meaning

Range of Value/Value

Serial number

Serial number of the device as specified by the manufacturer.

0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00000000 (hex)

License number

License number of the device as specified by the VARAN-BUS-
NUTZERORGANISATION.

0x00000000 ...
OXFFFFFFFF (hex) ,
Default:
0x00000000 (hex)

Bus

Client watchdog time

Client watchdog time in ms. The Client watchdog time is the maximum
cyclic communication timeout allowed, before Client signals a bus
error.

Example: Client watchdog time set to 50ms and Client is unplugged from the

network (or the Manager is set into stop mode), then the Client goes in an error
state on the 50th ms after this event.

[0 ... 130] ms,
Default = 130 ms,
0 = Off

Memory area 2*

If ‘Memory area 2’ is checked, the parameters for Memory area 2 are
enabled.

(*currently not supported, set to default value)

Checked, unchecked,
Default: unchecked

EMAC*

EMAC = Extended MAC-Address

If ‘EMAC’ is checked, an integrated EMAC for IP data exchange with
client application is used.

(*currently not supported, set to default value)

Checked, unchecked,
Default: unchecked

Memory area 2*

*(not supported)

Memory area 1 / Memory area 2

Read size / Reading size of the memory area 1 0 ... 128 Byte,
Memory area 1 Default: 128 Byte
Read size / Reading size of the memory area 2 0 ... 128 Byte,
Memory area 2* *(not supported) Default: 0 Byte
Write size / Writing size of the memory area 1 0 ... 128 Byte,
Memory area 1 Default: 128 Byte
Write size / Writing size of the memory area 2 0 ... 128 Byte,

Default: 0 Byte

Read offset /
Memory area 1

Reading offset of the memory area 1

0x00000000 ...
0x0000FFFF (hex),
Default:
0x00002000 (hex)

Read offset /
Memory area 2*

Reading offset of the memory area 2
*(not supported)

0x00000000 ...
0x0000FFFF (hex) ,
Default:
0x0000FFFF (hex)

Write offset /
Memory area 1

Writing offset of the memory area 1

0x00000000 ...
0x0000FFFF (hex) ,
Default:
0x00002000 (hex)

Write offset /
Memory area 2*

Writing offset of the memory area 2
*(not supported)

0x00000000 ...
0x0000FFFF (hex) ,
Default:
0x0000FFFF (hex)

Sync OUT 0/ Sync OUT 1

Note!

Only the following 3 combinations between SyncOutOMode + SyncOut1Mode are

reasonable:

"Time for IN/OUT valid (TIO)" + "Disable",

"Time for IN valid (T1)" + "Time for OUT valid (T0)",
"Time for OUT valid (TO)" + "Time for IN valid (TI)"

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017




Configuration 74/266
Parameter Meaning Range of Value/Value
Mode / The "SyncOut 0 Mode* applies the "SYNC OUT 0 ID” to the output of | Time for IN/OUT Valid
Sync OUT 0 the SYNC Out 0 signal. Using the setting (T10), _

- "Time for IN Valid (TI)“ for the output of the SYNC Out 0 signal the Pme ;Or '(;\'U\1/_a\|'/d I'(:j—l)i'o
time for the data IN is valid, chr;‘(;ucl)tr' alid (TO),
- Time for OUT Valid (TO) _for the output of the SYNC Out 0 signal the Time for INJOUT Valid
time for the data OUT is valid, (TIO)
- "Time for IN/OUT Valid (TIO)" for the output of the SYNC Out 0 signal
the time for the data IN/OUT is valid.
Mode / The "SyncOut 1 Mode * applies the "SYNC OUT 1 ID” to the output of | Disable, _
Sync OUT 1 the SYNC Out 1 signal. Using the setting Time for IN Valid (T1),
- "Disable* means the output of the SYNC Out 1 signal is not available, | T'me for-OL_JT Valid (TO),
- "Time for IN Valid (TI)* for the output of the SYNC Out 1 signal the Default: Disable
time for the data IN is valid,
- "Time for OUT Valid (TO)" for the output of the SYNC Out 1 signal the
time for the data OUT is valid.
Output / The “Sync out 0 flag/Output” enables / disables the output of the Enable, Disable,
Sync OUT 0 Memory area 1 SYNC Out 0 signal. Default: Enable
Output / The “Sync out 1 flag/Output” enables / disables the output of the Enable, Disable,
Sync OUT 1 Memory area 2 SYNC Out 1 signal. Default: Disable
Polarity / The “Sync out O flag/Polarity” defines the active high/low behavior of Active Low,
Sync OUT 0 the SYNC Out 0 signal. Active High,
Default: Active Low
Polarity / The “Sync out 1 flag/Polarity” defines the active high/low behavior of Active Low,
Sync OUT 1 the Memory area 2 SYNC Out 1 signal. Active High,
Default: Active Low
Pulse length (x10ns) | Pulse length of the SYNC Out signal in 10ns steps. 0...2.147.483.647,
(e.g. the value 100 results as 10ns*100=1000ns=1ps pulse) Default: 100
Data
Recv data length Length of the received data in Byte. Default: 128 Byte
Send data length Length of the send data in Byte. Default: 128 Byte

Table 28: VARAN Client (Slave) Parameters

Note: The settings in the used VARAN Manager (Master) must comply
with the settings in the Client to establish communication. Important
parameters are: Station Name, Vendor ID, Device ID, Recv Data Length
and Send Data Length and Memory area Read offset / Write offset.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Configuration

75/266

5.3 Fieldbus Systems

53.1 PROFIBUS DP Slave Parameters
Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Automatic (Default)

Watchdog time
[ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

1/0 data status

Status of the input or the output data.

For each input and output data the following status information (in Byte) is
memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Ident

Ident number

PROFIBUS Identification Number

0x00000000 ...
OX0000FFFF (hex),
Default:

NT 50 DP/DPS:
0x000000C99 (hex),
NT 100 DP/DPS:
0x000000COE (hex),
NB 100 DP/DPS:
0x00000C9C (hex)

the address switch.
If checked, the station address is configured at the address switch.

The parameter ‘Enable Address Switch’ with the setting ‘checked’ can only
be used for NT 100-DP/DPS and NT 50-DP/DPS.

Enable If ‘Enable’ is unchecked, the default value is used.

Bus

Station address | PROFIBUS address of the device 0...126

Enable address | Is only displayed here; is enabled in the Settings window. Default

switch Defines if the station address is configured in the configuration software or at NB 100 DP/DPS:
unchecked,

NT 100 DP/DPS,
NT 50 DP/DPS:
checked

Baud rate

Network Baud Rate

9,6 kBit/s
19,2 kBit/s
93,75 kBit/s
187,5 kBit/s
500 kBit/s
1,5 MBit/s
3 MBit/s

6 MBit/s

12 MBit/s
31,25 kBit/s
45,45 KBit/s
Auto-detect
Default: Auto-detect

Extras

Sync supported: If checked, the Slave stack supports the SYNC command
or the SYNC mode is activated.

Freeze supported: If checked, the Slave stack supports the FREEZE
command or the FREEZE mode is activated.

Fail safe supported: If checked, the FAILSAFE operation is supported or the
FAILSAFE mode is activated.

Default: checked

DPV1 enable: If checked, DPV1 is supported or the DPV1 functions are
activated.

Address change not allowed:If checked, the Slave stack supports the Set
Slave Address command. The bus address can be changed via the Master.
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The identifier bytes consists of the Type and the Size.

The identifier bytes are the general identifier bytes according to the
PROFIBUS standard.

Parameter | Meaning Range of Value/Value
Data
Output Module:
or for output modules 1..4
Input for input modules 5..8
Type: .Byte*,
Byte or Word Word“(Default)
each with consistency
Size: 0,1,23,4,8,12,
The number of Bytes or Words in the module. 16, 20, 32, 64 (Byte,
Word)
Configuration Configuration data for the output and input identifier bytes. Default: A1, 91 hex
data

Manual input

If “Manual input” is unchecked the field “Configuration data” shows the
output and input identifier bytes, which results from the settings of the output
modules and input modules.

If “Manual input” is checked the field “Configuration data” is editable. Output
and input identifier bytes can be entered into the Configuration Data field to
configure the device. Then, the settings of the output modules and input
modules have no meaning.

Default: unchecked

Output data
bytes

Total of the output identifier bytes of the modules 1 to 4

0 ... 244, Default: 2

Input data bytes | Total of the input identifier bytes of the modules 5 to 8

0 ... 244, Default: 2

Table 29: Parameters - PROFIBUS-DP Slave (Part 2)

Note: The input and output modules each work with 'consistency’.

Note: To configure the Master, a GSD file (device description file) is
required. The settings in the used Master must comply with the settings in

the Slave to establish communication. Important parameters are: Station
Address, Ident Number, Baudrate and Config Data (the configuration data

for the output and input length).

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Configuration 77/266
5.3.2 CANopen Slave Parameters
Parameter Meaning Range of
Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Default: Automatic

Watchdog time [ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535]
ms, default = 1000
ms,

0 = Off

1/0 Data status

Status of the input or the output data.

For each input and output data the following status information
(in Byte) is memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Ident
Enable If ‘Enable’ is unchecked, for the single Ident parameters each
the respective default value is used.
Vendor ID Identification number of the manufacturer 0x00000000 ...

Ox0000FFFF (hex),
Hilscher:
0x00000044 (hex)

Product code

Product code of the device as specified by the manufacturer

0x00000000 ...
OXFFFFFFFF (hex),
Default:

NT 50-CO/COS:
0X001ACB60 (hex),
NT 100-CO/COS:
0x001A2020 (hex),
NB 100-CO/COS:
0x001B3190 (hex)

Revision number

Revision number of the device as specified by the manufacturer

0x00000000 ...
OXFFFFFFFF (hex),
Default:
0x00020000 (hex)

Serial number

Serial number of the device

0x00000000 ...
OXFFFFFFFF (hex)

Bus

Node ID

Node ID of the CANopen Slave

1... 127, Default: 2

Enable address switch

Is only displayed here; is enabled in the Settings window.

Defines if the Node ID is configured in the configuration
software or at the address switch.
If checked, the Node ID is configured at the address switch.

The parameter ‘Enable Address Switch’ with the setting
‘checked’ can only be used for NT 100-CO/COS and NT 50-
COICOS.

Default

NB 100-CO/COS:
unchecked,

NT 100-CO/COS,
NT 50-CO/COS:
checked

Baud rate

Baud rate of CANopen connection
Available Baud Rate:

Auto-Detect
1 Mbaud,
800 Kbaud,
500 Kbaud,
250 Kbaud,
125 Kbaud,
100 Kbaud,
50 Kbaud,
20 Kbaud,
10 Kbaud,
Default: 1 MBaud

Data
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Parameter Meaning Range of
Value/Value
Send object/ Send object: Send object index 0x00002000 ...
Receive object Receive object: Receive object index 0x00002003 (hex)
0x00002200 ...
0x00002203 (hex)
Size: 128
Number of data Bytes to send per send object
or number of data Bytes to receive per send object.
Output data bytes Total output data bytes of all send objects 512,
Default: 512 Bytes*
Input data bytes Total intput data bytes of all receive objects 512,
Default: 512 Bytes*

Table 30: CANopen Slave Parameters

Note: To configure the Master, an EDS file (device description file) is
required. The settings in the used Master must comply with the settings in
the Slave to establish communication. Important parameters are: Node
Address and Baudrate.

Note: *The maximum number of output data bytes and input data bytes is
for the device 512 bytes each. The number of output data bytes and input
data bytes is not adjustable in the Slave and therefore greyed out in the
dialog.

The number of output data bytes and input data bytes, which are to be
transferred effectively between the CANopen Master and Slave, are
configured in the used CANopen Master. The CANopen Master configures
the device during establishing the communication and set the number of
output data bytes and input data bytes at this same time.
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5.3.3 DeviceNet Slave Parameters
Parameter | Meaning | Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Default: Automatic

Watchdog time
[ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0 data status

Status of the input or the output data.

For each input and output data the following status information (in Byte) is
memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

Default: None

Ident
Enable If ‘Enable’ is unchecked, for the single Ident parameters each the respective
default value is used.
Vendor ID Identification number of the manufacturer 0x00000000 ...

0x0000FFFF (hex),
Hilscher:
0x00000011B (hex)

Product code

Product code of the device

0x00000000 ...
OXFFFFFFFF (hex),
Default

NT 50 DN/DNS:
0x0000002D (hex),
NT 100 DN/DNS:
0x00000002B (hex),
NB 100 DN/DNS:
0x0000002F (hex)

Serial number | Serial number of the device 0x00000000 ...
OXFFFFFFFF (hex)
Product type Communication Adapter 0x00000000 ...

0x0000FFFF (hex),
Default:
0x00000000C (hex)

Major revision | Major revision 1...255,
Default: 1
Minor revision | Minor revision 1...255,
Default: 1
Product name | The variable Product Name is a text string that should represent a short 0...31ASCI
description of the product/product family. Characters
Bus
MAC ID This parameter defines the DeviceNet address of the device within the 0...63,
network. Default: 2
Enable address | Is only displayed here; is enabled in the Settings window. Default
switch Defines if the MAC ID is configured in the configuration software or at the NB 100 DN/DNS:
unchecked,

address switch.
If checked, the MAC ID is configured at the address switch.

NT 100 DN/DNS,
NT 50 DN/DNS:

The parameter ‘Enable Address Switch’ with the setting ‘checked’ can only | checked
be used for NT 100-DN/DNS and NT 50-DN/DNS.
Baud rate Baud rate of DeviceNet connection 500 kBaud,
250 kBaud,
125 kBaud,
Default: 500 kBaud
Extras Ignore address switch: address switches are always ignored Default: unchecked
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Parameter Meaning

Range of Value/Value

Continue on bus off:

off event (e. g. short circuit of the data lines)

CAN bus off event

Unchecked: A device reset by the user is necessary in case of a CAN bus

Checked: The device tries independently to continue operation in case of a

Default: unchecked

Continue on loss of network power (NP): Function not supported

Default: unchecked

Receive-idle clears data:

Unchecked: Received data keep their last state in case of idle state
Checked: Received data were set to zero in case of idle state

Default: unchecked

Receive Idle keeps data: Function not supported

Default: unchecked

Data

Consumed data | Consumed data length sets the number of receive bytes. 0 ... 255,
length Default: 8
Produced data | Produced data length sets the number of send bytes. 0 ... 255,
length Default: 8

Table 31: DeviceNet Slave Parameters

Note: To configure the Master, an EDS file (device description file) is
required. The settings in the used Master must comply with the settings in
the Slave to establish communication. Important parameters are: MAC ID,
Baudrate, Produced Size, Consumed Size, Vendor ID, Product Type,

Product Code, Major Rev, Minor Rev.
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5.34 CC-Link Slave Parameters
Parameter | Meaning Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Application controlled,
Automatic (Default)

Watchdog time
[ms]

Watchdog time within which the device watchdog must be
retriggered from the application program while the application
program monitoring is activated.

When the watchdog time value is equal to O the application program
monitoring is deactivated.

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

I/0 data status

Status of the input or the output data.

For each input and output data the following status information (in
Byte) is memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

None, (1 Byte, 4 Byte)
Default: None

Ident

Enable

If ‘Enable’ is unchecked, for the single Ident parameters each the
respective default value is used.

Vendor code

Code for the Vendor

0 ... 65535 bzw.
0x00000000 ...
0x0000FFFF (hex),
Hilscher:
0x00000352 (hex)

Model type

Model type

0... 255,

Default

NT 50-CC/CCS,

NT 100-CC/CCS: 1,

CIFX CC/CCS,

NETX 50 CC/CCS,

NETX 100 CC/CCS,
NETX 500 CC/CCS: 2
COMX 10XX-CCS/CCS: 3,
NJ 10XX-CCS/CCS: 4

Software
version

Software version

0...63,
Default: 4

Bus

Station address

Station address of CC-Link Slave

Note: The number of occupied stations plus station address must
not exceed the parameter range

1..64,
Default: 1

Enable address

switch

Is only displayed here; is enabled in the Settings window.

Defines if the station address is configured in the configuration
software or at the address switch.
If checked, the station address is configured at the address switch.

The parameter ‘Enable Address Switch’ with the setting ‘checked’
can only be used for COMX 10XX-CCS/CCS.

Default:

CIFX CC/CCS,

NT 50-CC/CCS,

NT 100-CC/CCS,
NETX 50-CC/CCS,
NETX 100 CC/CCS,
NETX 500 CC/CCS,
NJ 10XX-CCS/CCS:
unchecked

COMX 10XX-CCS/CCS,
checked

Baud rate

Network transmission rate

156 kBaud (Default)
625 kBaud

2500 kBaud

5 MBaud

10 MBaud
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received output
data

Clear output data (unchecked)
Hold last received output data (checked)

Configuration 82/266
Parameter Meaning Range of Value/Value
Enable baud Defines if the baudrate is configured in the configuration software or | Default:
rate switch at the baudrate switch. CIFX CC/CCS,

If checked, the baudrate is configured at the baudrate switch. NT 50-CC/CCS,
The parameter ‘Enable Address Switch’ with the setting ‘checked’ NT 100-CC/CCs,
can only be used for COMX 10XX-CCS/CCS. NETX 50-CC/CCS,
NETX 100 CC/CCS,
NETX 500 CC/CCS,
NJ 10XX-CCS/CCS:
unchecked
COMX 10XX-CCS/CCS;:
checked
Data
CC-Link CC-Link Version 1 1 (Default)
version CC-Link Version 2 2
Hold last Hold Clear Mode; Behavior in case of bus error Default: unchecked

Station type

Type of CC-Link station

Remote I/O Station: 0 (Default)
Remote Device Station 1

Number of Number of occupied stations

stations Remote I/O Station: 1 (Default)
Remote Device Station: 1..4

Extension Number of extension cycles

cycles Allowed numbers for CC-Link version 1:
Single/One cycle 1
Allowed numbers for CC-Link version 2:
Single/One cycle 1 (Default)
Double/Two cycles 2
Quadruple/Four cycles 4
Octuple/Eight cycles 8

I/O data bytes

The number of I0-Data bytes depends on the following settings:
station type, number of stations and number extension cycles. The
number of stations can only be configured with station type Remote
Device Station version 1 and version 2 and the number of extension
cycles can only be configured with version 2.

Firmware/stack works according to CC-Link Version 2.0
input data
output data

Firmware/stack works according to CC-Link Version 1.11
input data
output data

12 ... 368 Bytes
12 ... 368 Bytes

4 ... 48 Bytes
4 ... 48 Bytes
Default: 4

Table 32: CC-Link Slave Parameters

Note: To configure the Master, a CSP file (device description file) is
required. The settings in the used Master must comply with the settings in
the Slave to establish communication.

Important parameters are: Slave Station Address, Baudrate, Station Type
and Vendor Code. For CC-Link Version 2.00 are important: number of
cycles as well as number of extension cycles.
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5.3.5 CompoNet Slave Parameters
Parameter | Meaning Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Application controlled,
Automatic (Default)

Watchdog time
[ms]

Watchdog time within which the device watchdog must be retriggered from
the application program while the application program monitoring is
activated.

When the watchdog time value is equal to 0 the application program
monitoring is deactivated.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

1/0O data status

Status of the input or the output data.

For each input and output data the following status information (in Byte) is
memorized in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

None, (1 Byte, 4 Byte)
Default: None

Ident
Enable If ‘Enable’ is unchecked, for the single Ident parameters each the respective
default value is used.
Vendor ID Identification number of the manufacturer 0x00000000 ...
If the value 0x00000000 (hex) is entered, the firmware uses the internal E')i(lg?:ggEFFF (hex),
Hilscher ID 0x0000011B (hex). OXOOOOdllB (hex)
Product code Product code of the device 0x00000000 ...

The firmware uses the entered value.

OXFFFFFFFF (hex),
Default:

CIFX CP/CPS:
0x00000201 (hex),
NETX 50 CP/CPS:
0x00000203 (hex),
NETX 100 CP/CPS:
0x00000204 (hex),
NETX 500 CP/CPS:
0x00000205 (hex)

Serial number

Serial number of the device

If the value 0x00000000 (hex) is entered, the firmware uses the internal
device serial number.

0x00000000 ...
OXFFFFFFFF (hex)

Product type Communication Adapter 0x00000000 ...
If the value 0x00000000 (hex) is entered, the firmware uses the value OxD000FFFF (hex),
0x0000000C (hex). Default:

0x0000000C (hex)

Major revsion If the value 0 is entered, the firmware uses the value 1. 0 ... 255,

Default: 1

Minor revision If the value 0 is entered, the firmware uses the value 1. 0 ... 255,

Default: 1

Product name | The variable Product Name is a text string that should represent a short 0...31ASCll
description of the product/product family. Characters
If no product name is entered, the device uses an internal default name.

Bus

Node mode Node mode of the CompoNet Slave Word MIX  Slave,

Word IN Slave,
Word OUT Slave,
Bit MIX Slave,
Bit IN Slave,
Bit OUT Slave,
Default:

Word MIX  Slave

Node address | Node address of the CompoNet Slave Default: 2
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MAC ID

The MAC ID defines the CompoNet address of the device within the
network.

The MAC ID is calculated from the selected Node type and from the
selected Node Address according to the following table. In this field the
MAC ID is only displayed.

0...383,

Default: 2 (when using
the default values for
node type and node
address)

Node type Node Address MAC ID
Word IN 0-Ox3F 0x0-0x3F (0-63)
Word OUT 0-Ox3F 0x40-0x7F (64-127)
Word MIX 0-Ox3F 0x0-0x3F (0-63)
Bit IN 0-Ox7F 0x80-0xFF (128-255)
Bit OUT 0-Ox7F 0x100-0x17F (256-383)
Bit MIX 0-Ox7F 0x80-0xFF (128-255)
Baud rate Baud rate of the CompoNet connection Auto-detect,
93,75 kbps,
1,5 Mbps,
3 Mbps,
4 Mbps
Default: Auto-detect
Data
ProduceddData | Produced data sets the number of send points (Bits). Node type ,Bit"
2, 4 (Points), Default: 2
Prodl{‘c_eq data can be selected for the Node type ,IN“ and ,MIXED", for Nodé ty;I)e ,,)\Nord“:u
,OUT" it is grayed out. 8, 16, 32, 48, 64, 80, 96,
112, 128, 144, 160, 170,
192, 208, 224, 240, 256
(Points), Default:16
Size The number of bytes in the module for the produced data. 1... 32 (Bytes)*
(Produced [*=8 ... 256 Points]
data) Default

Node type ,Bit*: 1
Node type ,Word": 2

Consumed data

Consumed data sets the number of receive points (Bits).

Consumed data can be selected for the Node type ,OUT" and ,MIXED", for
LN“it is grayed out.

Node type ,Bit*:

2, 4 (Points), Default: 2
Node type ,Word":

8, 16, 32, 48, 64, 80, 96,
112, 128, 144, 160, 170,
192, 208, 224, 240, 256
(Points), Default:16

Size
(Consumed
data)

The number of bytes in the module for the consumed data.

1... 32 (Bytes)*
[*=8 ... 256 Points]
Default

Node type ,Bit": 1
Node type ,Word": 2

Table 33: CompoNet Slave Parameters

Note: To configure the Master, an EDS file (device description file) is
required. The settings in the used Master must comply with the settings in

the Slave to establish communication. Important parameters are: Node
Mode, MAC ID, Baudrate, Produced Data, Consumed Data, Vendor ID,

Product Type, Product Code, Major Rev, Minor Rev.
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5.4 Serial Protocols

541 Modbus RTU Parameters
Parameter ‘ Meaning Range of Value/Value
Interface

Bus startup

Communication start application controlled or automatic

Application controlled,
Automatic (default)

Watchdog time
[ms]

Watchdog time within which the device watchdog must be retriggered
from the application program while the application program monitoring is
activated.

When the watchdog time value is equal to 0 the application program
monitoring is deactivated.

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Watchdog timer off

Address Valid address range of the data. 0...65535
mapping This parameter can not be edited here.
Data swapping | Data-storage mode: Yes, No,

No: Data will not be swapped
Yes: Data will be swapped.

Default:: Yes

Map FC1 If unchecked, data are read from the intput area using FC1, FC3 and checked,

and FC3 FC23. unchecked,
If checked, data are read from the output area using FC1, FC3 and Default: unchecked
FC23. FC1 then can be used instead of FC2 and FC3 instead of FC4.

Ident

Device Device code NT50, NT100 (Default),
If ‘Enable’ is unchecked, the default value is used. NB100, String

Bus

Protocol mode

Determines the Mode of operation: Master or Slave.

For ,Master* mode Command Table is displayed in the navigation area.
For the Modbus RTU Master the Command Table is a list with
commands for the reading or writing of data.

Master, 10 Slave,
Slave (default)

Response Timeout value (specified in milliseconds) , 10 ... 10000 ms,
timeout Only valid for Master mode: Defines the maximum waiting time of the Default: 1000

master for an answer from the slave
Modbus Defines the own Modbus address of the Gateway device. 1 ... 247, Default; 2
address
Send retries Defines number of telegram retries when connection fails. 0...10,

Relevant only for operation as ,Master”. Default: 3
Interface type COM-Interface to be used RS232, RS485, RS422,

SPI Mode3,

Default: RS232

RTS control Signal “Return To Send line™ can be switched off or on. RTS Control Off (default),
(*netTapl100 - see hardware manual). RTS Control On
Baud rate Modbus RTU Network Baud Rate. Defines the transmission rate. 1,2 kBit/s,
2,4 kBit/s,
4,8 kBit/s,
9,6 kBit/s (Default),
19,2 kBit/s,
38,4 kBit/s,
57,6 kBit/s,
115,2 kBit/s
Stop bits Defines the quantity of stop bits, to be used in protocol for serial data 1,2
communication Default: 2
Parity Defines the parity bit for serial data communication. None, Even, Odd,

Default: Even
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Frame format | This parameter is not supported here. Include address and CRC,
EXclude address and CRC,
Default: Include address and

CRC
Data
Number of Not editable in protocol mode master 0 ... 65535,
registers Default: 2880
Number of coils | not editable 0... 65535,

Default: Automatic

Table 34: Modbus RTU Parameters

Settings for Modbus RTU Slaves

Note: The settings in the used Modbus RTU Slaves must comply with the
settings in the netTAP or netBRICK device as Modbus RTU Master to
establish a communication. Important parameters are: Modbus RTU
address, baud rate, number of stop bits and parity setting.
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542 3964R-Parameters
Parameter | Meaning |Value Range/Value
Interface

Bus startup

Communication start application controlled or automatic

Default: Automatic

Watchdog time [ms]

This function is not supported by gateway or proxy devices.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Watchdog timer off

1/0 data status

Status of the input or the output data.

For each input and output data the following status information (in
Byte) is stored in the dual-port memory:

Status 0 = None (default)

Status 1 = 1 Byte (for future use)

Status 2 = 4 Byte (for future use)

None, (1 Byte, 4 Byte)
Default: None

Application mode

Mode how the superordinated control unit controls to send a
3964R telegram respectively detects the receipt of a 3964R
telegram.

Handshake Mode: The control is done with synchronization
registers.

Default: Handshake Mode

After the maximum number of retries has been reached the data
transfer is aborted with error.

Ident
Device Device name
If ‘Enabled’ is unchecked, the default value is used.
Bus
Interface type Type of the serial interface, which should be used RS232 (Default),
RS422,
RS485
RTS control Specifies, if RTS control is activated or deactivated. RTS Control Off (Default),
When using the interface type RS-485, then "RTS Control on" has | RTS Control On
to be activated (On).
Baud rate Specifies the baud rate. 300 Bit/s
600 Bit/s
1200 Bit/s
2400 Bit/s
4800 Bit/s
9600 Bit/s (Default)
19200 Bit/s
38400 Bit/s
57600 Bit/s
115200 Bit/s
Data bits Specifies the number of data bits, 7 or 8 7,
8 (Default)
Stop bits Specifies the number of stop bits, 1 or 2 1 (Default)
2
Parity Specifies the parity bit of the serial data communication. None (Default),
None means that no parity bit is used. Even,
Odd
Conflict priority A conflict occurs when both devices start a data transfer at the High (Default),
same time. The conflict priority specifies the behavior for this Low
case: One device must have high priority the other device must
have low priority.
The device with high priority can continue with the data transfer
while the device with low priority must wait with the data transfer.
Retry limit When transmission errors occur, then the retry limit specifies the |0 ... 65535,
maximum number of retries to do a data transfer successfully. Default = 6
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Character delay time

The value specifies the time in ms within the remote device must
have sent the next character of a telegram. If the time is
exceeded, then an error is reported to the superordinated control
unit.

[4 ... 65535] ms,
Default = 220 ms

Acknowledge timeout

The value specifies the time in ms the remote device must have
sent an acknowledge. If the time is exceeded, then an error is
reported to the superordinated control unit.

[256 ... 65535] ms
Default = 550 ms

Data

Send data length max.

Maximum telegram length for receive data.
Received data are stored in the input data area.

0...5736,
1024 (Default)

Receive data length
max.

Maximum telegram length for send data.
Send data are taken from the output data area.

0...5736,
1024 (Default)

Table 35: 3964R Parameters

Settings for the 3964R Remote Device

Note: The settings in the used remote device must comply with the
settings in the netTAP or netBRICK device to establish a communication.
Important parameters are: Interface type, baud rate, data bits, parity, RTS
control, retry limit, character delay timeout and acknowledge timeout. The
conflict priority has to be set different for the used devices.
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5.4.3  ASCII Settings

Parameter Meaning Value Range/Value

Interface type Type of the serial interface, which should be used RS232 (Default),
RS485,
RS422

RTS Control Specifies, if RTS control is activated or deactivated. RTS Control Off (Default),

When using the interface type RS-485, then "RTS Control on" has to RTS Control On
be used.

Baud rate Specifies the baud rate. 300 Bit/s

600 Bit/s

1200 Bit/s

2400 Bit/s

4800 Bit/s

9600 Bit/s (Default)
19200 Bit/s

38400 Bit/s

57600 Bit/s
115200 Bit/s

Data bits Specifies the number of data bits, 7 or 8 7,
8 (Default)

Stop bits Specifies the number of stop bits, 1 or 2 1 (Default)
2

Parity Specifies the parity bit of the serial data communication. None (Default),
Even,
Odd

None means that no parity bit is used.

Table 36: ASCII Parameter

Settings for the remote ASCII Device

Note: The settings in the used remote ASCII device must comply with the
settings in the netTAP or netBRICK device to establish a communication.
Important parameters are: Interface type, baud rate, data bits, parity check
and respectively RTS control.

5.4.4 ASCII Parameters

The operating modes are:

¢ ‘Receive Only’ Mode

e ‘Send Only’ Mode

¢ Client Mode (first send, then receive)

e Server Mode (first receive, then send)

The further configuration parameters specify the
¢ the telegram structure of the send telegram,

¢ the telegram structure of the receive telegram,
¢ the timing,

¢ the size of the send and receive buffer
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5441 Telegram Structure in Data Stream

A send or receive telegram in the simplest case only consists only by user
data. Many implementations however add to the user data further
characters which have a certain meaning, such as a start character, an end
character, a checksum or a device address.

A typical telegram structure is e. g.
IStar{[D_a t a]|Checksum][End|

with for example (in hexadecimal notation):
[0x02] [0x38][0x33][0x33][0x37][0x38][0x30][0x33][0x37][0x36][0x33] [0x69][0xA5] [0x03]

Send Only Mode | _____ ecerve Only Mods Client Mode Server Mode

Receive Data Stream Configuration

|Start ﬂ|HEH j||:|2
| Data j | Constant Length(bytes] ﬂ |1 0
|Check ~||cRecie || 005
| End ﬂ | Hex ﬂ ||33

- | Bl =

[
Table 37: ASCII Telegram Structure Example

The serial data stream of the send and receive telegram each can be
defined with up to 10 structural elements.

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Configuration

91/266

Parameter [Description Range of Value /
Parameter Type
Unused Structural element is not used -
Start Start character of the telegram consisting of one or more characters ASCII,
The information is given as an ASCII character (Char) or as hexadecimal Hex,
(Hex). For the ASCII character 'STX' enter the hexadecimal value'02'. Decimal
When sending, the start character is inserted in the telegram.
When receiving, the start character is checked for equality.
Device Device Address ASCII,
When sending, the device address is inserted in the telegram. Thereby the Hex,
receiving device is specified. Decimal
When receiving, the device address is checked for equality.
Object Object Index or Start Address of the data in the device ASCII,
When sending, the object index / start address is inserted in the telegram. Hex,
When receiving, the object index / start address is checked for equality. Decimal
Command Command Identifier ASCII,
When sending, the Command Identifier is inserted in the telegram. Hex,
When receiving, the Command Identifier is checked for equality. Decimal
Data Length specification for Data Field or Telegram end (Character or Time) Constant Length (Bytes)
Length Specification: Byte Number Data
Constant Length (bytes): The data field has a fixed length. The information is | Word Number Data
given as number of bytes. Character Terminated
Byte Number Data: The length specification is given in one byte. When Unspecific
sending, this byte is inserted in the telegram directly before the data field.
When receiving, the value of this byte from the telegram is used as the length
of the directly following data field.
Word Number Data: The length specification is given in one word. When
sending, this word is inserted in the telegram directly before the data area.
When receiving, the value of this word from the telegram is used as the length
of the directly following data field.
Termination Character:
Character Terminated: The data field is terminated by a fixed end identifier
consisting of one byte. When sending, this termination character is inserted in
the telegram after the data field. When receiving, this termination character is
used to detect the end of the data field. The termination character is not part
of the data field.
Telegram end by time:
Unspecific: The end of the data field is done with the character delay time.
End End of the telegram character consisting of one or more characters ASCII,
The information is given as an ASCII character (Char) or as hexadecimal Hex,
(Hex). For the ASCII character 'ETX" enter the hexadecimal value'03'. Decimal
When sending, the end character is inserted in the telegram.
When receiving, the end character is checked for equality.
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Parameter [Description Range of Value /
Parameter Type

Check Checksum CRCS,

CRCS8: Any data of the telegram before the checksum are inserted in the initial | CRC16,
value zero with the polynomial 1D (default) and the 1-byte result is used as CRC32
checksum. '

Exor
CRC16: Any data of the telegram before the checksum are inserted in the

initial value zero with the polynomial 8005 (default) and the 2-byte result is
used as checksum.

CRC32: Any data of the telegram before the checksum are inserted in the
initial value zero with the polynomial 04C11DB7 (default) and the 4-byte result
is used as checksum.

Exor: Any data of the telegram before the checksum are set off against the
initial value zero with exclusive-or and the 1-byte result is used as checksum.

When sending, the computed checksum is inserted in the telegram.

When receiving, the checksum is calculated based on of the received
characters and is checked for equality with the received checksum.

Don't care [ Characters with no meaning Constant Length (Bytes)

Constant Length (bytes): Specifies the number of bytes, which have no
meaning and which should be ignored.

When sending, the number of characters with a value of zero is inserted in the
telegram.

When receiving, the number of characters is ignored and thus filtered out from
the telegram.

Table 38: Telegram Structure

Type Description

Hex Hexadecimals

The entry is made as a hexadecimal value. A hexadecimal value consists of 2 characters
in the range 00 to FF and result in one byte. Each character has the range of value 0, 1, 2,

.9, A B, ..., F.

ASCII ASCII Character
The entry is made as a character. A character is one of the following characters: A-Z, a-z,
0-9,1,"8% %,&/,(),=2,,-,,+*

Decimal Decimal value

The entry is made as a decimal value.

Table 39: Parameter Types

Example: The specification of the character A is as hexadecimal value '41',
as character 'A’ or as a decimal value 65.
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ASCII Character Table
ASCII ASCIl | Charac- | ASCII ASCIl | Charac- | ASCII ASCIl | Charac- | ASCII ASCIl | Cha-
Hex Dez = Hex Dez = Hex Dez = Hex Dez rEELEl
00 0 NUL 20 32 SP 40 64 @ 60 96
01 1 SOH "A | 21 33 ! 41 65 A 61 97 a
02 2 STX "B 22 34 " 42 66 B 62 98 b
03 3 ETX ~C 23 35 # 43 67 C 63 99 c
04 4 EOT "D 24 36 $ 44 68 D 64 100 d
05 5 ENQ "E 25 37 % 45 69 E 65 101 e
06 6 ACK "F | 26 38 & 46 70 F 66 102 f
07 7 BEL "G 27 39 ' 47 71 G 67 103 g
08 8 BS "H 28 40 ( 48 72 H 68 104 h
09 9 TAB A 29 41 ) 49 73 | 69 105 i
OA 10 LF N 2A 42 * 4A 74 J 6A 106 j
0B 11 VT K 2B 43 + 4B 75 K 6B 107 k
oC 12 FF "L 2C 44 , 4C 76 L 6C 108 I
oD 13 CR "M 2D 45 - 4D 77 M 6D 109 m
OE 14 SO "N 2E 46 4E 78 N 6E 110 n
OF 15 SI "0 2F 47 / 4F 79 0] 6F 111 0
10 16 DLE ~P 30 48 0 50 80 P 70 112 p
11 17 DC1 "Q 31 49 1 51 81 Q 71 113 q
12 18 DC2 "R 32 50 2 52 82 R 72 114 r
13 19 DC3 7S 33 51 3 53 83 S 73 115 S
14 20 DC4 ~T 34 52 4 54 84 T 74 116 t
15 21 NAK ~U 35 53 5 55 85 U 75 117 u
16 22 SYN V| 36 54 6 56 86 Y, 76 118 %
17 23 ETB "W | 37 55 7 57 87 W 77 119 w
18 24 CAN ~X | 38 56 8 58 88 X 78 120 X
19 25 EM Y 39 57 9 59 89 Y 79 121 y
1A 26 SUB ~Z 3A 58 5A 90 VA TA 122 z
1B 27 Esc 3B 59 ; 5B 91 [ 7B 123 {
1C 28 FS 3C 60 < 5C 92 \ 7C 124 |
1D 29 GS 3D 61 = 5D 93 1 7D 125 }
1E 30 RS 3E 62 5E 94 n 7E 126 ~
1F 31 us 3F 63 5F 95 _ 7F 127 DEL

Table 40: ASCIl Character Table
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5442 Size of the Send and Receive Buffer

The size of the send or receive buffer is configured.

Note: The send telegram must fit into the send buffer. The receive telegram
must fit into the receive buffer.

Parameter Description Range of Value
Sendbuffer Size Size of the send buffer in bytes 0..1024

Default: 512 Bytes
Receivebuffer Size [ Size of the receive buffer in bytes 0..1024

Default: 512 Bytes

Table 41: Size of the Send and Receive Buffer

5.4.4.3 Operating Modes and Timing

The modes are:

e ‘Receive Only’ Mode

e ‘Send Only’ Mode

¢ Client Mode (first send, then receive)

e Server Mode (first receive, then send)
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5.4.4.4 ‘Send Only’ Mode
Basic Principle
In the 'Send Only' mode the device only sends. The remote device only
receives. The superordinated control unit has to use a handshake to
transfer the data to the device.
Communication
The send operation can be triggered from the superordinated control unit or
performed by the device cyclically.
e triggered

Telegram Telegram Telegram >

With each handshake of the superordinated control unit a telegram is send.
For this, set the timing parameter Send Cycle Time to zero.
e Cyclic
The device sends in a constant cycle.
With each handshake of the superordinated control unit the send data
initially are updated in the internal buffer of the device and sent during the
next send cycle. For this, set the timing parameter Send Cycle Time to the
cycle time (unequal to zero).
Timing Parameter

Parameter Description Range of

Value
Send Cycle Specifies whether the telegram will be sent cyclically or triggered. 0..2%1
Time The value (unequal to zero) specifies the cycle time of the send telegram. Default: 0
The value 0 specifies that the send telegram is triggered.

Table 42: Timing Parameters for the Operating ‘Send Only’ Mode
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Configuration Example

¢ SendOnly Mode @ Receive Only Mode| Clignt Made | Server Mode |

Send Data Stream Configuration

Start ¥ ||Hex L|02
Data ¥ || Constant Length(bytes) L|1D
Check _~||CRC16 L|Ux8005
End 7 ||Hex L|DS
[ |
[ |
|
= _| Send Buffer
= _| Size:
i =l =l [ sizlbytes
Send Cycle Time: [ 0]ms
Send Data Streal } | | | t
[l -

Signal Configuration Enabled

Table 43: Telegram Structure for the Operating ‘Send Only’ Mode
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5.4.45 'Receive Only' Mode
Basic Principle
In the 'Receive Only' mode the device only receives. The remote device
only sends.
Telegram Telegram Telegram
-
The superordinated control unit must acknowledge the reception.
Communication
When configuring the telegram structure the method is defined how the end
of the telegram is detected:
e Character
e Length
e Time
Each telegram received is indicated to the superordinated control unit by
handshake. The superordinated control unit must acknowledge the
reception. Only after the acknowledgement the reception of a further
telegram can be indicated to the superordinated control unit.
Timing Parameter
Parameter Description Range of
Value
Receive Specifies whether the reception of subsequent telegrams is monitored by time. 0..2%1
Watchdog Thereby the remote device can be monitored. The time is taken from telegram end t0 | pafquit: 0
Time telegram end. '
The value (unequal to zero) specifies in what time the remote device must have sent
the next telegram. If the time is exceeded, then an error is reported to the host.
The value 0 specifies that the reception of subsequent telegrams is not monitored.
Character Specifies whether the time between two characters during reception is monitored by |0 ... 231-1
Delay Time time. Default: 0

The value (unequal to zero) specifies in what time the remote device must have sent
the next character. If the time is exceeded, then an error is reported to the host.

The value 0 specifies that no monitoring is performed.

Table 44: Timing Parameters for the Operating ‘Receive Only’ Mode
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Configuration Example

Client Mode | Server Mode

Send Only Maode |ﬂ

Receive Data Stream Configuration

|Start ﬂ|Hex j|02
Data _ || Constant Lengthlbytes) L|1D
Check _+||CRCTE || 0xg005
End v ||Hex |03
= |
=l |
=l ll _
| Receive Buffer
= _| Size:
= I [ siz]bytes
t
Character Delay Time: [ o]ms . ... .
. . = B
Signal Configuration Enabled [ Receive Watchdog Time: | o]ms Lai|

Table 45: Telegram Structure for the Operating ‘Receive Only’ Mode
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5.4.4.6 Client Mode (First Send, Then Receive)

Basic Principle

In the 'Client Mode' the device sends a telegram to the remote device. The
remote device then sends a telegram which is received by the device.

By this a polling (querying) of the remote devices can be performed. The
device can send a polling telegram with or without user data.

Send :|\| | Send :|\ >
l |
| |

> Receive \T Receive

-

The superordinated control unit must activate the send operation by
handshake. The superordinated control unit must acknowledge each
reception by handshake.

Communication

The send operation can be triggered or performed cyclically.
e triggered

With each handshake of the superordinated control unit a telegram is send.
For this, set the timing parameter Send Cycle Time to zero.

The remote device then sends a telegram which is received by the device.
The device can monitor the beginning of the receive telegram by time
monitoring via the Response Timeout parameter.

The superordinated control unit must activate the send operation by
handshake. The superordinated control unit must acknowledge each
reception by handshake.

e Cyclic
The device sends in a constant cycle.

With each handshake of the host the send data initially are updated in the
internal buffer and sent during the next sending cycle. For this, set the
timing parameter Send Cycle Time to the cycle time (unequal to zero).

The remote device then sends a telegram which is received by the device.
The device can monitor the beginning of the receive telegram by time
monitoring via the Response Timeout parameter.

The superordinated control unit must activate the send data by handshake.
The superordinated control unit must acknowledge each reception by
handshake.
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Timing Parameter

Parameter Description Range of
Value

Send Cycle Specifies whether the telegram will be sent cyclically or triggered. 0..2%%1

Time The value (unequal to zero) specifies the cycle time of the send telegram. Default: 0

The value 0 specifies that the send telegram is triggered.

Response Specifies whether the reception of the response telegram is monitored by time. 0..2%1
Timeout Thereby the remote device can be monitored. The time is taken from telegram end to Default: 1000
telegram end. '

The value (unequal to zero) specifies in what time the remote device must have sent
the response telegram. If the time is exceeded, then an error is reported to the host.

The value 0 specifies that the reception of response telegrams is not monitored.

Character Specifies whether the time between two characters during reception is monitored by |0 ... 231-1
Delay Time time. Default: 0

The value (unequal to zero) specifies in what time the remote device must have sent
the next character. If the time is exceeded, then an error is reported to the host.

The value 0 specifies that no monitoring is performed.

Table 46: Timing Parameters for the Operating Mode 'Client Mode'

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Configuration 101/266

Configuration Example

Send Only Mode | Receive Only Mode|

Send Data Stream Configuration

Start ¥ ||Hex ;|D2
Data || Constant Lengthlbytes] le
Check _r||cRC1E v ||0x8005
End v ||Hex ~|joa
=l ~ll
= l
I
= _| Send Buffer
= _| Size:
=] = yhes
. —
— Send Cycle Time: 0|ms .-
?en |—Da|El S_1r|_ea A Signal Configuration Enabled .- I:I.f
Signal Configuration Enabled el Character
TieeLEE Delay Time:
ms L oms
Receive Data Stream Configuration
Start ¥ ||Hex ;|D2
Data _ || Constant Length(bytes] le
Check _v||cRC16 _v||0x8005
End x|[Hex x|jo3
| ~ll
= ll
= | Receive Buffer
= —I Size:
| | [ siz]bytes

Table 47: Telegram Structure for the Operating Mode 'Client Mode'
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5.44.7 Server Mode (First Receive, Then Send)
Basic Principle
In the 'Server Mode' the device receives a telegram from the remote
device. The superordinated control unit must acknowledge each reception
by handshake. The superordinated control unit must activate by handshake
the send operation. The device then sends a telegram to the remote
device.
Receive [ Receive ‘
-
Send Send
| Send | | Send | >
Communication
When configuring the telegram structure the method is defined how the end
of the telegram is detected:
e Character
e Length
e Time
Timing Parameter
Parameter Description Range of
Value
Receive Specifies whether the reception of subsequent telegrams is monitored by time. 0..2%1
Watchdog Thereby the remote device can be monitored. The time is taken from telegram end to Default: 0
Time telegram end. '
The value (unequal to zero) specifies in what time the remote device must have sent
the next telegram. If the time is exceeded, then an error is reported to the host.
The value 0 specifies that the reception of subsequent telegrams is not monitored.
Response Specifies whether the reception of telegrams is monitored by time. Thereby the 0..2%1
Timeout remote device can be monitored. The time is taken from the end of the send telegram .
. Default: 1000
to the start of the receive telegram.
The value (unequal to zero) specifies in what time the remote device must have sent
the next telegram. If the time is exceeded, then an error is reported to the host.
The value 0 specifies that the reception of telegrams is not monitored.
Character Specifies whether the time between two characters during reception is monitored by |0 ... 231-1
Delay Time time. Default: 0
The value (unequal to zero) specifies in what time the remote device must have sent
the next character. If the time is exceeded, then an error is reported to the host.
The value 0 specifies that no monitoring is performed.

Table 48: Timing Parameters for the Operating Mode 'Server Mode'
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Configuration Example

Send Only Maode | Receive Only Mode| Client Mode || Server Mode

Receive Data Stream Configuration

|Stalt j|HBH j|02
Data ¥ || Canstant Length(bytes)] ;|1D
Check _v||CRCIE LlDHBDDE
Erd || Hex v |foz
] _| Receive Buffer
— _| Size:
=] || 512 |bytes
P\e_sponse 1000 |rris._ _
Timeout: Signal Configuration Enabled
.I_I_I_I_I_I_I_l_l_l_l t
Send Data Strea
er Delay Time: “0]ms . L. .
Signal Configuration Enabled I~ Redeive Watthdod Tirde: | o] s il
Send Data Stream Configuration
|Start ﬂ|Hex ﬂ|02
Data _ || Constant Length[bytes] L|1D
Check _~||cRC1E _~||0x8008
End > ||Hex L'DS

Send Buffer
Size:

=l =l 512 |bytes

Table 49: Telegram Structure Parameters for the Operating Mode 'Server Mode'
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5.4.5 netSCRIPT Settings

Parameter Meaning

Value Range/Value

Interface type Type of the serial interface, which should be used

RS232 (Default),
RS485,
RS422

RTS Control Specifies, if RTS control is activated or deactivated.

When using the interface type RS-485, then "RTS Control on" has to
be used.

RTS Control Off (Default),
RTS Control On

Baud rate Specifies the baud rate.

300 Bit/s

600 Bit/s

1200 Bit/s

2400 Bit/s

4800 Bit/s

9600 Bit/s (Default)
19200 Bit/s

38400 Bit/s

57600 Bit/s
115200 Bit/s

Data bits Specifies the number of data bits, 7 or 8

7,
8 (Default)

Stop bits Specifies the number of stop bits, 1 or 2

1 (Default)
2

Parity Specifies the parity bit of the serial data communication.
None means that no parity bit is used.

None (Default),
Even,
Odd

Table 50: netSCRIPT Settings

Settings for the Remote netSCRIPT Device

_} Note: The settings in the used remote netSCRIPT device must comply
with the settings in the netTAP or netBRICK device to establish a
communication. Important parameters are: Interface type, baud rate, data

bits, parity check and respectively RTS control.
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5.5 Signal Configuration

In the Signal Configuration dialog you can define the data structure of the
input or output data of your device transmitted at the bus. The input and
output data coming from the bus and shown in the module configuration are
not very meaningful for the further use. You can not read from it where a
signal is generated, and how it is used. However, in the signal configuration
you can specify the structure or the data types of the input and output data
in more detail. Therefore you need to structure the input and output data as
modules and signals and enter appropriate module and signal names for
each use case as well as to configure the data types for the signals. The
generated signal configuration then allows an easy identification of the
transmitted input and output data.

The default names for the modules and signals assigned by the
configuration software, as ,Bytes In’ and ,Bytes Out’ or ,Input_001’,
JInput_002’, ,Output 001', ,Output 002', are designed to distinguish
between the input and output modules or the input and output signals.
These names you can replace by terms such as "reference"” or "status”, etc.
Furthermore, you can specify the data type of a signal more accurately, and
whether it is a signed or unsigned value.

Example for the Signal Configuration: For example you can specify that
4 bytes of input data together match with 1 input signal of the data type
,UNSIGNED32".

4 Byte (input) = 1 ,UNSIGNED32’ (input)
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55.1 Dialog Pane Signal Configuration
[ Disable advanced editing
| | Type | Signal Mame | Data Tope | Length | 10 Type |
EE Bytes In <1> 4 Bytes In
4 InBptes BYTE 4 |npLt
= 4 Bytes Out <2> 4 Bytes Out
4 OutBytes BYTE 4 Output
Add module | Add signal | Remove | Default
Figure 28: Configuration > Signal Configuration — Example
Parameter Meaning Range of Value/

Value

Disable advanced
Editing

Check, to disable Add Module, Add Signal and Remove.
Uncheck, to enable Add Module, Add Signal and Remove.

checked,
unchecked,
Default: checked

The arrow symbol shows the current line in the table. This line is the
reference for Add Module, Add Signal and Remove.

The tree shows the structure of the modules (1) and signals (2) or of
modules configured without signals (3).

The modified signal configuration is incorrect. For example, if a
duplicate name is used or if the length of the signal exceeds the
configured length for the data transferred on the bus.

Type

Not editable names of the modules with the input or output signals.
Consecutive module number (in angeled brackets).

Bytes In, Bytes Out

Signal Name

Editable name for the modules, the input or output signals,
as for example ,Bytes In’ and ,Bytes Out’ or ,Input_001’, ,Input_002’,
,Output_001’, ,Output_002’

Data Type Data type of the single input or output signals. BYTE,
Depending by the used device profile the user can select the data type | SIGNEDS,
from a list. UNSIGNEDS,

WORD etc.

10 Type Input signal or output signal input, output

Length Number of the Bytes.

Add Module Using Add Module you can insert additional modules into the signal
configuration.

Add Signal Using Add Signal you can insert additional signals to a module.

Remove Using Remove you remove signals from a signal configuration.

Default Using Default you can reset the signal configuration to the

configuration defined in the Configuration pane.

Table 51: Explanations to the Dialog Pane Signal Configuration
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5.5.2 Configuration Steps

1.
2

Select Configuration > Signal Configuration in the navigation area.

The dialog pane Signal Configuration is displayed.

[ Disable advanced editing

Type | Signal Mame | Data Tope | Length | 10 Type |
:4 Bytes In <13 4 Bytes In
4 InBptes BYTE 4 |npLt
4 Bytes Out <2> 4 Bytes Out
4 OutBytes BYTE 4 Output

Add mcn:lulel Add signal | Remove | Default

Figure 29: Configuration > Signal Configuration — Example

VW oy v N

v o v &

VYV O gV

4

%

Enable Advanced Editing.

Uncheck Disable advanced editing.

Add Module, Add Signal and Remove is enabled.
Adjust Signal Names.

In the column Sighal Name adjust the names for the modules and the
signals.

Define Data Types.

In the column Data Type define the data types for the signals.

Add Module.

Click on the line of the module, above that you intend to insert a new
module.

Click Add Module.

A new line for a new module is inserted above the module selected.

Add Signal.
Click on the line of the module, to which you intend to add a new signal.
Click Add Signal.

At the lower end of the signal list of that module a new line for a new
signal is inserted.

The signals of the type ,Input’ are sequentially assigned to the input
data.

The signals of the type ,Output’ are sequentially assigned to the output
data.

Note: As a maximum you can insert as many signals as input or output
data are configured.

If you insert more input signals, than input data are configured or if you
insert more output signals, than output data are configured or if both is true,
the following warnings are displayed:
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e Input Length too large

If you insert an input signal length greater than the configured input data
length the ,Warning — Inputs length has exceeded the length entered in
protocol configuration.” is displayed.

Warning

@ Inputs length has exceeded the length entered in protocol configuration,

Figure 30: Warning — Input Length too large (Example)

If you afterwards click to Apply or OK, the ,Warning - Inputs length
exceeds the length entered in protocol configuration. Do you wish to save
the signal configuration anyway?" is displayed.

Warning

2 Inputs length exceeds the length enkered in protocol configuration.
M—*\r’" Do wau wish ko save the signal configuration anyway?

Figure 31: Warning — Input Length too large — saving anyway? (Example)

e OQutput Length too large

If you insert an output signal length greater than the configured output data
length the ,Warning — Outputs length has exceeded the length entered in
protocol configuration.“ is displayed.

If you afterwards click to Apply or OK,the ,Warning - Outputs length
exceeds the length entered in protocol configuration. Do you wish to save
the signal configuration anyway?" is displayed.

e Input Length and Output Length too large

If you insert an input signal length greater than the configured input data
length the ,Warning — Inputs length has exceeded the length entered in
protocol configuration.“ is displayed.

If you in addition insert an output signal length greater than the configured
output data length the ,Warning — Outputs length has exceeded the length
entered in protocol configuration.” is displayed.

If you afterwards click to Apply or OK, the ,Warning — Inputs and Outputs
length exceeds the length entered in protocol configuration. Do you wish to
save the signal configuration anyway?" is displayed.

7. If the configured signal length has been exceeded, remove signals from
the configuration.

Click to the line of the signal to be removed.
Click Remove.

The marked signal is removed from the configuration.

© WV Vv

Save Configuration
» Save your configuration using Apply or OK.
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55.3 Default

Important! First save your signal configuration before resetting the signal
configuration to the default settings made in the Configuration pane.
Using Default all manually inserted modules, signals and names get lost.

If you click Default, the following Warning is displayed:

Warning X

"{/' Current signal configuration will be losk, Proceed?
St

o |

Figure 32: Warning — Current signal configuration will be lost. Proceed?

First click No.

Save your singla configuration using Apply or OK.
Or save the entire project.

Click Default another time.

Click Yes.

The signal configuration is reset to the configuration made in the
Configuation pane.

d V V V V V
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5.6 Command Table

Overview
Section Subsection Page
Command Table Command Table Modbus RTU 110
Command Table Open Modbus/TCP 116

Table 52: Command Table for Gateways

56.1 Command Table Modbus RTU

5.6.1.1 For what the Command Table does serve?

For the Modbus RTU Master the Command Table is a list with commands
for the reading or writing of data.

The Command Table is only relevant, if a device works as Master on the
Modbus RTU.

From every command line the Modbus RTU Master produces a telegram
for reading or for the writing of data to or from a Modbus RTU Slave device.
For every command are indicated:

e the Modbus RTU Slave device address (Device Address),

the Function code,
¢ the data address in the Modbus RTU Slave device (Address),

e the number of data (Number of Registers/Colls),

e and the data address in the Modbus RTU Master device (Memory
Address (internal)).

For writing telegrams (FC 5, 6, 15 and 16) in the column
e Trigger

you can decide, whether the writing telegrams are executed every time
(Cyclic) or only at data modification (Change data).

Furthermore

e aCycle Time
can be set for every command.
The Command Table is processed from the first to the last entry (from

above to below). After the execution of the last command the execution of
the first command is started again.

For reading commands the Modbus RTU Master reads out data from the
Modbus RTU Slave and saves them into its data memory.

For writing commands the Modbus RTU Master reads out data from its data
memory and writes them into the Modbus RTU Slave.

The number of commands which can be defined depends from the
firmware and from the Dual-Port Memory layout.
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5.6.1.2 Opening Command Table

Delay: |0 4:

Command T able

To view the Table Command, proceed as follows:

For Gateway devices:

1. Inthe netGateway DTM select Configuration > Settings.

In the Settings pane under Protocol Combination >

At Primary network (Port X2) select the primary network protocol.

v v N

At Secondary network (Port X3) select the secondary network
protocol Modbus RTU.

Select OK.
In the netDevice pane put a right click on the DTM icon.

In the context menu select Configuration > Modbus RTU.

ok w v

In the Configuration pane (Configuration Modbus RTU), under
Protocol Mode set the entry to "Master".

» Answer to the query “This and following changes will force recreation of
signal configuration! Do you want to proceed?” with Yes.

6. In the navigation area select Configuration > Command Table.
2 The pane Command Table is displayed.

B

Device Addiess | Unit Indentifier | Function Code | Addiess | Mumber of Register/Coils_|Memary Address(internal)] Trigger | Cycle Time [ms]
0 Read Holding Reqisters(FC3) 10 12 0 Cyclic i
0 Preszet Multiple Reqgister[FC1E) a0 2 0 Changed | 1]

| Add | ‘ Remaove

Figure 33: Pane Command Table

Each command contains the following parameters:

Parameter

Description

Device Address

Modbus RTU Slave device address

Unit Identifier

(not relevant here)

Function Code

Function code

Address

data address in the Modbus RTU Slave device

Number of Registers/Coils

Number of data

Memory Address (internal)

Data address in the Modbus RTU Master device
(= Byte address in the process image of the Modbus RTU Master device)

Trigger

Trigger for writing commands

Cycle Time

Cycle time

Table 53: Parameter of the Command Table

For a detailed description of the parameters refer to section Parameter of
the Command Table beginning from page 112.
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56.1.3 Parameter of the Command Table

Parameter Meaning

Range of Value/Value

Device Address Specifies the Modbus RTU Slave device address, from which the

For Modbus RTU: 1 ...

Modbus RTU Slave device. The register address is counted for
every function code beginning with 0.

The following table shows the assignment of the Address to the
data address in the Modbus RTU Slave by Function code:

EJ Data Address Modbus RTU Slave
£ 2 FC1 FC2 [Fca [FC3
g S FC5 FC6
o< FC 15 FC 16
0 1 10001 | 30001 | 40001
1 2 10002 | 30002 | 40002
2 3 10003 | 30003 | 40003
3 4 10004 | 30004 | 40004
4 5 10005 | 30005 | 40005

To know, which data address with which data of the Modbus
RTU Slave devices is provided for reading or for writing,
refer to the device description of the Modbus RTU Slave
device manufacturer.

Modbus RTU master device reads out the data or into which it 247
writes the data. Default: 1
Unit Identifier (not relevant here) Default: 0
Function Code Specifies the function code for read and write requests [3]: 1/2/3/4/5/6/15/16
Read Coils(FC1) Default: ,Read Coils
Read Inputs(FC2) (FC1)*
Read Holding Registers(FC3)
Read Input Registers(FC4)
Force Single Coil(FC5)
Preset Single Register(FC6)
Force Multiple Coils(FC15)
Preset Multiple Registers(FC16)
Address Indicates the data address in the Modbus RTU Slave device. 0...65.535
The parameter Address contains the register address in the Default: 0

Number of Indicates the number of reading or writing data as registers or coils.
Registers/Cails | the maximum value depends from the function code.

1 ... max. value, Default: 1
max. value for

FC1 = 2000 (Coils),

FC2 = 2000 (Coils),

FC3 = 125 (Registers),

FC4 = 125 (Registers),

FC5 =1 (Caoils),

FC6 = 1 (Registers),

FC15 = 1968 (Coils),

FC16 = 123 (Registers)

Memory Byte address in the process image of the Modbus RTU Master
Address device for input or output data of the Master
(internal)

The configuration software calculates the byte address in the
process image of the Master for the input or for the output data
automatically. Because of this definition, for function codes for
reading (FC 1, 2, 3 and 4) the data are assigned consecutively in
the process image for input data and for function codes for writing
(FC 5, 6, 15 and 16) the data are assigned consecutively in the
process image for output data.

0...5759
Default: 0
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Parameter

Meaning

Range of Value/Value

Trigger

Defines for all function codes for writing (FC 5, 6, 15 and 16); if the
command is to be executed cyclically (Cyclic) or only if the data
have changed (Change Data).

For function codes for reading (FC 1, 2, 3 und 4) this parameter is
not used.

0 = Cyclic
1 = Changed Data
Default: ,Cyclic”

Cycle Time

The cycle time defines, after how many milliseconds a writing or a
reading command shall be reexecuted.

The default value ,0 ms" means, that the command is executed as
fast as possible. Otherwise the execution can be defined in steps of
10 ms.

With the cycle time the temporal execution of the command can be
influenced.

If since the last execution of the command the set cycle time or
more time has been passed, the command is reexecuted.

If since the last execution of the command less time has been
passed then the cycle time, the command is skipped.

If e. g. from a Modbus RTU Slave data are required only every 10
seconds, as these one change only slowly, then for the cycle time
enter 10.000 ms.

0, 10, 20, 30, ... 60.000
ms

Default: 0 ms

Delay

Between the single commands a delay time can be parameterized.
This sometimes is necessary to avoid a too high load of the
connected Slave devices by a continuous communication.

0: The commands are processed without delay.
1 ... 60.000 ms: Delay time in ms, the Modbus RTU Master waits,
before starting the next command.

0 ... 60.000 ms
Default: O

Table 54: Parameter of the Command Table

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices

DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Configuration 114/266

5.6.1.4 Adding/removing Command

To add or to remove data sets for commands to the Command Table,
proceed as follows:

Add command:

» In the table Command Table put the cursor in the line below which a
new data set for a command shall be added.

> Click Add.

2 Under the clicked line a new command is added.

Remove command:

» In the table Command Table put the cursor in the line with the data set
to be deleted.

» Click Remove.

> The command of the clicked line is not shown any more.

5.6.1.5 Setting Parameters

Important: When entering the parameters, make sure that these address
valid data registers. (Refer to the device description of the Modbus RTU
Slave device manufacturer.)

To set the single parameters in the Command Table, proceed as follows:

1. Device Address, Function Code, Address, Number of
Registers/Coils:

The fields for these parameters are editable.

» Enter the values for these parameters to the corresponding table cells.

2. Trigger:

In Function Code field select an entry for a writing command (FC 5, 6,
15 or 16).

» Inthe column Trigger select the entry ,,Cyclic* or ,Change Data"“.

3. Cycle Time:

Put the cursor to the table cell and set the cycle time using the spin

box = in steps of 10 ms.
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5.6.1.6 Examples Modbus RTU Reading or Writing Command
Device Address | Unit Indentifier | Function Code | Addiess | Mumber of Register/Cails | Memory Addressfintemall Trigger | Cycle Time [ms]|
0 Read Holding Registers(FC3) 10 12 0 Cyclic 0
M 9 0 Preset Multiple Register[FC16) 30 2 0 Changed | a

Figure 34: Examples - Reading Command with FC 3, Writing Command with FC16

Example Reading Command with FC 3: From the Modbus RTU Slave
device with the Modbus address 8 from data address 40011 onwards 12
registers are read by function code 3. The data are assigned to the memory
address(internal) O.

Example Writing Command with FC 16: To the Modbus RTU Slave with the
Modbus address 8 from data address 40031 onwards 12 registers are
written by function code 16. The data are read from the process image of
the Master from the memory address(internal) O onwards. The writing
process is only performed, if the data in the process image of the Master on
the memory addresses(internal) 0 to 3 have changed, as the parameter
trigger is set to 'changed'.

Modbus RTU Master Modbus RTU Slave
8
Input Data
0
1
2
3
4
5 (ﬁ\
0 = 40001
29 FC3 1=40002
123 9 = 40010
%g 10 = 40011
11 = 40012
.\ 12 = 40013
21 =.£‘1;3022
22 = 40023
23 = 40024
29 =.d.l.0030
| 30 =40031
Qutput Data //FCLG///’ —( 31 = 40032
g / 32 = 40033
; — 33 = 40034
3
4
5

Figure 35: Examples - Reading Command with FC 3, Writing Command with FC16
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5.6.2 Command Table Open Modbus/TCP

5.6.2.1 For what the Command Table does serve?

For the Open Modbus/TCP Client the Command Table is a list with
commands for the reading or writing of data.

The Command Table is only relevant, if a device works as Client on the
Open Modbus/TCP.

From every command line the Open Modbus/TCP Client produces a
telegram for reading or for the writing of data to or from an Open
Modbus/TCP Server device. For every command are indicated:

¢ the Open Modbus/TCP Server device address (Device Address),

the Unit identifier (to identify a remote Server via gateway),
e the Function code,
¢ the data address in the Open Modbus/TCP Server device (Address),

e the number of data (Number of Registers/Colls),

e and the data address in the Open Modbus/TCP Client device (Memory
Address (internal)).

For writing telegrams (FC 5, 6, 15 and 16) in the column
e Trigger

you can decide, whether the writing telegrams are executed every time
(Cyclic) or only at data modification (Change data).

Furthermore

e aCycle Time
can be set for every command.

The Command Table is processed from the first to the last entry (from
above to below). After the execution of the last command the execution of
the first command is started again.

For reading commands the Open Modbus/TCP Client reads out data from
the Open Modbus/TCP Server and saves them into its data memory.

For writing commands the Open Modbus/TCP Client reads out data from its
data memory and writes them into the Open Modbus/TCP Server.

The number of commands which can be defined depends from the
firmware and from the Dual-Port Memory layout.

For Open Modbus one connection per IP address is established. In
maximum 16 Client connections can be supported. In this case the
parameter Open Server Sockets must be set from 4 (Default) to O.
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5.6.2.2 Opening Command Table
To view the Table Command, proceed as follows:
For Gateway devices:
1. Inthe netGateway DTM select Configuration > Settings.
2. Inthe Settings pane under Protocol Combination >
» At Primary network (Port X2) select the primary network protocol.
» At Secondary network (Port X3) select the secondary network
protocol Modbus/TCP.
» Select OK.
3. Inthe netDevice pane put a right click on the DTM icon.
4. In the context menu select Configuration > Open Modbus/TCP.
5. In the Configuration pane (Configuration Open Modbus/TCP), under
Protocol Mode set the entry to "Client".
» Answer to the query “This and following changes will force recreation of
signal configuration! Do you want to proceed?” with Yes.
6. In the navigation area select Configuration > Command Table.
2 The pane Command Table is displayed.
For devices without Gateway function:
1. In the Configuration pane (Configuration Open Modbus/TCP), under
Protocol Mode set the entry to "Client".
» Answer to the query “This and following changes will force recreation of
signal configuration! Do you want to proceed?” with Yes.
2. Inthe navigation area select Configuration > Command Table.
2 The pane Command Table is displayed.
Delay: [0
Command T able
Device Addiess | Unit Indentifier | Function Code | Addiess | Mumber of Register/Coils | DualPort Memary Addiess | Trigger | Cycle Time [ms]|
GRS oo i Fegiom 18 3 chaned 0 0
Add Remaove
Figure 36: Pane Command Table
Each command contains the following parameters:
Parameter Description

Device Address Open Modbus/TCP Server IP address

Unit Identifier to identify a remote Server via gateway

Function Code Function code

Address data address in the Open Modbus/TCP Server device

Number of Registers/Coils

Number of data

Memory Address (internal)

Data address in the Open Modbus/TCP Client device
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Parameter Description
(= Byte address in the process image of the Open Modbus/TCP Client device)
Trigger Trigger for writing commands
Cycle Time Cycle time
Table 55: Parameter of the Command Table
For a detailed description of the parameters refer to section Parameter of
the Command Table beginning from page 118.
5.6.2.3 Parameter of the Command Table
Parameter Meaning Range of Value/Value

Device Address

Specifies the Open Modbus/TCP Server device address, from
which the Open Modbus/TCP Client device reads out the data or
into which it writes the data.

For Open Modbus/TCP:
000.000.000.000-
255.255.255.255,
Default: 000.000.000.000

Unit Identifier To identify a remote Server connected on a serial line or on other 0...247,
buses. Default: 0
The Unit Identifier is initialized by the Client. Do not change for
response!
Function Code Indicates the function code for reading or writing commands [3]: 1/2/3/4/5/6/15/16
Read Coils(FC1) Default: ,Read Coils
Read Inputs(FC2) (FC1)*
Read Holding Registers(FC3)
Read Input Registers(FC4)
Force Single Coil(FC5)
Preset Single Register(FC6)
Force Multiple Coils(FC15)
Preset Multiple Registers(FC16)
Address Indicates the data address in the Open Modbus/TCP Server device. | 0 ... 65.535
The parameter Address contains the register address in the Open Default: 0

Modbus/TCP Server device. The register address is counted for
every function code beginning with 0.

The following table shows the assignment of the Address to the
data address in the Open Modbus/TCP Server by Function code:

Data Address Open Modbus/TCP
S Server
o w
= FC1 FC2 |FC4 FC3
S5 FC5 FC6
o< FC 15 FC 16
0 1 10001 | 30001 (40001
1 2 10002 | 30002 | 40002
2 3 10003 | 30003 | 40003
3 4 10004 | 30004 |[40004
4 5 10005 [ 30005 | 40005

To know, which data address with which data of the Open
Modbus/TCP Server devices is provided for reading or for
writing, refer to the device description of the Open
Modbus/TCP Server device manufacturer.
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Parameter

Meaning

Range of Value/Value

Number of
Registers/Coils

Indicates the number of reading or writing data as registers or coils.
The maximum value depends from the function code.

1 ... max. value, Default: 1

max. value for

FC1 = 2000 (Caoils),
FC2 = 2000 (Caoils),
FC3 = 125 (Registers),
FC4 = 125 (Registers),
FC5 =1 (Cails),

FC6 = 1 (Registers),
FC15 = 1968 (Cails),
FC16 = 123 (Registers)

Memory
Address
(internal)

Byte address in the process image of the Open Modbus/TCP Client
device for input or output data of the Client

The configuration software calculates the byte address in the
process image of the Client for the input or for the output data
automatically. Because of this definition, for function codes for
reading (FC 1, 2, 3 and 4) the data are assigned consecutively in
the process image for input data and for function codes for writing
(FC 5, 6, 15 and 16) the data are assigned consecutively in the
process image for output data.

0...5759
Default: O

Trigger

Defines for all function codes for writing (FC 5, 6, 15 and 16); if the
command is to be executed cyclically (Cyclic) or only if the data
have changed (Change Data).

For function codes for reading (FC 1, 2, 3 und 4) this parameter is
not used.

0 = Cyclic
1 = Changed Data
Default: ,Cyclic”

Cycle Time

The cycle time defines, after how many milliseconds a writing or a
reading command shall be reexecuted.

The default value ,0 ms" means, that the command is executed as
fast as possible. Otherwise the execution can be defined in steps of
10 ms.

With the cycle time the temporal execution of the command can be
influenced.

If since the last execution of the command the set cycle time or
more time has been passed, the command is reexecuted.

If since the last execution of the command less time has been
passed then the cycle time, the command is skipped.

If e. g. from a Open Modbus/TCP Server data are required only
every 10 seconds, as these one change only slowly, then for the
cycle time enter 10.000 ms.

0, 10, 20, 30, ... 60.000
ms

Default: 0 ms

Delay

Between the single commands a delay time can be parameterized.
This sometimes is necessary to avoid a too high load of the
connected Server devices by a continuous communication.

0: The commands are processed without delay.
1 ... 60.000 ms: Delay time in ms, the Open Modbus/TCP Client
waits, before starting the next command.

0 ... 60.000 ms
Default: O

Table 56: Parameter of the Command Table
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5.6.24 Adding/removing Command
To add or to remove data sets for commands to the Command Table,
proceed as follows:
Add command:

» In the table Command Table put the cursor in the line below which a
new data set for a command shall be added.

> Click Add.

2 Under the clicked line a new command is added.
Remove command:

» In the table Command Table put the cursor in the line with the data set
to be deleted.

» Click Remove.

> The command of the clicked line is not shown any more.

5.6.2.5 Setting Parameters

Important: When entering the parameters, make sure that these address
valid data registers. (Refer to the device description of the Open
Modbus/TCP Server device manufacturer.)

To set the single parameters in the Command Table, proceed as follows:

1. Device Address, Function Code, Address, Number of
Registers/Coils:

The fields for these parameters are editable.

» Enter the values for these parameters to the corresponding table cells.

2. Trigger:

In Function Code field select an entry for a writing command (FC 5, 6,
15 or 16).

» Inthe column Trigger select the entry ,,Cyclic* or ,Change Data"“.

3. Cycle Time:

Put the cursor to the table cell and set the cycle time using the spin

box = in steps of 10 ms.
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5.6.2.6 Examples Open Modbus/TCP Reading or Writing Command

Device Addiess | Unit Indentifier | Function Code | &ddess [ MNumber of Register/Coils | DualPart Memary Address [ Trigger | Cycle Time [ms]]
n 1392168.10.101 0 Read Holding Registers[FC3) 10 12 0 Cyclically 0
L4 19216810101 0 Preset Multiple RegisterFC16] an 2 1 Changed D 0

Figure 37: Examples - Reading Command with FC 3, Writing Command with FC16

Example Reading Command with FC 3: From the Open Modbus/TCP
Server device with the Modbus address 8 from data address 40011
onwards 12 registers are read by function code 3. The data are assigned to
the memory address (internal) O.

Example Writing Command with FC 16: To the Open Modbus/TCP Server
with the Modbus address 8 from data address 40031 onwards 12 registers
are written by function code 16. The data are read from the process image
of the Client from the memory address (internal) 0 onwards. The writing
process is only performed, if the data in the process image of the Client on
the memory addresses (internal) 0 to 3 have changed, as the parameter
trigger is set to 'changed'.

Open Modbus/TCP
Open Modbus/TCP Server
Client 192.168.10.101

Input Data
0
1
2
3
4 (\
E 0= 40001
5 fes 1 = 40002
123 | 9= 40010
24
10 = 40011
B 11 = 40012
112 =40013
y
21 = 40022
22 = 40023
23 = 40024
— 29 = 40030
30 = 40031
Output Data ///ﬂg/// ::1,}\ 31 =40032
0 / 32 = 40033
; E— 33 = 40034
2
4
5

Figure 38: Examples - Reading Command with FC 3, Writing Command with FC16
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5.6.3 Modbus References

[1] MODBUS Application Protocol Specification V1.1, http://www.modbus.org/,
12/06/02

[2] MODBUS Messaging on TCP/IP Implementation Guide V1.0b, October 24, 2006

[3] MODBUS APPLICATION PROTOCOL SPECIFICATION V1.1a, June 4, 2004,
http://www.Modbus-IDA.org
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6 Online Functions

6.1 Connecting/Disconnecting Device

Note: Several netSLAVE DTM functions e. g. Diagnosis or the
configuration download in the FDT Framework require an online
connection from the netSLAVE DTM to the Slave device.

Connecting Device

The following steps are needed to establish a connection from the
netSLAVE DTM to a Slave device:

Under Settings in the Driver pane:

1. Verify that the default driver is checked and respectively check another
or multiple drivers.

2. Configure the driver if necessary.
Under Settings in the Device Assignment pane:
3. Scan for the devices (with or without firmware).

4. Select the device (with or without firmware) and apply the selection.

\  Before you download the firmware adhere to the necessary safety
) precautions to prevent personnel injury and property damage that may

occur in consequence of a communication stop. For more refer to section
Safety Messages on Firmware or Configuration Download on page 29.

Under Settings in the Firmware Download pane if not yet a firmware was
loaded to the device:

5. Select and download the firmware.

Under Settings in the Device Assignment pane if not yet a firmware was
loaded to the device:

6. Scan for the device (with firmware) once more.

7. Select the device (with firmware) once more.

N An overview of the descriptions for these steps you find in the section

Overview Settings on page 31.

8. In the DTM interface dialog select the OK button, to apply the selection
and to close the DTM interface dialog.

9. Put aright-click on the Slave device icon.
10. Select the Connect command from the context menu.

> The Slave device now is connected to the netSLAVE DTM via an online
connection. In the network view the device description at the device
icon of the Slave is displayed with a green colored background.
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Disconnecting Device

To disconnect an online connection from the Slave device to a netSLAVE
DTM take the following steps:

1. In the DTM interface dialog select the OK button, to close the DTM
interface dialog.

Right-click on the Slave device icon.
Select the Disconnect command from the context menu.

w

2 In the network view the device description at the device icon of the
Slave device is not any more displayed with a green colored
background. Now the Slave device is disconnected from the DTM.
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6.2 Download Configuration

The device configuration is created offline in the DTM (application
program). A download to the device is required, to transfer the configuration
with the parameter data to the device.

Note: To download configuration parameter data to the Slave device an
online connection from the netSLAVE Slave DTM to the Slave device is
required.

Further information can be found in the Connecting/Disconnecting Device
section on page 123.

Safety Precautions

Adhere to the necessary safety precautions to prevent personnel injury and
property damage that may occur in consequence of a communication stop
or in consequence of a mismatching system configuration.

| & WARNING |

Personnel Injury in Consequence of a Communication Stop
= Stop the application program before starting a configuration download.

= Make sure that your equipment operates under conditions that prevent
personal injury. All network devices should be placed in a fail-safe mode
before downloading a configuration.

= Unexpected equipment operation may cause personal injury.

Personnel Injury as a result of mismatching System Configuration

= Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause personal injury.

NOTICE

Damage of Equipment and Loss of Device Parameters in
Consequence of a Communication Stop

= Stop the application program before starting a configuration download.

= Make sure that your equipment operates under conditions that prevent
property damage. All network devices should be placed in a fail-safe
mode before downloading a configuration.

= Unexpected equipment operation may cause property damage.

= Before you initiate a configuration download make sure that your current
project configuration data are saved non-volatile in order to prevent loss
of configuration data.

Damage of Equipment as a result of mismatching System
Configuration

= Mismatching system configuration loaded into the device could result in
faulty data mapping in the application program and thus unexpected
equipment operation may cause damage of equipment.
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Download Steps

To transfer the configuration with the corresponding parameter data to the
Slave device you download the data using the frame application of the
configuration software.

For netDevice the download is made via Device > Download or use the
context menu with Download.

1. Select Download in the context menu of the device.

2 If the download is started as long as the Slave devices are connected to
the Master device, the following message is displayed: ‘If you attempt to
download during bus operation, communication between Master and
Slaves is stopped. Do you really want to download?’

.
netDevice CIFX_DP_DPMICIFX DP/DPM] <1>(£1) - Download . -

\ If you atternpt to download during bus operation, communication
¥ between master and slaves is stopped.
Do you really want to download?

-

Yes Mo

Figure 39: netDevice Message: Download

Important: If the communication between the Master and the Slave
devices is stopped, the data exchange between the Master device and the
Slave devices is stopped.

2. Click to Yes if you intend to download the configuration.

2 Then the current configuration in the application program is down
loaded to the device.

3. Otherwise click to No.
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7 Diagnosis

7.1 Overview Diagnosis

The dialog Diagnosis serves to diagnose the device behavior and
communication errors. For diagnosis the device must reside in online state.

Diagnosis Panes

The table below gives an overview for the individual Diagnosis dialog
panes descriptions for the respective communication system.

netSLAVe DTM Section Page
Navigation area = Firmware Diagnosis 130
= General Diagnosis 128

=y General Diagnosis
Firmware Diagnosis
.1 Extended Diagnosis

Table 57: Descriptions of the Diagnosis Panes

Online Connection to the Device

Note: Accessing the Diagnosis panes of the netSLAVE DTM requires an
online connection from the netSLAVE DTM to the Slave device . For
further information, refer to section Connecting/Disconnecting Device on
page 123.

Extended Diagnosis

The Extended Diagnosis helps to find communication and configuration
errors, when default diagnosis fails. For further information refer to section
Overview Extended Diagnosis on page 131.
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7.2 General Diagnhosis

Information regarding the Device State and other general diagnosis
parameters are displayed in the General Diagnosis dialog.

Device state Metwork, state
I.J Communication 9 Cperate
W run i) Idle
Ready 1_} Stop
i Erraor i) Offling
Configuration state
i) Configuration locked
'-J Mew configuration pending
iy Reset required
i Bus ON
Cormrunication errar:
Wakchdog kime:
Error counk:
Figure 40: General Diagnosis
LED Meaning ‘ Color | State
Device State
Communication Shows whether the Slave device executes the Q (green) In COMMUNICATION
network communication. state
Not in
@ (gray) COMMUNICATION state
Run Shows whether the Slave device has been (W (green) Configuration OK
configured correctly.
.‘J (gray) Configuration not OK
Ready Shows whether the Slave device has been started (vellow) | Device READY
correctly. The Slave device waits for a configuration.
.‘J (gray) Device not READY
Error Shows whether the Slave device records a device () (red) ERROR
status error. For further information about the error
characteristics and the number of counted errors '-.) (gray) No ERROR
refer to the extended diagnosis. y
Network State
Operate Shows whether the Slave device is in data (W (green) In OPERATION state

exchange. In a cyclic data exchange the input data

or the output data of the Slave are transmitted to the .‘J (gray) Not
Master. in OPERATION state
Idle Shows whether the Slave device is in idle state. (yellow) |In IDLE state

@ (gray)

Not in IDLE state
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LED Meaning Color State
Stop Shows whether the Slave device is in Stop state: ﬂ (red) In STOP state

There is no cyclic data exchange at the network.

The Slave device was stopped by the application .‘J (gray) Not in STOP state

program or it changed to the Stop state because of

a bus error.
Offline The Slave device is offline as long as it does not (vellow) | In OFFLINE state

have a valid configuration.

.“} (gray) Not in OFFLINE state

Configuration State
Configuration Shows whether the Slave device configuration is (yellow) Configuration LOCKED
locked locked, to avoid the configuration data are typed

over. .‘J ra Configuration not

@ay) | ocKkep
New Configura- | Shows whether a new Slave device configuration is (yellow) | New Configuration
tion pending available. pending
.‘J No new Configuration
ra
(gray) pending

Reset required Shows whether a firmware reset is required as a (yellow) RESET required

new Slave device configuration has been loaded

into the device. i (gray) No RESET required
Bus ON Shows whether the bus communication was started Q (green) Bus ON

or stopped. . e., whether the device is active on the

bus or no bus communication to the device is [ (gray) Bus OFF

possible and no response messages are sent.

Table 58: Indication General Diagnosis
Parameter Meaning

Communication Error

set to zero again.

Shows the name of the communication error. If the cause of error is resolved, the value will be

Watchdog time

Shows the watchdog time in ms.

Error Count

related or caused internally.

This field holds the total number of errors detected since power-up, respectively after reset.
The protocol stack counts all sorts of errors in this field no matter whether they were network

Table 59: Parameter General Diagnosis
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7.3 Firmware Diagnosis

In the dialog Firmware Diagnosis the current task information of the
firmware is displayed.

Under Firmware or Version the name of the firmware and version
(including the date) are indicated.

Firmware Diagnosis

Firmware: |Firmware Name |

Version: 2.1.0 (Build 39)

Date: 19.4.2013

Task information:
Task Mame of task Wersion | Pri | Description | State
0 RXx_IDLE 1.0 63 RX IDLE Task, Task Status ok, (0x00000000)
1 R.¥_TIMER. 1.0 1 rck Timer, Task Status ok, (0x00000000)
2 R¥_SYSTEM 1.16 ] Middleware System Task. Task Status ok, (0x00000000)
3 DPM_COMOD_SMEX 1.0 50 TLR-Router DPM. Task Status ok, (000000000}
4 DPM_COMO_RMEX 1.0 51 TLR-Router DPM. Task Status ok, (Dx00000000)
5 EPLCM_DPM 2.1 15 Ethernet PowerLink DPM Task. Task Status ok, (0x00000000)
] EPLCM_PCK 2.1 16 Ethernet Powerlink Packet Ta... Task Status ok. (0x00000000)
7 TCP_UDP 2.11 39 TCPUDP task (TCP/IP stack). Task Status ok. (0x00000000)
3 TLRTIMER. 1.0 57 TLR. Timer Task, Task Status ok, (Dx00000000)
] MARSHALLER. 2.0 54 Marshaller: Main Task. Task Status ok, (0x00000000)
10 EPLCM_SDO 2.1 17 Ethernet PowerLink SDO Task. Task Status ok, (0x00000000)
11 EPLCM_MMT 2.1 18 Ethernet PowerLink NMT Task, Task Status ok, (000000000}
12 PACKET _ROUTER 2.0 49 Marshaller: Packet Router Task,  Task Status ok, (0x00000000)

Figure 41: Firmware Diagnosis, Example

Task Information:

The table Task Information is listing the task information of the single
firmware tasks.

Column
Task
Name of task

Meaning

Task number

Name of the task

Version Version number of the task
Prio Priority of the task
Description Description of the task
Status Current status of the task

Table 60: Description Table Task Information
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8 Extended Diagnosis

8.1 Overview Extended Diagnosis

The Extended Diagnosis of the netSLAVE DTM helps to find
communication and configuration errors. Therefore it contains a list of
diagnosis structures as online counter, states and parameters.

Mavigation area i
|:| Diagnosis -
s £ xtended Diagnosis

Figure 42: Navigation Area - Extended Diagnosis

DTM requires an online connection from the netSLAVE DTM to the Slave
device . For further information, refer to section Connecting/Disconnecting
Device on page 123.

Note: Accessing the Extended Diagnosis dialog panes of the netSLAVE

QOverview Dialog Panes “Extended Diagnosis”

For an overview of the descriptions of the dialogue windows under
Extended Diagnosis for every communication system refer to the following
subsections. All descriptions have exemplary character and may differ in
detail for the single devices.

Type of System Subsection/ Communication System Manual Page
Real-Time Ethernet Systems EtherCAT Slave* 132
EtherNet/IP Adapter* 137
Open Modbus/TCP 145
PROFINET IO Device* 150
POWERLINK Controlled Node 154
Sercos 155
VARAN Client (Slave) 156
Fieldbus Systems PROFIBUS DP Slave* 163
CANopen Slave* 170
DeviceNet-Slave* 184
CC-Link Slave 190
CompoNet Slave 209
Serial Protocols 3964R Slave* 213

Table 61: Overview Extended Diagnosis (*only Gateways)

For the descriptions of repeated used tasks refer to section Descriptions for Tasks with
similar Functions on page 220.

For information about the parameters in the dialogue windows Extended Diagnosis
refer also to the descriptions of the configuration parameters in section Real-Time
Ethernet Systems beginning from page 60 and in section beginning from page Fieldbus
Systems beginning from page 75, as well as to the corresponding User Manual of your
device, in the section Technical Data of the Communication Protocols. This manual is
located on the included DVD to your device.
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8.2
8.2.1 EtherCAT Slave
8.2.1.1 Overview EtherCAT Slave

Real-Time Ethernet Systems

Dialog Panes “Extended Diagnosis” EtherCAT Slave

The table below gives an overview for the Extended Diagnhosis dialog

panes descriptions:

IniBatch Status
IniBatch Status
=3 EcatsDO
Task Information
ECAT_SDO_RSC DIAG T
ECAT_SDO_RSC_TIMER_T
3 EcatCOE
Task Information
=3 EcatESM
Task Information
ECAT_ESM_RSC_DIAG. T
=3 EcatMBX
Task Information
ECAT_MBX_RSC_DIAG T
ECAT_MBX_RSC_TIMER_T
=3 EcatFOE
Task Information
ECAT_FOE_RSC_DIAG_T
ECAT_FOE_RSC_TIMER_T
=3 EcatDPM

Tazk Information

_: section Descriptions for Tasks with similar

Functions.

Navigation Area Folder Name in the [Dialog Pane Manual
EtherCAT-Slave* Navigation Area Page
e =| | EcatsDO EcatSDO\ECAT_SDO_RSC_DIAG_T 133
[ Diagnosis EcatSDO\ECAT_SDO_RSC_TIMER_T 133
@ | Extended Diagnosis EcatESM EcatESM\ECAT_ESM_RSC_DIAG_T 134

5] R¥_SYSTEM
. EcatMBX EcatMBX\ECAT_MBX_RSC_DIAG_T 134
=y Task Information

IniBatch Status EcatMBX\ECAT_MBX_RSC_TIMER_T 135
IniBatch Status EcatFOE EcatFOE\ECAT_FOE_RSC_DIAG_T 135
IniBatch Status EcatFOE\ECAT_FOE_RSC_TIMER_T 136

IniBatch Status .
For the description of further tasks refer to 220

* The displayed EtherCAT Slave exteded

diagnosis corresponds to the EtherCAT Slave

firmware version 2.5.x.x

Table 62: Descriptions of the Dialog Panes Extended Diagnosis EtherCAT Slave
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8.2.1.2 EcatSDO\ECAT_SDO_RSC_DIAG T

Task skates

Mame | Yalue

ulCompletedDownloadsserver
ulZompletedUploadsServer
ulCampletedDawnloadsClisnk
ulCompletedUploadsClisnt
ulabortedDownloadsServer
ulabortedUploadsServer
ulabortedDownloadsClient
ulabortedploadsClisnt
ulServer Timeouts
ulClientTimeouts

=

o oo oo oo o0

Figure 43: Extended Diagnosis EtherCAT Slave > EcatSDO > ECAT_SDO_RSC_DIAG_T

Name Description

[Service] Diagnosis counter of the ECAT_SDO_RSC_DIAG_T layer. Indicates the services
processed. (The services of the single packets are described in the EtherCAT Slave
Protocol APl manual [9].)

Table 63: Extended Diagnosis EtherCAT Slave > EcatSDO > ECAT_SDO_RSC _DIAG_T

8.2.1.3 EcatSDO\ECAT_SDO_RSC_TIMER_T

Task skates

Mame Yalue
ulTimeriZnk 544500
ulTirmeraran 100
ulSDOClient Timeouk 1000
ulsDoServerTimeouk 1000

Figure 44: Extended Diagnosis EtherCAT Slave > EcatSDO > ECAT_SDO_RSC_TIMER_T

Name Description

ulTimerCnt Timer Count

ultimerGran Granularity of the timer
ulSDOClientTimeout Clients

ulSDOServerTimeout Timeout value of the SDO Server

Table 64: Extended Diagnosis EtherCAT Slave > EcatSDO > ECAT_SDO_RSC_TIMER_T
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8.2.14 EcatESM\ECAT _ESM_RSC DIAG_ T
Task skates
Marme | Yalue
uIReadyEits 4294967295
ulSetInitBits 32789
ulCarrectstakeChanges 1

ulIrvalidStateChanges 1]
ulErrorstateChanges 1]
ulInvalidstateRequested n
ulParameterFailures 1]
ulTimeoukSkakeChanges 1]
ulalskatus IMIT

Figure 45: Extended Diagnosis EtherCAT Slave > EcatESM > ECAT_ESM_RSC_DIAG_T

Name Description

ulReadyBits Number of Ready Bits

ulSetlnitBits Number of Setlnit Bits

[Service] Diagnosis counter of the ECAT_ESM_RSC_DIAG_T layer. Indicates the services

processed. (The services of the single packets are described in the EtherCAT Slave
Protocol APl manual [9].)

ulAlStatus AL status, for more detailed information, see the EtherCAT Specification, Part 5 and 6
Table 65: Extended Diagnosis EtherCAT Slave > EcatESM > ECAT_ESM_RSC_DIAG_T

8.2.1.5 EcatMBX\ECAT _MBX_RSC_DIAG T
Task states

Mare Yalue

FEotPacketht aiting 1]

Factive n

ulMessageskeceived 0

ulMessagessent 0

ulMsgTooLong n

Figure 46: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_MBX_RSC_DIAG_T

Name Description
[Service] Diagnosis counter of the ECAT_MBX_RSC_DIAG_T layer. Indicates the services

processed. (The services of the single packets are described in the EtherCAT Slave
Protocol APl manual [9].)

Table 66: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_MBX_RSC_DIAG_T
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8.2.1.6 EcatMBX\ECAT _MBX_RSC_TIMER_T
Task skates
Mame YWalue
uITirmetGEran 50
ulTimerCnk 0
ulLowTrafficTimeout 100

Figure 47: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_MBX_RSC_TIMER_T

Name Description

ulTimerCnt Timer Count

ulTimerGran Granularity of the timer
ulLowTrafficTimeout Timeout value for low network data traffic

Table 67: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_MBX_RSC_TIMER_T

8.2.1.7 EcatFOE\ECAT FOE_RSC_DIAG T

ECAT_FOE_RSC_DIAG_T

Task states

MName | Value

completed FoE transfers 0

aborted FoE transfers ]

Started FoE transfers ]

Active FoE transfers ]

Timeouts 0

Figure 48: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_FOE_RSC_DIAG_T

Name Description
[Service] Diagnosis counter of the ECAT_FOE_RSC_DIAG_T layer. Indicates the services

processed. (The services of the single packets are described in the EtherCAT Slave
Protocol APl manual [9].)

Table 68: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_FOE_RSC_DIAG_T
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8.2.1.8 EcatFOE\ECAT FOE_RSC_TIMER_T

ECAT_FOE_RSC_TIMER_T

Task states

Mame | Value

ulTimerCnt ]

ulTimerGran 100

ulProtocolTimeout 1000

Figure 49: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_FOE_RSC_TIMER_T

Name Description
ulTimerCnt Timer Count
ulTimerGran Granularity of the timer
ulLowTrafficTimeout Timeout value for low network data traffic

Table 69: Extended Diagnosis EtherCAT Slave > EcatMBX > ECAT_FOE_RSC_TIMER_T
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8.2.2

8.2.2.1

EtherNet/IP Adapter

Overview EtherNet/IP Adapter

Dialog Panes “Extended Diagnosis” EtherNet/IP Adapter

The table below gives an overview for the Extended Diagnhosis dialog

panes descriptions:

Navigation Area Folder Name in the [Dialog Pane Manual
EtherNet/IP Adapter* Navigation Area Page
e EisEncap EisEncap/Encap Command Counter 138
-3 Diagnosis EisObject EisObject/Object Request Counter 139
by [ Edidc B2 i EisObject/Outgoing Connection 140

Firmware Diagnosis - - - -
23 Extended Diagnosis EisObject/Ingoing Connection 140
{3 RX_SYSTEM EisAp EisAp/Common Diagnosis 141
Task Information EisAp/General Stat 141
IniBatch Status
IniBatch Status EIP_DLR_TASK EIP_DLR/DLR Object Diagnosis 142
IniBatch Status EIS_DLR/DLR Object Counter 144
IniBatch Status
IniBatch Status
IniBatch Status For the description of further tasks refer to 220

9 TCP_UDP
Task Information
IP Information
IP Packet Counter
IP Code Diagnosis
TCP_UDP Information

TCP_UDP Code Diagnosis

3 FisCL1
Task Information

3 EisEncap
Task Information

Encap Command Counter

Code Diagnosis
{3 FisObject
Task Information

Object Request Counter

Outgoing Connection
Ingoing Connection
Code Diagnaosis

3 EisAp
Task Information
Commoen Diagnosis
General State
Code Diagnosis

{23 EIP_DLR_TASK
Task Information
DLR Object Diagnosis
DLR Object Counter
Code Diagnaosis

| | section Descriptions for Tasks with similar

Functions.

* The displayed EtherNet/IP Adapter exteded
diagnosis corresponds to the EtherNet/IP
Adapter firmware version 2.6.x.x.

Table 70: Descriptions of the Dialog Panes Extended Diagnosis EtherNet/IP Adapter
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8.2.2.2 EisEncap/Encap Command Counter
Task skates
Marne YWalue
MR 0
List Taargek ]
Lisk Identity 1]
Lisk Services 0
Lisk Interfaces 0
Reqister session ]
Unregister sessian ]
Send process daka 1]
Unknown Cornrnand 0
Good Reply 0
Error Reply 1]
Figure 50: Extended Diagnosis EtherNet/IP Adapter > EisEncap > Encap Command
Counter
Name Description
NOP Counter incoming encapsulation telegrams
List Target Counter incoming encapsulation telegrams
List Identity Counter incoming encapsulation telegrams

List Services

Counter incoming encapsulation telegrams

List Interfaces

Counter incoming encapsulation telegrams

Register Session

Counter incoming encapsulation telegrams

Unregister Session

Counter incoming encapsulation telegrams

Process data

Unit Date RR Data telegrams

Unknown Command

Counter incoming encapsulation telegrams

Good Reply

Counter incoming encapsulation telegrams

Error Reply

Counter incoming encapsulation telegrams

Table 71: Extended Diagnosis EtherNet/IP Adapter > EisEncap > Encap Command Counter
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8.2.2.3 EisObject/Object Request Counter
Task skates
Marne Value .

Identity Get Atkribuke Single
Identity Gek Attriboke Al

Identity Reset

Identity unknown command
Azzembly Get Attribuke Single
Aszembly Set Attribuke Single
Assembly unknown command
Conneckion Manager Get Atkribute Single
Conneckion Manager Forward Open
Conneckion Manager Forward Close
onneckion Manager unknown command
oo Get Attribute Single

CoCo Get Attribute Al

CoCo Set Attribuke Single

CoiZo Set Attribute All

oo Create

CoCo Delete

ZoCo Restare

oo Change Start

CoCo Audit Change

CoCo Zhange Complete

CoCo Kick Timer

=

oo ooocoocooooo oo oo oo oo o

v

Figure 51: Extended Diagnosis EtherNet/IP Adapter > EisObject > Object Request Counter

The Object Request Counter table indicates the respective number of
services sent to different objects.

Name Description

Identity Get Attribute Single Counter for the Get Attribute Single services to the identity object
Identity Get Attribute All Counter for the Get Attribute All services to the identity object
Identity Reset Counter for the Reset services to the identity object

Identity unknown Command Counter for the Unknown Command services to the identity object

Assembly Get Attribute Single | Counter for the Get Attribute Single services to the assembly object

[Object] [Service] Counter for the [Object] services to the [Service] object
Table 72: Extended Diagnosis EtherNet/IP Adapter > EisObject > Object Request Counter
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8.2.2.4 EisObject/Outgoing Connection
Task states
Mame Yalue
Issue Open ]
Issue Close 0
Open Canneckions C00000000
Last errar instance ]
Last GRIC 00
Last ER.C 00

Figure 52: Extended Diagnosis EtherNet/IP Adapter > EisObject > Outgoing Connection

Name Description

Issue Open Counter for open issues
Issue Close Counter for closed issues
Open Connections Actual open connection
Last error instance Last error instance

Last GRC Last General Status Code
Last ERC Last Extended Status Code

Table 73: Extended Diagnosis EtherNet/IP Adapter > EisObject > Outgoing Connection

8.2.2.5 EisObject/Ingoing Connection

Ingoing Connection

Task states

MName | Value

Last Error Address 000000000

Last GRC Ox0

Last ERC Ox0

Current Connection 0]

Figure 53: Extended Diagnosis EtherNet/IP Adapter > EisObject > Ingoing Connection

Name Description
Last Errors Address IP Address
Last GRC Last General Status Code
Last ERC Last Extended Status Code
Actual Connection Actual open connection

Table 74: Extended Diagnosis EtherNet/IP Adapter > EisObject > Ingoing Connection
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8.2.2.6 EisAp/Common Diagnosis
Task skates

Mame Yalue
State Field 7
Bus state 4
Cornmunication error Crx00000000
Version 1
YW akchdog time 1000
Protocol class 5 1:2
Error counker ]

Figure 54: Extended Diagnosis EtherNet/IP Adapter > EisAp > Common Diagnostic

Name Description
Status field Communication change of state
Bus state Communication state
Communication Error Unique error number according to protocol stack
(not supported yet)
Version Version number of this diagnosis structure
Watchdog time Configured watchdog time
Protocol Class Protocol class:
MASTER, SLAVE, CLIENT, SERVER, GATEWAY
Error Counter Total number of detected error since power-up or reset

Table 75: Extended Diagnosis EtherNet/IP Adapter > EisAp > Common Diagnostic

8.2.2.7 EisAp/General Status
Task states
Marne Yalue
Error code 000000000

Figure 55: Extended Diagnosis EtherNet/IP Adapter > EisAp > General Status

Name Description

Error Code Code of the last occurred error

Table 76: Extended Diagnosis EtherNet/IP Adapter > EisAp > General Status
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8.2.2.8 EIP_DLR/DLR Object Diagnhosis
Task skates

Mame Yalue
Metwork Topology Linear
Metwork Status Mormal
Ring supervisor staktus Marmal ring node
Ring supervisar mode Deactivated
Ring supervisar precedence 0
Beacon inkerval 0 micro sec
Beacon kirmeouk 0 ricro sec
VLAN ID 0
Ring Faulks counk 1]
MacC of last ackive node park 1 00-00-00-00-00-00
IP of last active node port 1 0.0.0.0
MaC of last ackive node pork 2 00-00-00-00-00-00
IP of last active node port 2 0.0.0.0
Ring participants counk 0
MAC of active ring supervisor 0o-00-00-00-00-0a
IP of ackive ring supervisor 0.0.0.0
Precedence of ackive ring super.., 0
Capability Flags 000000022
MAC node 1 00-00-00-00-00-00
IP node 1 0.0.0.0
MAC node 2 00-00-00-00-00-00
IP node 2 0.0.0.0
MAC node 3 00-00-00-00-00-00
IP node 3 0.0.0.0
MaC node 4 00-00-00-00-00-00
IP node 4 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node & 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node 5 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node & 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node 5 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node & 0.0.0.0
MAC node 5 00-00-00-00-00-00
IP node 5 0.0.0.0

Figure 56: Extended Diagnosis EtherNet/IP Adapter > EIP_DLR > DLR Object Diagnosis

Name

Description

Network Topology

Possible Values: Linear or Ring

Network Status

Possible Values: Normal, Ring fault, Unexpected loop detected, Partial network fault,
Rapid fault/Restore cycle

Ring Supervisor Status

Possible Values: Backup, Active ring supervisor, Normal ring node, None DLR
device, Current supervisor parameters not supported

Ring Supervisor Mode

Possible Values: Deactivated, Activated

Ring Supervisor Precedence

Precedence value assigned to a ring supervisor, and transmitted in Beacon frames
(further see www.odva.org)

Beacon-Interval

Ring interval at which the supervisor sends beacon frames (further see

(Mikro-Sek) www.odva.org)

Beacon-Timeout Amount of time nodes will wait before timing out reception of Beacon frames and

(Mikro-Sek) taking the appropriate action (depending on weather supervisor or normal ring node).
(further see www.odva.org)

VLAN-ID VLAN ID used when sending DLR protocol frames.
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Name

Description

Ring faults count

Counts Ring faults

MAC of last active

MAC Address of last active node at port 1

node port 1

IP of last active IP Address of last active node at port 1
node port 1

MAC of last active MAC Address of last active node at port 2
node port 2

IP of last active
node port 2

IP Address of last active node at port 2

Ring participants count

Ring participants count

MAC of active ring
supervisor

MAC Address of active ring supervisor

IP of active ring supervisor

IP Address of active ring supervisor

Precedence of active ring

supervisor

The precedence the supervisor has in the ring.

Capability Flags

Indicates which capabilities the supervisor has.

MAC Node 1 MAC Address Node 1
IP Node 1 IP Address Node 1

to

MAC Node 10 MAC Address Node 2
IP Node 10 IP Address Node 2

Table 77: Extended Diagnosis EtherNet/IP Adapter > EIP_DLR > DLR Object Diagnosis
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8.2.2.9 EIS_DLR/DLR Object Counter
Task-3tatus
Mame | 'ert

=

Beacon Precedence Higher

Beacon Rx Port Meq Last

Ring State Changed To Mormal
Ring Skate Changed To Fault

Rcwd Beacon From Self on Port 1
Rcwd Beacon From Self on Port 2
Revd Meighbor Check Reg on Port 1
Rewd Meighbor Check Reg on Port 2
Rcvd Meighbor Check Res on Port 1
Fcvd Meighbor Check Res on Park 2
Revd MeighborfLink Status

Ficvwd Locate Faulk Frame

Rewd Announce Frame

Rcvd Sign On Frame

Fcvd Sign On Frame As Unicast
Beacon Timeout Port 1

Beacon Timeout Part 2

Sent Meighbor Check Req

Sent Meighbor Check Res

Sent Announce Frame

Sent Meighbaor/Link Skatus Frame
Forward Sign On Frame

Sent Sign On Frame

Sent Locate Faulk Frame

Senk Sign On Frarme To Ackive SY
Meighbor Check Timeout Port 1
Meighbor Check Timeouk Port 2
Announce Inkeryal Timeouk

Sigrn On Tirmeauk

Link, Up Port 1

Link, Drowen Port 1

Link. Up Port 2

Link. Down Pork 2

Set Beacon Ind Self

Reset Beacon Ind Self

oOooOoooooocoo oo oo oo oo oo oo o oo ooD oo oo oo oo

Figure 57: Extended Diagnosis EtherNet/IP Adapter > EIS_DLR > DLR Object Counter

Name Description

[Service] Diagnosis counter: Indicates the services processed. (The services of the single
packets are described in the EtherNet/IP Slave Protocol APl manual [2] [2].)

Table 78: Extended Diagnosis EtherNet/IP Adapter > EIS_DLR > DLR Object Counter
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8.2.3 Open Modbus/TCP
8.2.3.1 Overview Open Modbus/TCP

Dialog Panes “Extended Diagnosis” Open Modbus/TCP

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

Navigation Area Folder Name in the |Dialog Pane Manual
Open Modbus/TCP* Navigation Area Page
Navigation area = OMB OMB/OMB Information 146
[~ Diagnosis OMB/OMB Client 147
a Extended diagnosis OMB/OMB Server 148

3 R¥_SYSTEM
iy Task Information OMB/OMB 10 149
I”!Bat':: Status | For the description of further tasks refer to | 220
IniBatch Status | | section Descriptions for Tasks with similar
IniBatch Skatus " | Functions.
IniBatch Skatus
Iniatch Status Note: For netGateway devices the
IniBatch Skatus Extended Diagnosis for
{3 DPM_COMO_SME DPM_COMO_SMBX,
Task Information DPM_COMO_SMBX,
{23 DPM_COMO_RME Marshaller and Packet-Router is not
Task Information displayed.
3 TCP_UDP

) * The displayed Open Modbus/TCP
Task Information ; -
exteded diagnosis corresponds to the

IP Infarmatian Open Modbus/TCP firmware version
IP Packet Count 2 5.x.x

1P Code Diag

TCP_IDP Information

TCP_IUDP Code Diag
25 oMB

Task Information

OME Information

OME Client

OME Server

OME IO
£ OME_AP

Task Information
£ MARSHALLER

Task Information
25 PACKET_ROUTER

Task Infarmation

Table 79: Descriptions of the Dialog Panes Extended Diagnosis Open Modbus/TCP
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8.2.3.2 OMB/OMB Information
Task skates
Mame Walue
Task State ‘i'ait configuration
Error Counk 1]
Lask Error O 00000000
Socket Skatus O 00000000
Cyrlic Event Counk 6132
Idle Counk 0

Figure 58: Extended Diagnosis Open Modbus/TCP > OMB > OMB Information

Name

Description

Task State

Actual state of the protocol process:
- Task not initialized

- Task is running

- Task initialized

- Initialization error

- Waiting for configuration

Error Count

Counter for errors

Last Error

Last occurred error (Description see appropriate manual)

Socket Status

The socket status informs about the TCP sockets. More exactly, it contains the
information whether sockets are open or closed in a bit-coded manner. The coding is
as follows: The socket number corresponds to the position of the bit within the variable,
i.e. bit O represents socket # 0 and bit 15 represents socket # 15. The coding is in that
way that a bit value of 1 means the respective socket is open and a value of 0 indicates
it is not open.

Cyclic Event Count

The cyclic event counter represents the number of cyclic events that have occurred.

Idle Count

The idle count is currently not used.

Table 80: Extended Diagnosis Open Modbus/TCP > OMB > OMB Information
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8.2.3.3 OMB/OMB Client
Task skates

Mame | Yalue

Messages Send ko Lser ]

Messages Recy From User 1]

FZ1 Counk 1]

FiZ2 Count 1]

FiZ3 Count 1]

FZ4 Counk 1]

FZ5 Counk 1]

FiZ6 Count 1]

FiZ¥ Count 1]

FZ15 Count 1]

FZ16 Count 1]

FiZ23 Count 1]

Figure 59: Extended Diagnosis Open Modbus/TCP > OMB > OMB Client
Name Description
Messages Send to User Number of messages send from the OMB client to the user
Messages Recv from User Number of messages received from the user
FC[N] Count Number of access events to the respective function code
FC = Function code
Possible values forN =01, 2,3, 4,5, 6,7, 15, 16, 23

Table 81: Extended Diagnosis Open Modbus/TCP > OMB > OMB Client
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8.2.3.4 OMB/OMB Server

Task states

N Yalue

Messages Send ko TCP task
Messanes Fecy From TCP task
FZ1 Count

FiZ2 Count

FZ3 Count

FZ4 Count

FZS Count

FZ& Count

FZF Count

FZ15 Counk

FiZ1e Counk

FiZ23 Counk

=

oo o oo oo oo oo

Figure 60: Extended Diagnosis Open Modbus/TCP > OMB > OMB Server

Name Description

Messages Send to TCP task | Number of messages send from the OMB server to the TCP task

Messages Recv from TCP Number of messages received from the TCP task
task
FC[N] Count Number of access events to the respective function code

FC = Function code
Possible valuesforN =01, 2, 3, 4,5, 6,7, 15, 16, 23

Table 82: Extended Diagnosis Open Modbus/TCP > OMB > OMB Server
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8.2.3.5

Task states

OMB/OMB 10

Marne

| Yalue

FZ1 Count
FZ2 Count
FiZ3 Count
FZ4 Count
FZS Count
FZ& Count
FZF Count
FZ15 Counk
FiZ16 Counk
FiZ23 Counk

Daka count
Function code
Data

Error Counk
Laskt Error

Messages Send ko TCP task
Messages Recy From TCP bask

Modbus address

L]

oo o oo oo oo o ooo

Q000000000 000000000 00000000
0
Q00000000

Figure 61: Extended Diagnosis Open Modbus/TCP > OMB > OMB IO

Name

Description

Messages Send to TCP task

Number of messages send from the OMB server to the TCP task

Messages Recv from TCP
task

Number of messages received from the TCP task

FC[N] Count

Number of access events to the respective function code

FC = Function code
Possible valuesforN =01, 2, 3, 4,5, 6,7, 15, 16, 23

Modbus address

Address within the Modbus Data model or memory map
(Range 0 ... 65535).

Data count

Data counter

Function code

The Modbus standard function codes for send and receive operations:

FC1: Read coils

FC2: Read discrete inputs (input bits)
FC3: Read multiple registers

FC4: Read input registers

FC5: Write coil

FC6: Write single register

FC7: Read Exception Status

FC15 : Force multiple coils

FC16: Write multiple registers

FC23: Read/Write multiple registers

Data

The first data of the last sent function code (telegram) are displayed.

Error Count

Counter for errors

Last Error

Last occurred error (Description see appropriate manual)

Table 83: Extended Diagnosis Open Modbus/TCP > OMB > OMB 10
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8.2.4 PROFINET 1O Device
8.24.1 Overview PROFINET IO Device
Dialog Panes “Extended Diagnosis” PROFINET IO Device

The table below gives an overview for the Extended Diagnosis dialog
panes descriptions:

3 Tepip
Task Information
IP Information
IP Packet Counter
IP Code Diagnosis
TCP_UDP Information
TCP_UDP Code Diagnosis
£ PnsACP
Task Information
£3 PnsDCP
Task Information
General Diagnosis Information
Extended Diagnosis Information
£ PnsMGT
Task Information
£3 PnsRPC
Task Information
General Diagnaosis Information
Extended Diagnosis Infermation
=3 PnsCMDEY
Task Information
General Diagnaosis Information
£3) Prslf

Task Information

General Diagnosis Information
£ SNMP-Server

Task Information
£3 Mib-Database

Task Information
£ LLDP-Task

Tazk Information

Navigation Area Folder Name in the Navigation Manual
PROFINET IO Device* Area//Dialog Pane Page
Mavigation area PnsDCP/Extended Diagnosis 151

B3 Diagnosis Information
(& | Extended Diagnosis| PnsRCP/Extended Diagnosis 152
£ RX_SYSTEM Information
nd I“_;“”;”g’”“”” Pnslf/PROFINET 10 Device 153
niBatch Status Extended Diagnosis Information
IniBatch Status
IniBatch Status ™, | For the description of further tasks 220
IniBatch Status | | refer to section Descriptions for
IniBatch Status Tasks with similar Functions.
IniBatch Status

PROFIMET IO Device Extended Diagnesis Informatien

*The displayed PROFINET IO-
Device exteded diagnosis
corresponds to the PROFINET IO-
Device firmware version 3.4.x.x

Table 84: Descriptions of the Dialog Panes Extended Diagnosis PROFINET 10 Device
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8.2.4.2 PnsDCP/Extended Diagnosis Information

Extended Diagnosis Information

Task states

Name | Value

Frames received (MCR) 1]
Frames sent (MCR)

Frames received (LUCR)

Frames sent (LICR)

Frames received (MCS)

Frames sent (MC5)

Frames received (UCS)

Frames sent (LCS)

Active Application Timers Counter
Erronious Frames received

Ident Request received Counter
Ident Request sent Counter

Ident Response received Counter
Identify ALL Request sent Counter
DCP SET Requests Received

DCP Set Requests sentcounter
Positiv DCP Set Responses
Megativ DCP Set Responses

DCP Get Requests Received

Lo e I o o e e O e e e T o Y o o

=]

Figure 62: Extended Diagnosis PROFINET 10-Device > PnsDCP/Extended Diagnosis
Information

The extended Diagnosis Information PNIO_DCP displays the counter
reading of the four state machines from the PROFINET 10 DCP protocol.

MCR: Multi Cast Receiver
UCR: Uni Cast Receiver
MCS: Multi Cast Sender
UCS: Uni Cast Sender
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8.2.4.3 PnsRCP/Extended Diagnosis Information

Extended Diagnosis Information

Task states
Name | Value
PIMGs sent 0

PINGs received
WORKIMGSs sent
WORKIMGS received
MOCALLs sent
MOCALLs received
CAMCELs sent
CAMCELs received
REJECTs sent
REJECTs received
Requests sent
Reguests received
Responses sent
Responses received
Fragments sent
Fragments received
Active Application Timers

L I o o [ o I o O o O s e o R o Y o Y o N e Y e e}

Figure 63: Extended Diagnosis PROFINET 10-Device > PnsRCP/Extended Diagnosis
Information

The parameters under RPC > Extended Diagnosis Information represent
PROFINET IO specific counters.

For further information refer to the PROFINET 10 specification. [4], [17]
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8.24.4 Pnslf/PROFINET IO Device Extended Diagnosis Information
PROFINET 10 Device Extended Diagnosis Information
Task states

Mame | Value

PMIO Device State 0x7B

Device Information set

PRIOFIMET Stack started

API added

Module in Slat 0 plugged

Submodule in Slat 0 Subslot 1 plugged

Bus on frue

Last Result/Error Code Operation succeeded.

Link State Mo Physical Link

Configuration State Configured by means of Configuration Packets

Communication State Stop

Communication error Operation succeeded.
Figure 64: Extended Diagnosis PROFINET 10-Device > Pnslf/PROFINET 10 Device
Extended Diagnosis Information

Name Description

PNIO Device State

Summary of the PROFINET 1O stack status: set, not set

Device Information

Manufacturer information about the device, which is defined in the GSDML file.

PROFINET Stack

Status of the PROFINET IO stack: started, not started

API

API of the PROFINET 10 stack: added, not added

Module in Slot 0

Module in Slot 0 of the PROFINET IO stack: plugged, not plugged

Submodule in Slot 0 Subslot 1

Submodule in Slot 0 Subslot 1 of the PROFINET 10 stack: plugged, not plugged

Bus on

Network Communication: true, false

Last Result/Error Code

Last occurred result/ error of the PROFINET 10O stack:
e. g. “Operation succeeded”

Link State

State of the physical network connection of the PROFINET IO stack:

Low Physical Link Speed, No Physical Link

Configuration State

Configuration State of the PROFINET IO stack

. Not configured

. Configured by means of Configuration Files

° Error occurred while configuring with Configuration Files

° Configured by means of Configuration Packets

° Configuring by means of Configuration packets is running

° Error occurred during configuring with Configuration Packets

Communication State

Communication State of the PROFINET IO stack
d Unknown
. Not configured

i Stop
° Idle
i Operate

d Communication error

Communication error

Communication error of the PROFINET 10 stack:
e. g. “Operation succeeded”

Table 85: Extended Diagnosis PROFINET 10-Device > PnsIf/PROFINET IO Device
Extended Diagnosis Information
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8.2.5 POWERLINK Controlled Node
8.25.1 Overview POWERLINK Controlled Node

“Extended Diagnosis” POWERLINK Controlled Node

Navigation Area Folder Name in the |Dialog Pane Manual

POWERLINK Controlled Node* [Navigation Area Page
Navigation area = Note: Currently there is no specific

=3 Diagnosis extended diagnosis to the POWERLINK

Controlled Node.

=Y iaeneral Diagnosis

Firrmware Diagnosis . | For the description of the tasks refer to 220
=3 Extended Diagnosis | | section Descriptions for Tasks with similar
=5 R¥_SYSTEM " | Functions.
Task InFormation Note: For netGateway devices the
IniBiateh Status Extended Diagnosis for
IniBatch Status DPM_COMO_SMBX, DPM_COMO_SMBX,
Iniiatch Status Marshaller and Packet-Router is not
IniBatch Status displayed.

IniBatch Status

IniBatch Status
=5 DPM_COMO_SMEY

Task Information
=5 DPM_COMO_RMEY

Task Information
=3 EPLCM_DPM

Task Information
-3 EPLCN_PCK

Task Information
3 TCP_LIDP

Task Infarmation

IP Information

IP Packet Counter

IP Code Diagnosis

TCP_UDP Information

TCP_UDP Code Diagnosis
=5 MARSHALLER.

Task Information
=5 EPLCM_SDO

Task Information
=3 EPLCM_MMT

Task Information
=5 PACKET_ROUTER

Task Information

* The displayed POWERLINK Controlled
Node exteded diagnosis corresponds to the
POWERLINK Controlled Node firmware
version 2.1.x.Xx.

Table 86: Extended Diagnosis POWERLINK Controlled Node
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8.2.6 Sercos

8.26.1 Overview Sercos

“Extended Diagnosis” Sercos Slave

Navigation Area Folder Name in the |Dialog Pane Manual
Sercos Slave Navigation Area Page
Navigation Area = Note: Cyrrently there is no specific extended
: i diagnosis to the Sercos Slave.
(L1 Diagnosis
BEended Diagross
{33 RX_SYSTEM _ . | For the description of further tasks refer to 220
= Task Information | | section Descriptions for Tasks with similar
IniBatch Status " | Functions.

IniBatch Status

IniBatch Status

IniBatch Status

IniBatch Status

IniBatch Status
=3 DPM_COMO_SMEX

Task Information
=3 DPM_COMO_RMEX

Task Information
3 535_5VC

Task Information
£3 535 IDN

Task Information
23 535 COM

Task Information
3 535_AP

Task Information
23 535 NRT

Task Information
&3 TCP_UDP

Task Information

* The displayed POWERLINK Controlled
Node exteded diagnosis corresponds to the
Sercos Slave firmware version 3.1.X.X.

IP Information
IP Packet Counter
IP Code Diagnaosis
TCP_UDP Information
TCP_UDP Code Diagnosis
=9 535.5IP
Task Information
=3 TLRTIMER.
Task Information
=3 MARSHALLER
Task Information
3 PACKET_ROUTER
Task Information

Table 87: Extended Diagnosis Sercos Slave
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8.2.7 VARAN Client (Slave)
8.2.7.1 Overview VARAN Client (Slave)

Dialog Panes " Extended Diagnosis” VARAN Client (Slave)
Here you find an overview of the Extended Diagnosis for VARAN Client

(Slave).

Navigation Area Folder Name in the |Dialog Pane Manual
VARAN Client (Slave)* Navigation Area Page
NeriFE e aree = | VARANStack VARANStack/Extended Diagnostic 157
|23 Diagrosis VARANStack/Data Link Proc Port 158

‘3 Extended Diagnosis Diagnostic

QRX_SYETEM VARANApp VARANApp/App Extended 159
TE_ISk Information Diagnostic
IniBatch Status
IniBatch Status VARANApp/Extended Configuration | 160
IniBatch Status Diagnostic
IniBatch Status —
IniBatch Status . | For the description of further tasks 220
IniBatch Status . | refer to section Descriptions for

3 DPM_COMO_ SMEX Tasks with similar Functions.

Task Information -
£4 DPM_COMO_RMEX * The displayed POWERLINK

Task Information Controlled Node exteded diagnosis
3 vARANStack corresponds to the VARAN Client

Task Infarmation (Slave) firmware version 1.0.X.X.

Extended Diagnostic
Data Link Proc Port Diagnostic
23 VARAMADD
Task Infarmation
App Extended Diagnostic
Extended Configuration Diagnostic
3 MARSHALLER
Task Information
{23 PACKET _ROUTER
Task Information

Table 88: Descriptions of the Dialog Panes Extended Diagnosis VARAN Client (Slave)
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8.2.7.2 VARANStack/Extended Diagnostic

Task skates

Mame Yalue

zet Diagnostic Requests

et Diagnostic Confirmations - QK

et Diagnastic Confirmations - MO
zet Output Requests

Get Qukput Confirmations - Ok

et Dutput Confirmations - MOK

Set Inpuk Requesks

Sek Input Confirmations - Ok

Set Input Confirmations - MOk

Check Configuration Requests

Check Canfiquration Confirmations - Ok
Check Configuration Confirmations - MOK
Initialization Requests

Initialization Confirmations - Ok
Initialization Confirmations - MOk,
Change State Requests

hange State Confirmations - QK
Change State Confirmations - MK

]

Lol e e e e B R = g T I R e T I |

Figure 65: Extended Diagnosis VARAN Client (Slave) > VARANStack > Extended

Diagnostic
Name Description
[Service] Diagnosis counter: Indicates the services processed. (The services of the single packets are

described in the VARAN Client Protocol APl manual [15], in section
VARAN_CLIENT_CMD_GET_DIAG_REQ/CNF_T.)

Table 89: Extended Diagnosis VARAN Client (Slave) > VARANStack > Extended Diagnostic
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8.2.7.3

VARANStack/Data Link Proc Port Diagnostic

Task skates

Mame Yalue

R DY UP Counter Port0

Raw Frames Received Portd - Ok
Mested Frames Received Portd- OF
Received Frames Error Parkd

Fin Cuk Frames Part0 Counker

R Overflowy Porkd Counter

R Errar Statiskic Port0

Rs DV UP Counter Pork1

Raw Frames Received Portl - OF
Mested Frames Received Portl- OF
Received Frames Error Portl

Fin Cuk Frames Porkl Counker

R Overflow Parkl Counter

R Erraor Statiskic Pork1

Frames Sent OF Counter

T UFL Counker Park0

UTH UFL Counker Park1

*PEC not ready

Debug Counter Porkd

Debug Counter Portl

IP Fragments Received - QK

IF Fragments Dropped Due To Low Res
IP Fragments Dropped Due To DMA not ready
IP Fragments Transmitted - OF

IP Fragrenks Mok Sent Due To Low Res
IP Fragments Received By XPEC

IP Fragments Received By Host

IP Fragments Transmitted By Host
IP Fragrents Transmitked By XPEC
PLL Reset Requesks

Svncl Resel Requests

Swncl Reset Reguests

Collisian

R Mibble FIFC Error

T Nibble FIFO Error

Timerd Expired

TirerB Expired

PLL Cyile Sequence Error Counker

=

Lo I s I o O o I o O e e e Y e N s O e O s R s R O O s e Y e e Y o Y s O s O s O o s e g = Y s Y s Y o Y s R o s Y

Figure 66: Extended Diagnosis VARAN Client (Slave) > VARANStack > Data Link Proc Port

Diagnostic
Name Description
[Service] Diagnosis counter: Indicates the services processed. (The services of the single packets are

described in the VARAN Client Protocol APl manual [15], in section
VARAN_CLIENT_CMD_GET_DIAG_REQ/CNF_T.)

Table 90: Extended Diagnosis VARAN Client (Slave) > VARANStack > Data Link Proc Port
Diagnostic
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8.2.74 VARANApp/App Extended Diagnostic

Task skates

Marne Yalue

—_

Set Configuration Regquests

Set Configuration Canfirmations - OF
Set Configuration Confirmations - MOK
Channel Init Requests

Channel Init Confirmations - Ok
Channel Init Confirmations - MO

Skart Stop Requesks

Reqister Application Fequests

Register Application Confirmations - Ok
Register Application Confirmations - MOK
Set Watchdog Time Regquests

Set Watchdog Time Confirmations - OF
Set watchdog Time Confirmations - WK
3et Diagnostic Requests

hatchdog Indications

Lock Unlock Requests

Get Watchdog Time Requests
Unregister Application Regquests

et DPM IO Size Requests

Delete Configuration Requests

Stack Change OF State Indications

[ I o R L O e R e P N s Y s Y o I e e = R R e

Figure 67: Extended Diagnosis VARAN Client (Slave) > VARANApp > App Extended

Diagnostic
Name Description
[Service] Diagnosis counter: Indicates the services processed (refer also to the Dual-Port Memory
Interface Manual [17]).

Table 91: Extended Diagnosis VARAN Client (Slave) > VARANApp > App Extended
Diagnostic

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Extended Diagnosis

160/266

8.2.7.5 VARANApp/Extended Configuration Diagnostic
Task states

Mame Yalue
System flags 0
App, \Wakchdog bimeout 1000
App. Mode 0
Yendor ID 29
Device ID 1164
License Mumber 0
Product Revision 0
Yendor Mame Hilscher GrbH
Device Mame CIFXREMNRS
Serial Mumber 0
Crder Mumber 0
Memireal Read Offset 19z
Memdreal Read Size 128
Memfreal Wrike Offset 319z
Memareal Write Size 128
MemiareaZ Read Offset GE535
MemdreaZ Read Size 0
Memfreaz Wrike Offset BE535
Memareaz Write Size 1]
Configuration Flags 0
Client watchdog time 130
Syncouk pulse length 100
SyncOukd mode 5
SyncCutd flags 1
SyncCukl mode 0
Syncoukl Flags 0

Figure 68: Extended Diagnosis VARAN Client (Slave) > VARANApp > Extended

Configuration Diagnostic

Parameter

Meaning

Range of Value/Value

System flags
[Bus Startup]

Communication start application controlled or automatic

1 (=Application
controlled),

0 (=Automatic),
Default: 0

App. Watchdog
timeout

[Client Watchdog
Time]

Watchdog time within which the device watchdog must be retriggered
from the application program while the application program monitoring
is activated. When the watchdog time value is equal to0 the application
program monitoring is deactivated.

[0, 20 ... 65535] ms,
default = 1000 ms,
0 = Off

App.Mode Application mode Default =0
0 = VARAN_CLIENT_APP_MODE_IO

Vendor ID Vendor Identifier: Identification number of the manufacturer. 0..2%-1,
This value is specific for every single vendor. Hilscher: 29

Device ID Device Identifier: Identification number of the device as indicated by 00...2%2-1,

the VARAN-BUS-NUTZERORGANISATION. This value is specific for
every single device type and is fixed for every device. In case of an
unknown device ID the manager rejects the client.

CIFX RE/VRS: 1064;
COMX100xx-RE/VRS:
1062;

NIC50-RE/VRS: 1063;
NJ50x-RE/VRS: 1060;
NJ100xx-RE/VRS: 1061

License Number License number of the device as specified by the VARAN-BUS- 0..2%-1,
NUTZERORGANISATION. Default: 0

Product Revision Version of the device as specified by the manufacturer. 0..2%-1,

[Product Version] Default: 0
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Parameter Meaning Range of Value/Value

Vendor Name Name of the manufacturer, specific for every single vendor. Zeichenkette,

0 ... 64 Zeichen,
Default: Hilscher
GmbH

Device Name Name of the device as indicated by the VARAN-BUS- Zeichenkette,
NUTZERORGANISATION. 0 ... 64 Zeichen,
Default:

CIFX RE/VRS,
COMX100xx-RE/VRS,
NIC50-RE/VRS,
NJ50x-RE/VRS,
NJ100xx-RE/VRS

Serial Number Serial number of the device as specified by the manufacturer. 0..2%-1,
Default: 0
Order Number Order number of the device as specified by the manufacturer. 0..2%-1,
Default: 0

MemArea 1 Reading offset of the memory area lin Byte. 0 ... 65535 Byte,
Read Offset Default: 8192 Byte
Read Size / Reading size of the memory area 1lin Byte. 0 ... 128 Byte,
Memory Area 1 Default: 128 Byte
Write Offset / Writing offset of the memory area 1in Byte. 0 ... 65535 Byte,
Memory Area 1 Default: 8192 Byte
Write Size / Writing size of the memory area 1 in Byte. 0 ... 128 Byte,
Memory Area 1 Default: 128 Byte
Read Offset / Reading offset of the memory area 2 in Byte. 0 ... 65535 Byte,
Memory Area 2* (*currently not supported, set to default value) Default: 65535 Byte
Read Size / Reading size of the memory area 2 in Byte. 0 ... 128 Byte,
Memory Area 2* (*currently not supported, set to default value) Default: 0 Byte
Write Offset / Writing offset of the memory area 2 in Byte. 0 ... 65535 Byte,
Memory Area 2* (*currently not supported, set to default value) Default: 65535 Byte
Write Size / Writing size of the memory area 2 in Byte. 0 ... 128 Byte,
Memory Area 2* (*currently not supported, set to default value) Default: 0 Byte
Confignuration Flags | Bit 0: Enable/Disable EMAC Bit0: 0 =

If set, the parameters for Memory Area 2 are enabled. EMAC disable,

Bit 1: Enable/Disable MemArea 2 Bit0: 1= b

If set, an integrated Extended MAC-Address (EMAC) for IP data EMAC enable,

exchange with client application is used. Default value: 0

Bit 0 and 1 are currently not supported and they are set to default Bit1:0= .
value. MemArea 2 disable,
Bitl:1=
MemArea 2 enable,
Default value: 0
Client Watchdog Client watchdog time in ms. The Client watchdog time is the maximum |[0 ... 130] ms,
Time cyclic communication timeout allowed, before Client signals a bus Default = 130 ms,
error. 0 = Off
SyncOut pulse length | Pulse length of the SYNC Out signal in 10ns steps. 0...2.147.483.647,
[Pulse Length (e.g. the value 100 results as 10ns*100=1000ns=1ps pulse) Default: 100

(x10ns)]
Sync OUT 0/ Sync OUT 1

Note!
Only the following 3 combinations between SyncOutOMode + SyncOut1Mode are

reasonable:

"Time for IN/OUT valid (TIO) — (5)" + "Disable — (0)",

"Time for IN valid (TI) — (3)" + "Time for OUT valid (TO) — (4)",
"Time for OUT valid (TO) — (4)" + "Time for IN valid (TI) — (3)"
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Parameter Meaning Range of Value/Value
SyncOut0 mode "SyncOut 0 Mode* for the SYNC Out 0 signal, using the settings: 0,345
"Disable — (0)": Default: 5

The output of the SYNC Out 0 signal is not available,

"Time for IN valid (TI) — (3)":

For the output of the SYNC Out 0 signal the time for the data IN is
valid,

"Time for OUT valid (TO) — (4)":

For the output of the SYNC Out 0 signal the time for the data OUT is
valid,

"Time for IN/OUT valid (TIO) — (5)™:
For the output of the SYNC Out 0 signal the time for the data IN/OUT is

valid.
SyncOutO Flags Bit 0: Enable/Disable Output Bit0: 0 =
The “Sync out 0 flag/Output” enables / disables the output of the grtjtgui tilsable,

Memory Area 1 SYNC Out 0 signal.
Output enable,

Bit 1: Polarity active high/ low Default value: 1
The “Sync out 0 flag/Polarity” defines the active high/low behavior of Bit 1: 0 = active low,
the SYNC Out 0 signal. Bit 1: 1 = active high,
Default value: 1
SyncOutl mode "SyncOut 1 Mode" for the SYNC Out 1 signal, using the settings: 0,345
"Disable — (0)": Default: 0

The output of the SYNC Out 1 signal is not available,

"Time for IN valid (TI) — (3)":

For the output of the SYNC Out 1 signal the time for the data IN is
valid,

"Time for OUT valid (TO) — (4)":

For the output of the SYNC Out 1 signal the time for the data OUT is
valid,

"Time for IN/OUT valid (TIO) — (5)":
For the output of the SYNC Out 1 signal the time for the data IN/OUT is
valid.

SyncOutl Flags Bit 0: Enable/Disable Output Bit0: 0=

The “Sync out 1 flag/Output” enables / disables the output of the Output disable,

: Bit0: 1=
Memory Area 2 SYNC Out 1 signal.
y u 9 Output enable,

Bit 1: Polarity active high/ low Default value: 0

The “Sync out 1 flag/Polarity” defines the active high/low behavior of Bit 1: 0 = active low,
the SYNC Out 1 signal. Bit 1: 1 = active high,

Default value: 0

Table 92: Extended Diagnosis VARAN Client (Slave) > VARANApp > Extended
Configuration Diagnostic

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Extended Diagnosis 163/266

8.3 Fieldbus Systems

8.3.1 PROFIBUS DP Slave
8311 Overview PROFIBUS DP Slave
Dialog Panes “Extended Diagnosis” PROFIBUS DP Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

Navigation Area Folder Name in the | Dialog Pane Manual
PROFIBUS DP Slave* Navigation Area Page
[ = PROFIBUS_DL PROFIBUS_DL/Busparameter 164
[_7 Diagniosis PROFIBUS_DL/Counter 166
{3 Extended Diagnosis PROFIBUS PROFIBUS_FSPMS/Extended Diagnosis | 167

{3 R¥_SYSTEM FSPMS
tmp Task Information -
IniBatch Skakus '\PAROFIBUS_FSPMS/ Config Data from 168
IniBatch Status aster
IniBatch Status PROFIBUS_FSPMS/ Config Data from 168
IniBatch Status Slave
IniBatch Status PROFIBUS_FSPMS/Parameter Data 169

IniBatch Status
3 PROFIBUS_DL

Task Information | For the description of further tasks referto | 220
Busparameter | | section Descriptions for Tasks with similar
Counker Functions.
£ PROFIBUS_FSPMS
Task Infarmation * The displayed POWERLINK Controlled
Extended Diagnosis Node exteded diagnosis corresponds to the
Config Data from master PROFIBUS DP Slave firmware version
2.4.xX.X.

Config Data From slawe
Parameter Data
Code Diagnostic
3 PROFIEUS_APS
Task Information

Table 93: Descriptions of the Dialog Panes Extended Diagnosis PROFIBUS DP Slave
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8.3.1.2 PROFIBUS_DL/Busparameter

Under Extended Diagnosis > PROFIBUS DL > Busparameter the values
of the configured bus parameters are displayed which are active at the bus.

Task skates
Mame | Walue
Station Address z
Baudrate Auto Detect
Slat Time (EGiE) ]

Min. Station Delay Time (EBik)
Maz, Skakion Delay Time (kB
Quiet Time (kBik)

Setup Time {LBit)

Target Fotation Time (tBit)
EAP Factor

Highest Skation Address (H3A)
Mazx. Retry Linik

oo oo oo oo

Figure 69: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_DL> Busparameter

Bus Parameters Meaning

Station Address The Station Address is the individual device address of the Master device on the bus.
Value range: 0 .. 125

Baud Rate The Baud Rate is the data transfer speed: number of Bits per second.

The Baud Rate must be set to be the same for all devices on the bus. The result of
changing the Baud rate is that all other parameters must be re-calculated.

Baud Rate Bit time (tai) Max cable length (type A)
9,6 kBit/s 104,2 us 1200 m

19,2 kBit/s 52,1 us 1200 m

31,25 kBit/s 32 us 1200 m

45,45 kBit/s 22 us 1200 m

93,75 kBit/s 10,7 us 1200 m

187,5 kBit/s 5,3 us 1000 m

500 kBit/s 2us 400 m

1500 kBit/s 666,7 ns 200 m

3000 kBit/s 333,3ns 100 m

6000 kBit/s 166,7 ns 100 m

12000 kBit/s 83,3 ns 100 m

Slot time (tBit) ‘Wait for receipt' — Monitoring time of the sender (Requestor) of telegram for the

acknowledgement of the recipient (Responder). After expiration, a retry occurs in
accordance with the value of 'Max. telegram retries'.

Value range: 37 .. 16383 (The default value depends from the baud rate.)

Min. Station Delay This is the shortest time period that must elapse before a remote recipient (Responder)
Time (tBit) may send an acknowledgement of a received query telegram. The shortest time period
between the reception of the last Bit of a telegram to the sending of the first Bit of a
following telegram.

Value range: 1 .. 11 . 65535

Max. Station Delay This is the longest time period that must elapse before a Sender (Requestor) may send a
Time (tBit) further query telegram. Greatest time period between the reception of the last Bit of a
telegram to the sending of the first Bit of a following telegram.

The Sender (Requestor, Master) must wait at least for this time period after the sending
of an unacknowledged telegram (e.g. Broadcast only) before a new telegram is sent.

Value range: 1 .. 65535 (The default value depends from the baud rate.)

Quiet Time (tBit) This is the time delay that occurs for modulators (Modulator-trip time) and Repeaters
(Repeater-switch time) for the change over from sending to receiving.

Value range: 0 .. 127 (The default value depends from the baud rate.)
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Bus Parameters

Meaning

Setup Time (tBit)

Minimum period “reaction time” between the receipt of an acknowledgement to the
sending of a new query telegram (Reaction) by the Sender (Requestor).

Value range: 0 .. 255 (The default value depends from the baud rate.)

Target Rotation Time
(tBit)

Pre-set nominal Token cycling time within the Sender authorization (Token) will cycle
around the ring. How much time the Master still has available for sending data telegrams
to the Slaves is dependent on the difference between the nominal and the actual token
cycling time.

The Target rotation time (Ttr) is shown in Bit times (tBit) like the other Bus Parameters.
Below the displayed Bit time, the Target rotation time is also displayed in milliseconds
(ms).

Value range: 1 .. 2?4-1 (=16.777.215)

(The default value depends on the number of Slaves attached to the Master and their
module configuration)

GAP Factor

Factor for determining after how many Token cycles an added participant is accepted
into the Token ring. After expiry of the time period G*Trr, the Station searches to see
whether a further participant wishes to be accepted into the logical ring.

Value range: 0 .. 10 .. 255

Highest Station
Address (HSA)

The Highest Station Address is the highest bus address up to which a Master searches
for another Master at the bus in order to pass on the Token. This station address must on
no account be smaller than the Master station address.

Value range: 1 .. 126

Max. Retry Limit

Maximum number of repeats in order to reach a Station.

Value range: 1 .. 15 (The default value depends from the baud rate.)

Table 94: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_DL> Busparameter
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8.3.1.3 PROFIBUS_DL/Counter

Task states

Mame Yalue

Receive Frames ]
Transmik Frames
Transrnik Error

Receive Error

Target Ratation Tirmeouk

oo oo

Figure 70: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_DL> Counter

The values of the counter Receive Frames and Transmit Frames show
generally whether there is bus activity or not.

Name Description

Receive Frames Counter for number received frames
Transmit Frames Counter for number transmitted frames
Transmit Error Counter for number transmitted errors
Receive Error Counter for number received errors
Target Rotation Timeout | Counter for number target rotation timeout

Table 95: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_DL> Counter
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8.3.1.4 PROFIBUS_FSPMS/Extended Diagnosis
Task states
Mame Yalue
Skation Address z
Ident Mumber 0x0Ea9
Baud R.ate Auto Detect
Cutput Length 0
Input Length 0
Figure 71: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Extended
Diagnosis
Name Description

Station Address

PROFIBUS address of the device
Range of value: 0 ... 125

Ident Number

PROFIBUS Identification Number
Range of value: 0 ... 65535, Default: 0x0A12

Baud Rate

9,6 kBit/s 3 MBit/s
19,2 kBit/s 6 MBit/s
93,75 kBit/s 12 MBit/s
187,5 kBit/s 31,25 kBit/s
500 kBit/s 45,45 KkBit/s
1,5 MBit/s Auto detect

Output Length

Number of the output bytes
Range of value: 0 ... 244

Input Length

Number of the input bytes
Range of value: 0 ... 244

Table 96: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Extended
Diagnosis
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8.3.1.5 PROFIBUS_FSPMS/ Config Data from Master
Task states
Marme Yalue

Configuration Data Length 2
Configuration Daka w47 les 2030050070800 10i0 110 12:0 13:0 141,

Figure 72: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Config Data
from Master

Name Description

Configuration Data Length | Number of the configuration data from Master in byte
Describes how many bytes of the configuration data are valid.

Configuration Data Left value: numbering of every configuration data byte
Right value: value of the respective configuration data byte

Table 97: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Config Data
from Master

_) Note: To view the Value column completely, double click to the right
border of the column head. Move to the left or the right column side using
the scroll bar.

8.3.1.6 PROFIBUS_FSPMS/ Config Data from Slave
Task skates
Marne Yalue
Configuration Daka Length Z
Configuration Daka 147 e 2030405007050 010:011:012:013:0..,

Figure 73: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Parameter

Data
Name Description
Parameter Data Number of the parameter data in byte
Length Describes how many bytes of the parameter data are valid.
Parameter Data Left value: numbering of every parameter data byte

Right value: value of the respective parameter data byte

Table 98: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Parameter
Data

_) Note: To view the Value column completely, double click to the right
border of the column head. Move to the left or the right column side using
the scroll bar.
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8.3.1.7 PROFIBUS_FSPMS/Parameter Data
Task skates
Mame Yalue
Parameter Data Length 0
Parameter Data oono20s00s0e0F0s: 001010120150 140:01,..

Figure 74: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Parameter

Data
Name Description
Parameter Data Number of the parameter data in byte
Length Describes how many bytes of the parameter data are valid.
Parameter Data Left value: numbering of every parameter data byte

Right value: value of the respective parameter data byte

Table 99: Extended Diagnosis PROFIBUS DP Slave > PROFIBUS_FSPMS > Parameter
Data

_) Note: To view the Value column completely, double click to the right
border of the column head. Move to the left or the right column side using
the scroll bar.
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8.3.2 CANopen Slave

8.3.2.1 Overview CANopen Slave

Dialog Panes “Extended Diagnosis” CANopen Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

Task Information
Application Commands
CAM Driver Skatus
=3 CAMOPEM_SLAYE
Task Information
Common diagnostic
Commands
Mode diagnostic
PO diagnostic
300 diagnostic
Additional diagnostic
Receive CAN-ID diagnostic
(OB parameter diagnoskic
23] CAMNCOPEM_APS
Task Information
Slave configuration
Carmmands
DPM data exchange
3 COS_0Dv3
Task Information

Navigation Area Folder Name in the Dialog Pane Manual
CANopen Slave* Navigation Area Page
Navigation Area = CAN_DL CAN_DL/AP Commands Counter 171
|- Diagnosis CAN_DL/CAN Driver Status 172
El%te“ded Diagnosis CANOPEN_SLAVE CANOPEN_SLAVE/Common Diagnostic | 173

Rx_SYSTEM

Task InFormakion CANOPEN_SLAVE/Commands 174
IniBakch Status CANOPEN_APS CANOPEN_APS/Slave configuration 181
IniBatch Status CANOPEN_APS/Commands 182
IniBaktch Stakus -
IniBaktch Stakus
IniBatch Status | For the description of further tasks refer |220
IniBakch Status | | to section Descriptions for Tasks with

23 CAM_DL similar Functions.

* The displayed CANopen Slave exteded
diagnosis corresponds to the CANopen

Slave firmware version 3.0.X.X.

Table 100: Descriptions of the Dialog Panes Extended Diagnosis CANopen Slave
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8.3.2.2

CAN_DL/AP Commands Counter

Task states

Marne

Yalue

[aka Request

Positive Confirmations
Meqgative Confirmations

Zan DL Indications

Zan DL Responses

Can DL Skark Request
Positive Start Confirmations
Megative Skart Confirmations
Stop Requesks

Pasitive Stop Confirmations
Megative Stop Confirmations
Application Register Requests

Set Parameter Fequests

Set Filker Requests

Positive Set Filker Confirmations
Megative Set Filker Confirmations
Enable Receive Id Requests

Event Indications

Event Responses

Event Acknowledge Request
Positive Event Confirmations
Megative Event Confirmations
Transmit Abort Request

Init Request

Pasitive Init Confirmations
Meqative Init Confirmations
Hi Priority Data Request

Positive Application Register Co...
Meqgative Application Reqgisker C...

Positive Set Parameter Confirma. .,
Megative Set Parameter Confirm, ..

Paositive Enable Receive Id Confi. ..
Megative Enable Receive Id Con, ..

Pasitive Transmit bort Canfirm. ..
Megative Transmit Abark Confir, .

Positive Hi Priority Daka Confirm. ..
Megative Hi Priority Daka Confir...

]

oo o oMM OO oo o0 OoORMO-~~OO0O0O0O OO =0QO0C0Mo

Figure 75: Extended Diagnosis CANopen Slave > CAN_DL > AP Commands Counter

Name

Description

[Service]

Diagnosis counter of the CAN layer. Indicates the services processed. (The
services of the single packets are described in the CANopen Slave Protocol API
manual [8].)

Table 101: Extended Diagnosis CANopen Slave > CAN_DL > AP Commands Counter
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8.3.2.3 CAN_DL/CAN Driver Status
Task skates

Mame Yalue
Can Skatus O=00000006
Bus OFf false
Errar Warning true
Errar Passive true
Transmit Frame Succeded 1]
Transmit Errar Sumnarsy 4000
Receive Frame Succeded 1]
Receive Error Summary 0
Transmit Error Counker 128
Receive Error Counker 0
Arbitration Losk 1]
Inications Dropped dus to Fifo Full 0
Confirmations Dropped due ko Fi... 0
Receive Standardframes filkered 1]
Receive extended frames filkered 0
Receive Standardframes passed 1]
Receive extended frames passed 0

Figure 76: Extended Diagnosis CANopen Slave > CAN_DL > CAN Driver Status

Name Description

CAN Status Diagnosis status of CAN specific error levels. Indicates the respective status of the

Bus Off CAN bus. (For further information refer to the CANopen Slave Protocol APl manual

Error Warning [8])

ErrorPassive

[Service] Diagnosis counter of CAN errors. Indicates the services processed. (The services
of the single packets are described in the CANopen Slave Protocol API manual [8].)

Table 102: Extended Diagnosis CANopen Slave > CAN_DL > CAN Driver Status
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8.3.24 CANOPEN_SLAVE/Common Diagnostic
Task skates

Mame | Yalue

Lask received COB-ID 1]

CAM kelegrams sent n

CAM kelegrams received n

Mumber of detected CAM errors n

Baudrate 1MBaud
Figure 77: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Common
Diagnostic

Name Description

Last received COB-ID Last received CAN-Message Header-ID

CAN telegrams sent Number of sent CAN-Messages

CAN telegrams received Number of received CAN-Messages

Number of detected CAN errors Number of detected CAN errors

Bauderate Baud rate of CANopen connection
Available Baud Rate:
1 MBaud 100 KBaud
800 KBaud 50 KBaud
500 KBaud 20 KBaud
250 KBaud 10 KBaud
125 KBaud

Table 103: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Common

Diagnostic
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8.3.25 CANOPEN_SLAVE/Commands
Task skates
Mame Yalue

Reqgister req.

Regisker cnf,

Skart/Stop req,

Skark)stop cnf,

Busparam req.

Busparam cnf,

Get buffer req,

Get buffer cnf,

Skate change ind.

State change res,

Set watchdog Fail req.

Set wakchdog Fail crf,

Data exch, req.

Data exch, cnf,

Send emergency req.

Send emergency onf,

MMT command req.

MMT command cnf,

CaM_DL stop req.

CAN_DL skop cnf, pos.,
Cak_DL skop cnf, ned.
Cal_DL regisker req.
CAM_DL registker cnf, pos.,
CaAM_DL regisker cnf, neg.
Cal_DL sek param req.
CAN_DL set param cnf, pos,
CAMN_DL set param cnf, neq,
CaM_DL start req.

CAMN_DL start cnf, pos,
Cak_DL skart cnf, neq.
CAN_DL event ind.

Can_DL event res,

Cak_DL register cnf, pos,
Zak_DL send daka cnf, pos,
CaM_DL send data cnf. neq,
ZaM_DL enable id req.
Cal_DL enable id cnf, pos,
ZAMN_DL enable id cnf. neg.
CAN_DL event ack, req.

CAMN_DL recy data ind.
CAM_DL recy data res,
Unknawn req. fonf,
Cyelic ind.

Get packet Failed

Send packet Failed

CAN_DL event ack, cnf. pos,
CAMN_DL event ack, cnf, neg.

O = = = =
Lim g}

a04497

Lo w1 [ e T T e Y T e e o e N e e Y e e e e T e Y e T e s e e o e s e e e e Y e e e e o e O R g

Figure 78: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Commands

Name

Description

[Service]

Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CANopen Slave Protocol API manual [8].)

Get packet failed

Number of errors during requesting a packet

Send packet failed

Number of errors during sending a packet

Table 104: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Commands
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8.3.2.6 CANOPEN_SLAVE/Node diagnostic

Task skates

Marne

Yalue

MMT skake
Murmber of error control events
Error behaviour

Pre-Operational
0

Change ta pre-operational if operational
Murnber of MMT messages received 0
Murmber of book-up messages sent

Murmber of EMCY messages sent

Murmber of heartbeat messages sent

Murber of heartbeat messages received

Murber of node-guarding messages sent

Murmnber of node-guarding messages received (RTR)
Murmber of S¥YNC messages received

Murmber of timestamp messages sent

Murber of timestamp messages received

Mumber of RxPDO messages received

Murmber of TxPDO messages sent

Murmnber of RxPDO messages senk (RTR)

Murmnber of TxPDO messages received (RTR)
Mumber of 500 server messages sent

Mumber of 300 server messages received

L o R e T o O e e o O e e e Y e Y S )

Figure 79: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Node diagnostic

Name

Description

NMT state

Possible NMT states:

- Reset (at the beginning - reset node, later on - reset communication)

- Stopped

- Operational

- Pre-operational

NMT = Network Management

(For further information refer to the CANopen Slave Protocol APl manual [8].)

Error behaviour

Possible Error behaviour

- Change to pre-operational if operational
- No change of NMT state

- Change to stopped

[Services]

Number of error control events

Diagnosis counter

Number of NMT messages received

Number of boot-up messages sent

Number of EMCY messages sent

Number of heartbeat messages sent

Number of heartbeat messages received
Number of node-guarding messages sent
Number of node-guarding messages received (RTR)
Number of SYNC messages received
Number of timestamp messages sent
Number of timestamp messages received
Number of RxPDO messages received
Number of TXPDO messages sent

Number of RxPDO messages sent (RTR)
Number of TXPDO messages received (RTR)
Number of SDO server messages sent
Number of SDO server messages received

Internal diagnosis counter:
Indicate the send/received
messages.

Table 105: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Node diagnostic
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8.3.2.7

Task skates

CANOPEN_SLAVE/PDO diagnostic

Mame | Value
Murnber of receive PDO B4

Mumber of transmit PDO a4

Receive PDO count 0

Feceive PDO COB-ID OxQ000aco0
Receive PDO number n

Receive PDO rejected counk 1]

Send PO count: a0

Send PO COB-ID OxQ000aco0
Send PO number a0

Figure 80: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > PDO diagnostic

Name

Description

[Services]

Diagnosis counter: Indicate the services processed. (The services of the single packets are
described in the CANopen Slave Protocol API manual [8].)

Number of receive
PDOs

Number of the used receive PDOs

Number of transmit
PDOs

Number of the used send PDOs

Receive PDO number

Number of the last received PDO

Receive PDO COB-ID

CAN identifier related to the COB (Communication Object) of the last received PDO.
Receive PDOs are output data of the Master and are received from the node.
(For further information refer to CANopen Slave Protocol APl manual [8].)

Send PDO COB-ID

CAN identifier related to the COB (Communication Object) of the last sent PDO.
Send PDOs are input data of the Master and are send by the node.
(For further information refer to CANopen Slave Protocol APl manual [8].)

Table 106: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > PDO diagnostic
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8.3.2.8 CANOPEN_SLAVE/SDO diagnostic
Task stakes
Marne Yalue
Mumnber of CCS init download messages received n
Murnber of 3C5 init download messages sent 1]
Mumber of CC5 segment download messages received 0
Mumber of SC5 segment download messages sent a0
Mumber of CCS inik upload messages received a0
Mumnber of SC5 init upload messages sent 1]
Mumber of CC5 segment upload messages received 1]
Mumber of SC3 segment upload messages sent a0
Mumber of CC5 abaort messages received a0
Mumnber of S5 abork messages sent n
Murmber of CCS unknown messages received 1]
Last successfully index 00000
Last successfully sub-index 000
Last Faulty inde:x: 00000
Last Faulty sub-index 000
Last abort code 000000000

Figure 81: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > SDO diagnostic

Name Description

[Service] Diagnosis counter: Indicate the services processed. (The services of the single packets are
described in the CANopen Slave Protocol API manual [8].)

Last successfully index | Last index/sub-index of the successful or faulty send/received service data object (SDO) and

Last successfully sub- | code for abort.
index

Last faulty index
Last faulty sub-index
Last abort code

Table 107: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > SDO diagnostic
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8.3.2.9 CANOPEN_SLAVE/Additional diagnostic

Task skates

Mame Value
CAMN-DL quewe 50035950
ODW3 quene OxE00A51 20
Stake change queue OxB00A67 70
PDO receive queue Cex0a00aao0
Event indication queue Cex00a0ao00
Events indicated 000000000
MMT skate change Mo
Timestamp receive Mo

Error control event Mo

Receive PDO Mo

MMT cornmand Mo

Figure 82: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Additional
diagnostic

State change queue
PDO receive queue
Event indication queue

Name Description
CAN-DL queue Handle to another queue for the internal packet communication (to be used for trouble
ODV3 queue shooting)

Events indicated

Event Bit-list (1 Bit per event) to indicate the events in hexadecimal form

Example:

NMT state change: Yes
Timestamp receive: Yes
Error control event: Yes
Receive PDO: Yes
NMT command: Yes

Then “Events indicated” = 0x00000001F

NMT state change
Timestamp receive
Error control event
Receive PDO
NMT command

Events, indicated to the application

No: This event is not indicated to the application.
Yes: this event is indicated to the application.

Table 108: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Additional
diagnostic
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8.3.2.10

Task skates

CANOPEN_SLAVE/Receive CAN-ID diagnostic

SARL TR OIS n nnd

Mame | Yalue

CAN-ID 0-31 Ox00000001
CAN-ID 32-63 Ox0000a000
CAN-ID 64-95 Ox00000000
CAN-ID 96-127 Cx00000000
CAN-ID 128-159 Ox00000001
CAN-ID 160-191 Ox0000a000
CAN-ID 192-223 Ox00000000
CAN-ID 224-255 Ox00000000
CAN-ID 256-287 Cx00000000
CAN-ID 258-319 Ox0000a000
CAN-ID 320-351 Ox0000a000
CAN-ID 352-383 Ox00000000
CAN-ID 384-415 Ox00000002
CAN-ID 41 6-447 Ox00000000
CAN-ID 448-479 Ox0000a000
CAN-ID 4580-511 Ox0000a000
CAN-ID 512-543 Ox00000002
CAN-ID 544-575 Ox00000000
CAN-ID 576-607 Ox00000000
CAN-ID 605-639 Ox0000a000
CAN-ID 640-671 Ox0000000z
CAN-ID 672-703 Ox00000000
CAN-ID 7F04-735 Cx00000000
CAM-ID 736-767 000000000
CAN-ID 7e3-799 Ox0000ao0z
CAN-ID S00-531 Ox00000000
CAN-ID 832-863 Ox00000000
CZAN-ID S64-8095 Cx00000000
CAN-ID 596-927 Ox0000aaoz
CAN-ID 925-959 Ox0000a000

[ata e lalaTa ety

Figure 83: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Receive CAN-ID

diagnostic
Name Description
CAN-ID 0-31 One bit-field for each CAN-ID, which is currently processed by the stack.

CAN-ID 2016-2047

Range of values for the CAN-ID: CAN-ID 0 to CAN-ID 2047

Example:
Name Value Meaning
CAN-ID 0-31 0x00000001 CAN-ID 0 has been processed
CAN-ID 32-63 0x00000000 no CAN-ID has been processed
CAN-ID 64-95 0x00000000 no CAN-ID has been processed
CAN-ID 96-127 0x00000000 no CAN-ID has been processed
CAN-ID 128-159 0x00000001 CAN-ID 128 has been processed
CAN-ID 384-415 0x00000004 CAN-ID 386 has been processed

CAN-ID 2016-2047 0x00000000 no CAN-ID has been processed

Table 109: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > Receive CAN-ID
diagnostic

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices
DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public © Hilscher, 2008-2017



Extended Diagnosis

180/266

8.3.2.11 CANOPEN_SLAVE/OBJ parameter diagnhostic

Task skates

Marme Value

Lask written inde:x 01001

Lask written sub-index 000

Lask written data Oe00000001
Errar count a

Lask written Faulky index 0000

Lask written Faulty sub-index 000

Lask written Faulty data 000000000
Lask erraor Cex00000000

Figure 84: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > OBJ parameter

diagnostic

Name

Description

Last written index
Last written sub-index
Last written data

Last written index/sub-index/data of the OBJ parameter diagnostic.

Error count

Diagnosis counter (described in the CANopen Slave Protocol API manual [8].)

Last written faulty index

Last written faulty sub-
index

Last written faulty data
Last Error

Last written faulty index/sub-index/data and last error of the OBJ parameter diagnostic.

Table 110: Extended Diagnosis CANopen Slave > CANOPEN_SLAVE > OBJ parameter

diagnostic
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8.3.2.12 CANOPEN_APS/Slave configuration

Task skates
Mame Yalue
Flags 1]
Database found no
Warmstart configuration yla]
Initialization skate Complete
Initialization result Q00000000

Figure 85: Extended Diagnosis CANopen Slave > CANOPEN_APS > Slave Configuration

Name

Description

Flags

Bit0

set: Configuration data base found

not set: No configuration data base found
Bitl

set: Configuration by packets

not set: No packets for configuration

Database found

Yes: Configuration data base found
No: No configuration data base found

Warmstart
configuration

Yes: Configuration by packets
No: No packets for configuration

Initialization state

Idle

Send initialize request

Wait for initialize confirmation
Send register request

Wait for register confirmation
Send get buffer request

Wait for get buffer confirmation
Send bus parameter request
Wait for bus parameter confirmation
Complete

Failed

Initialization result

Error code of the initialization, O = no error

Table 111: Extended Diagnosis CANopen Slave > CANOPEN_APS > Slave Configuration
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8.3.2.13 CANOPEN_APS/Commands

Task states

Mame Yalue

Regisker req. 1
Reqister cnf. 1
SkarkfSkop req. 20
Skark/Skop onf, 20
Init req. 1
Init crf,

Busparam req.
Busparam cnf.

et buffer req.

Get buffer crf,

State change ind,
Skake change res,

Set watchdog Fail req.
Set watchdog Fail cnf,
Config pck. rouked
Command pck, routed
Inknown req. fonf,
Cyilic ind,

Get packet failed
Send packet Failed

Q085S

Lo T e T e e Y e e el e e )

Figure 86: Extended Diagnosis CANopen Slave > CANOPEN_APS > Commands

Name Description

[Service] Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CANopen Slave Protocol APl manual [8].)

Get packet failed Number of errors during requesting a packet

Send packet failed Number of errors during sending a packet

Table 112: Extended Diagnosis CANopen Slave > CANOPEN_APS > Commands
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8.3.2.14

Task skates

CANOPEN_APS/DPM data exchange

Marne Walue

Input block size 5760

Input block mode 4

Qutput block, size 57A0
Cutput block mode 4

Input data count 51z

Cubput daka count 51z

Input data update command count 0

Input data update acknowledas counk 0

Qutput daka update command counk 0

Cubput data update acknowledge count 0

Transfer mode DPM

Input DMA starked count 0

IR inpuk DMA Finished counk 0

Cutput DMA skarked count 0

IR output DA Finished count 0

Ipdate input data error count 0

Last update input: data error 000000000
pdate output data error counk 0

Last update output data error 00000000

Figure 87: Extended Diagnosis CANopen Slave > CANOPEN_APS > DPM data exchange

Name

Description

[Services]

Diagnosis counter: Indicate the services processed. (The services of the single packets are
described in the CANopen Slave Protocol API manual [8].)

Input block size

Block size of the receive data in Byte

Input block mode

value (read out from the device) = 4 (host control)

Output block size

Block size of the send data in Byte

Output block mode

value (read out from the device) = 4 (host control)

Input data count

Diagnosis counter: Indicates the input data as an UINT 32 value*.
* 1 UINT 32 = 4 Byte

Output data count

Diagnosis counter: Indicates the output data as an UINT 32 value*.
* 1 UINT 32 = 4 Byte

Transfer mode

Possible values: “DPM”, “DMA”
DPM = Dual-Port Memory
DMA = Direct Memory Access

Last update input data
error

Hexadecimal number identifying the last error occurred during the receive data are updated.

Last update output
data error

Hexadecimal number identifying the last error occurred during the send data are updated.

Table 113: Extended Diagnosis CANopen Slave > CANOPEN_APS > Commands
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8.3.3

8.3.3.1

DeviceNet-Slave

Overview DeviceNet Slave

Dialog Panes “Extended Diagnosis” DeviceNet Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

AP Command Counters
CAMN Command Counters
Timer-Counter

3 DMS_AP
Task Information

Navigationsbereich Folder Name in the [Dialog Pane Manual
DeviceNet Slave* Navigation Area Page
_— CAN_DL CAN_DL/AP Commands Counter 185
MNavigation area ]
(] Diagnasis CAN_DL/CAN Driver Status 186
== | Extended Diagnosis DNS_FAL DNS_FAL/DNS Common Status 187
{23 CANDL DNS_FAL/AP Commands Counter 188
Task Inf ti
= 'asknfermation DNS_FAL/CAN Command Counter 188
App Commands
CAM Driver Status
£3 DNS_FAL DNS_FAL/Timer Counter 189
Tazk Information
DMS Common Status For the description of further tasks refer to 220

_: section Descriptions for Tasks with similar

Functions.

* The displayed DeviceNet Slave exteded
diagnosis corresponds to the DeviceNet Slave
firmware version 2.3.x.X.

Table 114: Descriptions of the Dialog Panes Extended Diagnosis DeviceNet Slave
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8.3.3.2

CAN_DL/AP Commands Counter

Task skates

Mame | Yalue

[Data Request

Positive Canfirmations

Meqative Confirmations

Can DL Indications

_an DL Responses

Can DL Start Request

Positive Start Confirmations
Meqative Start Confirmations

Skop Requests

Positive Stop Confirmations
Meqative Stop Confirmations
Application Reqgister Requests
Positive Application Reqister Confi, ..
Megative Application Register Caon...
Set Parameker Requests

Positive Set Parameker Confirmati.. .
Meqative Set Parameter Confirmat, ..
Set Filker Requests

Positive Set Filker Confirmations
Meqative Set Filker Confirmations
Enable Receive Id Requests

Fositive Enable Receive Id Confir. ..
Megative Enable Receive Id Confir, ..
Event Indications

Event Responses

Event Acknowledge Request
Positive Event Confirmations
Meqative Event Confirmations
Transmit Abork Request

Fositive Transmit Abort Confirmati, ..
Megative Transmit Abort Confirma. ..
Init Request

Positive Init Confirmations

Megative Init Confirmations

Hi Priarity Daka Requesk

Positive Hi Priority Data Confirmati, .
Meqative Hi Priority Data Confirma, .

—_

O D0 00O = = O OO0 oM MO0 DRPOMRM O DORPMnOOoOOoOOD

Figure 88: Extended Diagnosis DeviceNet Slave > CAN_DL > AP Commands Counter

Name

Description

[Service]

Diagnosis counter of the CAN layer. Indicates the services processed. (The
services of the single packets are described in the DeviceNet Slave Protocol API
manual [11].)

Table 115: Extended Diagnosis DeviceNet Slave > CAN_DL > AP Commands Counter
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8.3.3.3 CAN_DL/CAN Driver Status
Task skates

Mame Yalue
Can Skatus 0000000068
Bus OFf false
Error Warning frue
Errar Passive Lrue
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
Reserved false
24 volt Metwork Errar false
Transmit Frame Succeded n
Transmit Error Surnrmary 704132
Receive Frame Succeded 1]
Receive Errar Summary 0
Transmit Errar Counker 128
Receive Error Counker 0
Arbitration Losk 1]
Inications Dropped due to Fifo Full 1]
Confirmations Dropped due ko Fifo,,, 0
Receive Standardframes filkered 1]
Receive extended frames filkered 1]
Receive Standardframes passed 1]
Receive extended frames passed n

Figure 89: Extended Diagnosis DeviceNet Slave > CAN_DL > CAN Driver Status

Name Description

CAN Status Diagnosis status of CAN specific error levels. Indicates the respective status of the

Bus Off CAN bus. (For further information refer to the DeviceNet Slave Protocol APl manual

Error Warning [11].)

ErrorPassive

Reserved Diagnosis status

24 Volt Network Error Diagnosis status of DeviceNet specific error levels. (For further information refer to
the DeviceNet Slave Protocol API manual [11].)

[Service] Diagnosis counter of CAN errors. Indicates the services processed. (The services
of the single packets are described in the DeviceNet Slave Protocol APl manual
(11].)

Table 116: Extended Diagnosis DeviceNet Slave > CAN_DL > CAN Driver Status
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8.3.34 DNS_FAL/DNS Common Status
Task skates
Marme | Yalue
Mac I 0
Baud Rate 500 kBaud
Produced Size 3 Byte
Consumed Size  Byte
Wakchdog Time 0 ms
Config Flags {Summary) 000000000
Config Flag(1) 'TGMORE_ADDR_S...  FALSE
Config Flag(2) "CONMTIMUE_OR_BL... FALSE
Config Flag(3) '"CONTIMUE_OM_LO... FALSE
Config Flagl4) 'RECVIDLE_CLEAR ... FALSE
Config Flagls) 'RECYIDLE_USER_...  FALSE
Config Flagle) '24vDCIMNVERT FaLSE
Enable Flags (Summary) Dx0000003F
Enable Flagi1l) "YERDORID' TRLE
Enable FlagZ) 'PRODUCTTYPE' TRLE
Enable Flag(3) 'PRODIDCTCODE! TRLE
Enable Flag4) ™MaJORMINORREY TRLE
Enable Flag(S) 'SERIALMR TRLE
Enable Flagle) 'PRODIJCTHMAME TRLE
Yendor ID 283
Product Type 1z
Product Code 11
Minor Revision 1
Major Revisian 1
Serial Murnber 206331153
DMS State DUP _\WaAIT _SEMND
Skakus Flags (Summary) Q00000007
Skabus Flag(l) 'BUS_PRM_WALID' TRLE
Skakus Flags(2) 'BUS_START' TRLE
Status Flags(3) "24v_METWORK ... TRUE
Skabus Flags(4) 'METWORK_STAT... FALSE
R Inkterrupks 0
Tw Interrupks 0
R Crverrun 0
T Owerrun 0
T# Aborts n
Errar Interrupt 2
Bus OFf Count: n
Reset Count 1
Figure 90: Extended Diagnosis DeviceNet Slave > DNS_FAL > DNS Common Status
Name Description
[Status] Common DNS Diagnosis status. Indicates the current status of the single tasks.

(For further information refer to the DeviceNet Slave Protocol APl manual [11].)

Table 117: Extended Diagnosis DeviceNet Slave > DNS_FAL > DNS Common Status
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8.3.35 DNS_FAL/AP Commands Counter
Task skates
Mame Yalue
Register Aplication Req. 2
Register Aplication Cnf. Pos. 2
Reqister Aplication Cnf, Meg. 1]
Init Req. 2
Init Cnf. Pos, 2
Init Cnf. Meq. n

Figure 91: Extended Diagnosis DeviceNet Slave > DNS_FAL > AP Commands Counter

Name Description
[Service] Diagnosis counter of the FAL layer. Indicates the services processed. (The services
of the single packets are described in the DeviceNet Slave Protocol APl manual
(11].)
Table 118: Extended Diagnosis DeviceNet Slave > DNS_FAL > AP Commands Counter
8.3.3.6 DNS_FAL/CAN Command Counter
Task skates
Marme Yalue
CAMN Data Ind. 1]
AN Data Req. 1
CAM Data Crf, Pos, 0
AN Data Cnf. MNeq. 0
Figure 92: Extended Diagnosis DeviceNet Slave > DNS_FAL > CAN Command Counter
Name Description
[Service] Diagnosis counter of the FAL layer. Indicates the services processed. (The services

of the single packets are described in the DeviceNet Slave Protocol APl manual

(11].)

Table 119: Extended Diagnosis DeviceNet Slave > DNS_FAL > CAN Command Counter
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8.3.3.7 DNS_FAL/Timer Counter
Task states
Marme Yalue
Cwclic Timer 3006094
Figure 93: Extended Diagnosis DeviceNet Slave > DNS_FAL > Timer Counter
Name Description
[Service] Diagnosis counter of the FAL layer. Indicates the services processed. (The services

of the single packets are described in the DeviceNet Slave Protocol APl manual

(11].)

Table 120: Extended Diagnosis DeviceNet Slave > DNS_FAL > Timer Counter
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8.3.4 CC-Link Slave

8.34.1

Overview CC-Link Slave

Dialog Panes “Extended Diagnosis” CC-Link Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

XC receive area

AC config area

#C status area

XC management area
KC triple buffer area

SN CCLIMK_APS
Tazk Information
Slave configuration
Commands
DPM data exchange
Rotary switch
5 MARSHALLER
Tazk Information
=3 PACKET_ROUTER
Task Informaticon

refer to section Descriptions for Tasks
with similar Functions.

Navigation Area Folder Name in the |[Dialog Pane Manual
CC-Link Slave Navigation Area Page
Navigation area CCLINK_SLAVE CCLINK_SLAVE/Configuration 191
[_71 Diagnosis CCLINK_SLAVE/Commands 193
7= | Extended Diagnosis CCLINK_SLAVE/Interrupts 194
3 RX_SYSTEM CCLINK_SLAVE/XC receive area 194
=y Tazk Information COLINK SLAVE/XC .
IniBatch Status = config area 195
IniBatch Status CCLINK_SLAVE/XC status area 198
IniBatch Status CCLINK_SLAVE/XC management 201
IniBatch Status area
IniBatch Status CCLINK_SLAVE/XC triple buffer area |203
IniBatch Status CCLINK_SLAVE/Extended 204
{23 DPM_COMO_SMBX transmission diagnostic
Task Information
£ DPM_COMD_RMEX CCLINK_APS CCLINK_APS/Slave configuration 205
Tazk Information
3 TLRTIMER ) CCLINK_APS/Commands 206
Tazk Information
25 CCLIMNK_SLAVE CCLINK_APS/DPM data exchange 207
Task Information -
Configuration CCLINK_APS/Rotary Switch 208
Commands
Interrupts = For the description of further tasks 220

Extended transmission diagnestic

Note: For netGateway devices the
Extended Diagnosis for
DPM_COMO_SMBX,
DPM_COMO_SMBX,

Marshaller and Packet-Router is not
displayed.

* The displayed CC-Link Slave exteded

diagnosis corresponds to the CC-Link
Slave firmware version 2.7.x.x.

Table 121: Descriptions of the Dialog Panes Extended Diagnosis CC-Link Slave
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8.3.4.2 CCLINK_SLAVE/Configuration

Configuration

Task states
Mame | Value
Slave station address i
Baudrate 156kBaud
Station type Remote I/0 Station
Mumber of occupied stations 1
CC-Link Version Version 1 Mode
Extension cyde Single
1/ types and points Default
Input data in case of error Clear
Vendor code 0x0352
Model type 2
SW Version 4
1/ bit data count (bytes) 4
1/ reqister data count (bytes) i]

Figure 94: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Configuration

Name

Description

Slave station address

Station address of CC-Link Slave

Note: The number of occupied stations plus station address must not exceed the

parameter range
Range of value: 1 ... 64

Baudrate

- Not configured
- 156kBaud

- 625kBaud

- 2500kBaud

- 5SMBaud

- 10MBaud

Station type

- Not configured

- Remote I/O Station

- Remote Device Station

- Intelligent Device Station

Number of occupied stations

Number of occupied stations
Remote I/O Station: 1 (Default)
Remote Device Station: 1 ... 4

CC Link Version

- Not configured
- Version 1 Mode
- Version 2 Mode

Extension cycle

Number of extension cycles:
- Not configured

- Single/One cycle

- Double/Two cycles

- Quadruple/Four cycles

- Octuple/Eight cycles

Allowed numbers for CC-Link version 1: Single

Allowed numbers for CC-Link version 2: Single, Double, Quadruple, Octuple
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Name Description

I/O types and points Total number of points; I/O type available: Mixed, Input, Output, Composite
- Not configured
- Default

- Mixed, depending on number of occupied station
- Mixed, 8 points (Bits)

- Mixed, 16 points (Bits)

- Mixed, 32 points (Bits)

- Input, depending on number of occupied station

- Input, 8 points (Bits)

- Input, 16 points (Bits)

- Input, 32 points (Bits)

- Output, depending on number of occupied station
- Output, 8 points (Bits)

- Output, 16 points (Bits)

- Output, 32 points (Bits)

- Composite, depending on number of occupied station
- Composite, 8 points (Bits)

- Composite, 16 points (Bits)

- Composite, 32 points (Bits)

“Mixed” means that both input and output exist on the same module.
“Composite” means a device that doesn’t use the same numbers for input and

output.

Input data in case of error - Not configured
- Clear
- Hold

Vendor code Vendor code (If corresponding bit in the vendor code flags parameter is set)
Range of value: 0 ... 65535, Default: 0x0352

Model type Model type (If corresponding bit in the model type flags parameter is set)
Range of value: 0 ... 255

SW Version Software version (If corresponding bit in the software version flags parameter is set)
Range of value: 0 ... 63, Default: 1

I/O bit data count (bytes) Counter for I/O bits in bytes

I/O register data count Counter for I/O register in bytes

(bytes)

Table 122: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Configuration
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8.3.4.3 CCLINK_SLAVE/Commands

Task states

Marne

Yalue

Register req.
Reqgister cnf.
SkartfSkop req,
Start/Stop cnf,
Set busparam req.
Set busparam cnf.
Get busparam req.
Get busparam cnf,
Get buffer req.
Get buffer cnf,
Get ool skatus req.
et ccl skatus cnf,

Skate change ind,
Skate change res,

Set watchdog Fail req.
Set watchdog Fail cnf,
nknown req, fonf.
Cwclic ind.

et packet Failed
Send packet Failed

Change slave status req.
Change slave status cnf,

OO o0 = 0O 000000000 —

[ =]
-l
[
(=]
=]
I

Figure 95: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Commands

Name

Description

[Service]

Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CC-Link Slave Protocol APl manual [7].)

Get packet failed

Number of errors during requesting a packet

Send packet failed

Number of errors during sending a packet

Table 123: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Commands
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8.34.4

CCLINK_SLAVE/Interrupts

Interrupts

Task states

Mame Value

Commaon 0
RX-PDO written

T¥-PDO read

CRC error

Connection state change

[ I o o I}

Figure 96: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Interrupts

Name

Description

[Service]

Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CC-Link Slave Protocol APl manual [7].)

8.3.4.5

T

Table 124: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Interrupts

CCLINK_SLAVE/XC receive area

ask skates

Mame Yalue

CCLS_RY_TIMESTAMP_NS 000000000
CCLS_RY_TIMESTAMP_S 000000000
CCLS_RCYD_TEST_DATA_OF_MSTPATD 000000000
CCLS_Ry_FRAME_FIN_OK_JUMP_LABEL 000000000

Figure 97: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC receive area

_) Note: The Extended Diagnosis > CCLINK_SLAVE > XC receive area
serves only for internal diagnosis purposes.
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8.3.4.6

Task states

CCLINK_SLAVE/XC config area

Marme Walue

CCLS SLAVE _STATION_ADDR C00000000
CCLS_MUMBER_OF _OCCURIED _STATIONS C00000000
CCLS_VENDOR_CODE C00000000
CCLS_MODEL_CODE Q00000000
CCLS_SOFTWARE_VERSION C00000000
CCLS_SLAVE _POLLIMG_TIMEOQUT Ce00000000
CCLS_MASTER_DaTA_REFRESH_TIMEOUT C00000000
CCLS_COMSECUTIVE_TRANSMISSION_MOMNL.,.,  Ox00000000
CiCLS_IMTERRUPTS_EMABLE 00000000
CCLS_SYSTIME _BORDER_COPY O 3B9ACIFF

Figure 98: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC config area

ID Value Description
CCLS_SLAVE_STATION_ADDR 1..64 Slave station address
CCLS_NUMBER_OF_OCCUPIED_STATIONS 1...4 Number of occupied stations
CCLS_VENDOR_CODE Vendor code
CCLS_MODEL_CODE 0.. 281 Model code

The model codes are allocated in vendor
modules.

Bits 1 and 0: Total number of 10-points
00: dependent of the number of occupied
stations,

01: 8 points,

10: 32 points,

11: 16 points

Bits 3 and 2: I/O types

00: mixed: Where both inputs and outputs
exist on the same module. The same 1/O
numbers (starting from RX0 and RYO,
respectively) are used.

01: input,

10: output,

11: composite: A device that does not use
the same numbers for input (RX) and
output (RY)

Bits 5 and 4: Number of occupied
stations

00: 1 station occupied
01: 2 stations occupied
10: 3 stations occupied
11: 4 stations occupied
Bit 7 and 6: Reserved

Bit 8: Switch Setting
0: Normal, 1: Abnormal

Bit 9: Output status when error occurs
0: Clear, 1: Hold

Bits 13 to 10: reserved
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ID

Value

Description

(continued)
CCLS_MODEL_CODE

Bits 15 and 14: Station Type
(Type of station)

00: remote I/O

01: remote device

10: intelligent device/local
11: Reserved

Bits 23 and 16: Model Type (This byte
defines the model of the slave station. This
is allocated seperately for each model.)

Bits 31 and 24: reserved

CCLS_SOFTWARE_VERSION

0.. 2821

Software version (Machine information,
set by ARM before CC-Link Slave is
started)

Bits 5 to 0: Software Version Vendor
(This indicates the software version of
each model; dependent on the vendor)

Bits 7 and 6: Protocol Version
(for Version 2)

00: Version 1

01: Version 2

10: Version 3 (Future function)
11: Version 4 (Future function)
Bits 31 to 8: reserved

CCLS_SLAVE_POLLING_TIMEOUT

0.. 2%21

Slave polling timeout

Bits 31 to 0: Slave Station Polling,
Timout value in 10ns resolution,
0: timeout monitoring disabled

CCLS_MASTER_DATA_REFRESH_TIMEOUT

0.. 2%21

Master data refresh timeout

Bits 31 to 0: Master Data Refresh,
Timeout value in 10ns resolution,
0: timeout monitoring disabled

CCLS_CONSECUTIVE_TRANSMISSION_MONIT
ORING_TIMEOUT

0.. 2%21

Consecutive transmission monitoring
timeout

Bits 31 to 0: Monitoring of consecutive
transmission time,

Timeout value in 10ns resolution,

0: timeout monitoring disabled

CCLS_INTERRUPTS_ENABLE

0.. 2%21

Bit 0: RX Test Data written by Master
(enable event "Master has written new

test-loopback data"; to inform ARM that
Master Status was updated)

Bit 1: TX Test Data ready by Master
(enable event "Master has polled test-
loopback data")

Bit 2: RX PDO written by Master (enable
event "Master has refreshed RXPDQO")

Bit 3: TX PDO read by Master (enable
event "Master has polled TXPDO")

Bit 4: Refresh Cycle End (enable event
"Refresh cycle end")
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ID Value Description
(continued) Bit 5: Slave polling Timeout (enable
CCLS INTERRUPTS ENABLE event "Slave polling timeout")

Bit 6: Master Data refresh Timeout
(enable event "Master data refresh
timeout")

Bit 7: Consecutive Transmission
Timeout (enable event "Consecutive
Transmission monitoring timeout")

Bit 8: CRC Error (enable event "CRC error
detected")

Bit 9: Slave connected State changed
(enable event "The connection state of the
slave has changed")

Bit 10: RX Message Buffer written by
Master (enable event "Receive message
buffer written by master")

Bit 11: TX Message Buffer read by
Master (enable event "Transmit message
buffer read by master")

Bit 15 to 12: reserved
Bit 31 to 16: reserved (unusable)
CCLS_SYSTIME_BORDER_COPY 0..2%1 Bits 31 to 0: Systime border copy

Table 125: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC config area
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8.34.7 CCLINK_SLAVE/XC status area

Task skates

Mame Yalue

CCLS_RX_MESSAGE BUF _STATUS 000000000
CCLS Te_MESSAGE_BUF_STATUS Q00000000
CCLS_COMMECTION_STATE Ox00000000
CCLS_MASTER_STATUS Ox00000000
CCLS_SLAVE_STATUS Q00002000

Figure 99: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC status area

ID

Value

Description

CCLS_RX_MESSAGE_BUF_STATUS

0..2%1

0: Receive Message Buffer Empty,
otherwise: Receive Message Buffer Full,
set by xPEC, reset by ARM

CCLS_TX_MESSAGE_BUF_STATUS

0..2%1

0: Transmit Message Buffer Empty,
otherwise: Transmit Message Buffer Full,
set by ARM, reset by xPEC

CCLS_CONNECTION_STATE

0..2%1

Bit 0: State (connection state of slave),
0: disconnected,

1: connected,

written by xPEC

Bit 1: Network joined
0: reserved

1: local slave was test polled by master
Bits 15 and 2: reserved

Bit 16: Consecutive Transmission
Timeout Status
0: no error

1: error
Bits 31 and 17: reserved

CCLS_MASTER_STATUS

0..2%1

Bit 0: Status1 Master Status User
Application Programm (Operation status
Master station user application program)
0: stop

1: run

Bit 1: Status1 Master Status User
Application Programm Error Check (An
error occured in the master station user
application program)

0: normal
1: error

Bit 2: Status1 refresh Startup
(Link refresh was started)

0: stop
1: start
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ID Value Description
(continued) Bit 3: Status1 Transient data status
CCLS MASTER STATUS (Transient data is included)

0: no error

1: error

Bit 4: Status1 Transient data reception
enabled (Ready to receive transient
data.)

0: disabled

1: enabled

Bits 6 and 5: Status1 Protocol version
00: Version 1

01: Version 2

10: Version 3 (Future function)

11: Version 4 (Future function)

Bit 7: Status1 Master Station Type
(Station type of the master station)

0: Master station
1: Standby master station

Bits 11 and 8: Status 2 RY Info
Transmission Points (RY: Remote
output length; multiplied with 32 bytes)
Bits 15 and 12: Stauts 2 RWW Info
Transmission Points (RWW: Remote
register output length; multiplied with 64
bytes)

Bit 31 to 16: reserved

CCLS_SLAVE_STATUS 0..2%1 Bit 0: Station 1 fuse Status
(Salve station fuse has blown)

0: No error

1: Error

Bit 1: Station 1 unit Error invalid
Number of Points (Unit error (remote 1/10
stations), Invalid number of points flag;
slave stations excluding remote 1/O
stations)

0: No error
1: Error

Bit 2: Station 1 no refresh receive
(No refresh transmission received from
the master station; shall be set to zero
because bit is inserted by xPEC)

0: Not received
1: Received

Bit 3: Station 1 no parameter receive
(No parameter information received from
the master station)

0: Not received
1: Received

Bit 4: Station 1 switch change detection
(Switch setting changed after power is
turned on or reset cancelled)

0: Not present
1: Present
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ID

Value

Description

(continued)
CCLS_SLAVE_STATUS

0.. 2821

Bit 5: Station 1 cyclic Communication
(Cyclic communication is enabled)

0: Enabled
1: Disabled
Bit 6: reserved

Bit 7: Station 1 Watchdog Error
(Watchdog timer error has occurred)

0: Not present
1: Present

Bit 8: Station 2 Transient Data Status
(Transient data is included; shall be set to
zero because bit is inserted by XPEC)

0: No transient data is included
1: Transient data is included

Bit 9: Status2 Transient data reception
enabled (Ready to receive transient data;
shall be set to zero because bit is inserted
by xPEC)

0: Disabled
1: Enabled

Bit 10: Status2 Transient Type (Type of
transient data)

0: 1:n communication (intelligent device
station)

1: n:n communication (local station)
Bit 11: reserved

Bit 12: Status2 Transmission Route
Status (Transmission route error)

0: No error
1: Error

Bit 12: Station 2 res fixed to one
reserved (setto 1)

Bit 15 to 14: State 2 extended Cycle Set-
ting (Extended cycle setting; Version 2)

00: Single setting (1*)

01: Double setting (2*)
10: Quadruple setting (4*)
11: Octuple setting (8%)
Bit 31 to 16: reserved

Table 126: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC status area
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8.3.4.8 CCLINK_SLAVE/XC management area
Task states

Mare Yalue

CCLS_SLAME_FRAMES_FC_FD TRAMSMITTE... 0=00000000
CCLS_SLAVE_FRAMES_FE_FF_TRANSMITTED,.. 0=00000000
CCLS_MASTER_FRAMES_FA_RECEIWED Ok 000000000
CiCLS_MASTER_FRAMES FC_RECEIWED Ok Q00000000
CCLS_MASTER_FRAMES _FD_RECEIVED Ok 000000000
CCLS_MASTER_FRAMES_FE_RECEIVED Ok 0=00000000
CiCLS_MASTER_FRAMES_FF_RECEIVED Ok 000000000
CiCLS_SLAVE_FRAMES_FC_RECEIVED Ok Q00000000
CCLS_SLAVE_FRAMES_FD_RECEIVED Ok 000000000
CCLS_SLAVE_FRAMES_FE_RECEIVED Ok 0=00000000
CCLS_SLAVE_FRAMES_FF_RECEIVED Ok 000000000
CCLS_UMENOWN_FRAMES RECEIVED Ok Q00000000
CCLS_SLAVE _POLLIMG_TIMEOUT _ERROCRS 000000000
CCLS_MASTER_DATA_REFRESH_TIMEOUT_E... 0=00000000
CCLS_COMSECUTIVE_TRAMSMISSION_MOMNI.,..  O0x00000000
CiCLS CRC_ERRORS Q00000000
CCLS_ABORT_ERRORS 000000000
CCLS_FORMAT_ERRORS 000000000
CCLS_LEMGTH_ERRORS 000000000
CCLS_URX_FIFO ONERFLOW ERRORS 000000000
CCLS_MESSAGES_DROPPED_DUE_MESSAGE ... 0=00000000

Figure 100: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC management area

ID

Value

Description

_OK

CCLS_SLAVE_FRAMES_FC_FD_TRANSMITTED

0..

232-1

Counter for frames of type "Slave station
test loop-back data" that are successfully
transmitted

OK

CCLS_SLAVE_FRAMES_FE_FF TRANSMITTED_ | O ...

232-1

Counter for frames of type "Slave station
response (refresh) data" that are
successfully transmitted

CCLS_MASTER_FRAMES_FA_RECEIVED_OK 0..

232-1

Counter for frames of type "Refresh cycle
end data" that are successfully received

CCLS_MASTER_FRAMES_FC_RECEIVED_OK 0..

232-1

Counter for frames of type "Master station
test polling data" that are successfully
received

CCLS_MASTER_FRAMES_FD_RECEIVED_OK 0..

232-1

Counter for frames of type "Master station
test polling and test data" that are
successfully received

CCLS_MASTER_FRAMES_FE_RECEIVED_OK 0..

232-1

Counter for frames of type "Master station
polling data" that are successfully received

CCLS_MASTER_FRAMES_FF_RECEIVED_OK 0..

232-1

Counter for frames of type "Master station
polling and refresh data" that are
successfully received

CCLS_SLAVE_FRAMES_FC_RECEIVED_OK 0..

232-1

Counter for frames of type "Slave station
test loopback data" that are successfully
received

CCLS_SLAVE_FRAMES_FD_RECEIVED_OK 0..

232-1

Counter for frames of type "Slave station
response (refresh) data" that are
successfully received

CCLS_SLAVE_FRAMES_FE_RECEIVED OK 0..

232-1

Counter for frames of type "Slave station
response (refresh) data" that are
successfully received
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ID Value Description
CCLS_SLAVE_FRAMES_FF_RECEIVED_OK 0..2%1 Counter for frames of type "Slave station

test loopback data" that are successfully
received
CCLS_UNKNOWN_FRAMES_RECEIVED_OK 0.. 281 Counter for frames of unknown type that
are successfully received
CCLS_SLAVE_POLLING_TIMEOUT_ERRORS 0..2%1 Counter for Slave Station Polling Timout
errors
CCLS_MASTER_DATA REFRESH_TIMEOUT ER | 0... 2821 Counter for Master Data Refresh Timeout
RORS errors
CCLS_CONSECUTIVE_TRANSMISSION_MONIT 0.. 281 Counter for consecutive transmission
ORING_TIMEOUT_ERRORS timeout errors
CCLS_CRC_ERRORS 0.. 281 Counter for frames that do not pass the
CRC check
CCLS_ABORT_ERRORS 0.. 281 Counter for frames that were aborted
during reception
CCLS_FORMAT_ERRORS 0.. 281 Counter for frames that have not the
expected frame format
CCLS_LENGTH_ERRORS 0.. 281 Counter for frames that have not the
expected frame length
CCLS_URX_FIFO_OVERFLOW_ERRORS 0.. 281 Counter for frames that have an urx fifo
overflow error
CCLS_MESSAGES_DROPPED_DUE_MESSAGE | 0...2%%! Counter for times a message was dropped

due message buffer was full

Table 127: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC management area

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices

DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Extended Diagnosis 203/266

8.3.4.9 CCLINK_SLAVE/XC triple buffer area
Task states

Mame Yalue

CiCLS_TRIPEUF _RxPDiD xPEC Q000000 4
CiCLS_TRIPBUF_RXPDO_LAST O=000003C8
CCLS_TRIPEUF_RXPDO_ARM Ox=000006CC
CCLS_TRIPEUF_RAPDO_UPDATED O=00000000
CCLS_TRIPEUF_THPDO_<PEC O=00000900
CCLS_TRIPBUF_T=PDhD LAST 000000404
CCLS_TRIPBUF_THEPDO_ARM O=000004832
CCLS_TRIPEUF_T=PDO_UPDATED O=00000000

Figure 101: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC triple buffer area

ID Value Description
CCLS_TRIPBUF_RXPDO_XPEC 0..2%1 XPEC register of Tripple Buffer for RxPDO
CCLS_TRIPBUF_RXPDO_LAST 0.. 2%t LAST register of Tripple Buffer for RxPDO
CCLS_TRIPBUF_RXPDO_ARM 0.. 2%t ARM register of Tripple Buffer for RxPDO
CCLS_TRIPBUF_RXPDO_UPDATED 0.. 2%t Updated register of Tripple Buffer for
RxPDO
CCLS_TRIPBUF_TXPDO_XPEC 0.. 2%t XPEC register of Tripple Buffer for TXPDO
CCLS_TRIPBUF_TXPDO_LAST 0.. 2%t LAST register of Tripple Buffer for TxPDO
CCLS_TRIPBUF_TXPDO_ARM 0.. 2%t ARM register of Tripple Buffer for TxPDO
CCLS_TRIPBUF_TXPDO_UPDATED 0.. 2%t Updated register of Tripple Buffer for
TxPDO

Table 128: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > XC triple buffer area
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8.3.4.10 CCLINK_SLAVE/Extended transmission diagnostic

Task skates

E = ‘alue
50 complete counk 0
S0 error counk 1]
53 repetitions counk u]

Figure 102: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Extended transmission
diagnostic

ID

Description

SQ complete count

Number of complete data transfers
(SQ = sequence)

SQ error count

(SQ = sequence)

Number of detected sequence errors in the data transfers

SQ repetitions count

Number of repeated data sequences
(SQ = sequence)

Table 129: Extended Diagnosis CC-Link Slave > CCLINK_SLAVE > Extended transmission

diagnostic
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8.3.4.11 CCLINK_APS/Slave configuration

Task skates

Marme Yalue

Flags 1]

Dakabase found no

Configuration packet no

Initialization skate Complete

Initialization result 000000000

Figure 103: Extended Diagnosis CC-Link Slave > CCLINK_APS > Slave Configuration

Name Description
Flags Indication of flags
Database found Indicates if the configuration database has been found (yes) or not (no)

Configuration packet Indicates if the configuration shall be done with a configuration packet (yes) or not (no)

Initialization state - Idle

- Send initialize request

- Wait for initialize confirmation

- Send register request

- Wait for register confirmation

- Send get buffer request

- Wait for get buffer confirmation
- Send bus parameter request

- Wait for bus parameter confirmation
- Complete

- Failed

Initialization result Status code for error-free initializing = 0x00000000, otherwise error code
Table 130: Extended Diagnosis CC-Link Slave > CCLINK_APS > Slave Configuration
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8.3.4.12 CCLINK_APS/Commands

Task skates

Marne

Yalue

Reqgister req.
Reqister cnf.
Startistop req.
SkartfStop cnf,
Init req.

Init cnif.
Busparar req.
Busparam cnf,
et buffer req.
et buffer cnf,

Stake change ind.
Stake change res,

Set watchdog Fail req.
Set wakchdog Fail cnf,
onfig pck. routed
Command pck., rouked
Unknown req, fenf,
Cyelic ind,

et packet Failed
Send packet failed

Change slave skatus req.
hange slave skatus cnf,

[y

-l

35135
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Figure 104: Extended Diagnosis CC-Link Slave > CCLINK_APS > Commands

Name

Description

[Service]

Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CC-Link Slave Protocol APl manual [7].)

Get packet failed

Number of errors during requesting a packet

Send packet failed

Number of errors during sending a packet

Table 131: Extended Diagnosis CC-Link Slave > CCLINK_APS > Commands
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8.3.4.13

Task states

CCLINK_APS/DPM data exchange

DPM data exchange

Marne

| Value

Input block size
Input block mode
Cutput block size
Cutput block mode 4
Input data count 4
Cutput data count 4
Input data update count 0
W]
D
U]
U]

5780

Cutput data update count
Tranzfer mode

IRQ input DMA finished count
IRQ output DMA finished count

Figure 105: Extended Diagnosis CC-Link Slave > CCLINK_APS > DPM data exchange

Name

Description

Input block size

Size of the Input Data Image (cyclic data from the network)
The default size of the input data image is 5760 byte.

Input block mode

Handshake mode of the input data block supported by the protocol stack, to synchronize

process data exchange with the host application.

0x00 For compatibility reasons, This value is identical to 0x04 - Buffered Host
Controlled 10 Data Transfer

0x02 Buffered Device Controlled 10 Data Transfer

0x03 Uncontrolled Mode

0x04 Buffered Host Controlled IO Data Transfer

Output block size

Size of the Output Data Image (cyclic data to the network)
The default size of the output data image is 5760 byte.

Output block mode

Handshake mode of the output data blocks, see Input block mode

Input data count

Current Number of input data in bytes

Output data count

Current Number of output data in bytes

Input data update
count

The total data count of input data in bytes
(Counter for updating the input data)

Output data update
count

The total data count of input data in bytes
(Counter for updating the output data)

Transfer mode

DPM (Dual-Port Memory), DMA (Direct Memory Access)

IRQ input DMA
finished count

The data count of IRQ input data in bytes when DMA is finished.

IRQ output DMA
finished count

The data count of IRQ output data in bytes when DMA s finished.

Table 132: Extended Diagnosis CC-Link Slave > CCLINK_APS > DPM data exchange
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8.3.4.14 CCLINK_APS/Rotary Switch

Hotary switch

Task states

Mame Value

Flags 0
Address switch no
Baud switch n
Configured address 0
Current address 0
Configured baudrate 0
Current baudrate 0

Figure 106: Extended Diagnosis CC-Link Slave > CCLINK_APS > Rotary Switch

Name Description

[Service] Diagnosis counter: Indicates the services processed. (The services of the single packets are
described in the CC-Link Slave Protocol APl manual [7].)

Address switch “yes” means: The station address is configured at the address switch,

(only for COMX 10XX-CCS/CCS).
“no” means: The station address is configured in the configuration software.

Baud switch “yes” means: The baudrate is configured at the baudrate switch,
(only for COMX 10XX-CCS/CCS).

“no” means: The baudrate is configured in the configuration software.
Table 133: Extended Diagnosis CC-Link Slave > CCLINK_APS > Rotary Switch
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8.3.5 CompoNet Slave
8.35.1 Overview CompoNet Slave

Dialog Panes “Extended Diagnosis” CompoNet Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

Navigation Area Folder Name in the Dialog Pane Manual
CompoNet Slave* Navigation Area Page
Navigation area = |CPNSlave CPNSlave/Initialization Diagnostic 210
[Z7) Diagnosis CPNSlave/Link Diagnostic 211

=3 Extended Diagnosis

{3 Ry_SYSTEM CPNSlave/Command Diagnostic 212
Task Information
IniBatch Skatus —
IniBakch Skatus | For the description of further tasks refer to 220
InBatch Status ! 's:ectl?.n Descriptions for Tasks with similar
IniBatch Status unctions.
IniBakch Status " -
InBatch Status The displayed CompoNet Slave exteded

diagnosis corresponds to the CompoNet Slave

3 DPM_COMD_SMEX firmware version 1.0.x.x.

Task Information
=5 DPM_COMO_RMES

Task Information
23 cPuslave

Task Information

Initialization Diagnaostic

Link, Diagnaostic

Command Diagnostic
25 CPuSlavespp

Task Information
-3 MARSHALLER,

Task Information
=5 PACKET_ROUTER

Task Information

Table 134: Descriptions of the Dialog Panes Extended Diagnosis CompoNet Slave
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8.3.5.2 CPNSlave/Initialization Diagnostic
Task skates
Marme | Yalue
System Flags 0
Wakchdog Yalue 1000
Baud R.ate Auto Baudrate
Mode Type Compalet In/Mix Slave
Mode MAC Id 2
Input Length 4
Cutput Length 4
Enable Flags 47
Configuration Flags 0
Yendor Id 283
Praduct Type 12
Product Code 513
Minar Revision 1
Major Revision 1
Serial Mumber 20003
Product Mame Hilscher Compomlet Slawve
Figure 107: Extended Diagnosis CompoNet Slave > CPNSlave > Initialization Diagnostic
Name Description

System Flags

Display of the current value of the system flags. Currently always zero (0)

Watchdog Value

The set value of the watchdog time. The value zero (0) means the watchdog must not be
activated. A value greater than zero (0) indicates the watchdog time.

Baudrate Baud rate of the CompoNet connection
Node Type Node type of the CompoNet Slave
Node MAC Id The MAC ID defines the CompoNet address of the device within the network

Input Length

Input length: number of input bits, value range: 2 ... 256 bits

Output Length

Initial length: number of output bits, value range: 2 ... 256 hits

Enable Flags

Number of enabled flags, which will use a default value (default)

Configuration Flags

Number of configuration flags, which must be configured

Vendor ID Identification number of the manufacturer
Product Type Communication Adapter
Product Code Product code of the device, according to manufacturer's instructions

Minor Revision

Minor Revision of the task

Major Revision

Major Revision of the task

Serial Number

Serial number of the device

Product Name

The variable product name is a string (text string), which is a short description of the product /
product family.

Table 135: Extended Diagnosis CompoNet Slave > CPNSlave > Initialization Diagnostic
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8.3.5.3 CPNSlave/Link Diagnostic

Task skates

Marme | Yalue

Qutput Frames Received

Input Frames Received
Confirmation Frames Received
Trigger Frames Received

A-Event Frames Received

B-Ewvent Frames Received

Beacon Frames Received

CRiC Errar Counker

Codding Errar Counker

R Cverflow Counter

Rejected frames because of the lack of resource
Metwaork Tirmeaut Counker

IMITZ Skate Entrance Counker
OFFLIME State Entrance Counter
LOCKED Skate Enkrance Counter
EVEMTOMLY Stake Entrance Counker
OMLIME Stake Entrance Counkter
COM FALLT Stake Entrance Counker
Input Frames Sent Counker
Corfirmaitan Frames Sent Counter
A-Event BUSY Sent Counter
A-Event ACK Sent Counter

A-Event POLL Sent Counter
BE-Event BUSY Sent Counter
A-Event ACK Sent Counkter

Input Buffer Empty Counker

Cukput Buffer Full Counter

=

o I e o Y e e O e o O e R e Y e e O s e O e e e R e T e e e Y e T e e e o |

Figure 108: Extended Diagnosis CompoNet Slave > CPNSlave > Link Diagnostic

Name Description

[Service] Diagnosis counter of the Link Diagnostic layer. Indicates the services processed. (The
services of the single packets are described in the CompoNet Slave Protocol APl manual
[12][12].)

Table 136: Extended Diagnosis CompoNet Slave > CPNSlave > Link Diagnostic
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8.35.4 CPNSlave/Command Diagnostic
Task skates
Marme Yalue

=

Application Reqgister Request
Application Reqgisker Confir,. .
Skart/Stop Reguest
SkarkfSkap Confirmatian
Initialize Request

Initialize Confirmation

Set Bus Parametters Request
Set Bus Parametkers Confir, ..
(zet Bus Parametters Fequek
A-Event Frames With Mo R...
A-Event Frames Sending-3t. ..
A-Ewent Frames Sending-C...
Input Tipple-Buffer Updates
Cutput Tipple-Buffer Updates
Ilpdate Inputs Counter
Ilpdate Qukputs Counter
Input Events Counter

Resets Performed

WakchDog Timeouts
Wakchdog Confirmation Fail. ..
Unknown Counker Expired
Cyilic Routine Counter
Get-Packets Failures
Send-Packets Failures

o R e N Y s e s e N e s e e e e I e s e o

Figure 109: Extended Diagnosis CompoNet Slave > CPNSlave > Command Diagnostic

Name Description

[Service] Diagnosis counter of the Command Diagnostic layer. Indicates the services processed. (The
services of the single packets are described in the CompoNet Slave Protocol APl manual
[12] [12])

Get-Packet Failures Number of errors during requesting a packet

Send Packet Failures Number of errors during sending a packet

Table 137: Extended Diagnosis CompoNet Slave > CPNSlave > Command Diagnostic
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8.4 Serial Protocols

8.4.1 3964R Slave
84.1.1 Overview 3964R Slave

Dialog Panes “Extended Diagnosis” R3964 Slave

The table below gives an overview for the Extended Diagnhosis dialog
panes descriptions:

Navigation Area Folder Name in the | Dialog Pane Manual
3964R Navigation Area Page
Mavigai P3964RStack P3964R Stack/Initialization Diagnosis 214
avigation area E
(27 Diagnosis P3964R Stack/Stack State and Error 215
% | E<tended Diagnosis Diagnosis
{3 P39E4RStack P3964R Stack/Stack Command 217
ki Task Information Diagnosis
Intislization Disgnosis — I'5ag/ptack P3964R App/Application Command 218
Stack State and Errar Diagnaosis Diagnosis

Stack Command Diagnosis
23 PI9E4RADD
Task Information
Application Command Diagnosis

#%, | For the description of further tasks refer |220
[ D—i\l | to section Descriptions for Tasks with
@ | similar Functions on page 220.

Table 138: Descriptions of the Dialog Panes Extended Diagnosis R3964 Slave
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8.4.1.2 P3964R Stack/Initialization Diagnosis

Task stakes

Mame | Yalue
Syskem Flags 1]
Wakchdog Time 1000 msec
Communication Mode Handshake Mode
Praduck Marme MT100
IART Interface Rsz3z2
RTS OFF

JART Baud Rate Aa00bps
UART Data Bits g

UJART Stop Bits 1

UART Parity Mone
3964R, Prioriky High
3964R. Retry Linik &

3964R, Character Delay Time 220 msec
3964F, Acknowledae Delay Time 550 msec
Receive Buffer Size 32 Bytes
Transmit Buffer Size 32 Bytes

Figure 110: Extended Diagnosis R3964 Slave > P3964R Stack > Initialization Diagnosis

Name

Description

System Flags

Shows the current value of the System Flags. currently always zero (0).

Watchdogtime

Shows the configured watchdogtime. A value of zero (0) means, that no monitoring
(no watchdog) was activated. A value greater than zero (0) shows the
watchdogtime.

Communication Mode

Shows the configured Communication Mode.
Possible value(s): Handshake Mode

Product Name

Shows the configured product name

UART Interface

Shows the configured interface type. Possible values: RS232, RS422, RS485.

RTS

Shows the configured setting for RTS control. Possible values: On, Off

UART Baud Rate

Shows the configured baud rate

UART Data Bits

Shows the configured value of data bits

UART Stop Bits

Shows the configured value of stop bits

UART Parity

Shows the configured parity. Possible values: None, even, odd

3964R Priority

Shows the configured priority. Possible values: High, low

3964R Retry Limit

Shows the configured value for retry limit

3964R Character Delay Time

Shows the configured value for character delay time

3964R Acknowledge Delay Time

Shows the configured value of acknowledge delay time

Receive Buffer Size

Shows the configured size of the receive buffer

Transmit Buffer Size

Shows the configured size of the send buffer

Table 139: Extended Diagnosis R3964 Slave > P3964R Stack > Initialization Diagnosis
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8.4.1.3 P3964R Stack/Stack State and Error Diagnosis

Task skates

Mame

Stack State

Sent Telegrams
Received Telearams
Send Rekries

UART Parity Errors
UART Break, Errors
UART Frame Errors
UART Owerrun Errars
Lask Recepkion Errar

R, Frame koo long
R, DLE not doubled

R, Checksum error

1]
1]
1]
u]
1]
1]
1]
1]
0
1]
1]
1]
R, Character Delay Time elapsed 0
1]
1]
0
1]
1]
1]
1]
1]
1]
1]
1]

Init Conflicks (High Priority)
Init Conflicts {Lowe Priority)

00000000

R, wrong characker received in idle skate

R, Mo memory segment available

Lask Transmissian Errar

T¥, Received MAK ak connection cleardown

T, Received MAK at connection buildup

Ti, Transmission aborted by receiver

T, Acknowledge timeout {connection buildup)

T, Acknowledge timeout {connection cleardown)
T, Daka transmission interrupted

Ti, received wrong character{oonneckion buildup)
T#, received wrong characker{connection cleardown)

00000000

Figure 111: Extended Diagnosis R3964 Slave > P3964R Stack > Stack State and Error
Diagnosis

Name

Description

Stack State

Shows the current state of the stack. Possible values:
Not initialized, Ready, Stopped,

TX, Sent STX, wait for DLE

TX, Sent Data, wait for DLE

TX, Send data (no DLE)

TX, Send data (doubling DLE)

TX, Send ETX

TX, Send BCC

RX, Sent DLE, wait for data

RX, Wait for 2nd DLE or ETX

RX, Wait for BCC

Wait for memory segment

Wait for character timeout and send NAK

Sent Telegrams

Number of telegrams sent

Received Telegrams

Number of telegrams received

Send Retries

Number of Send Retries

Init Conflicts (High Priority)

Number of '"How many Initialization Conflicts occured at high priority’

Init Conflicts (Low Priority)

Number of '"How many Initialization Conflicts occured at low priority

UART Parity Errors

Number of parity errors

UART Break Errors

Number of break errors
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Name

Description

UART Frame Errors

Number of frame errors

UART Overrun Errors

Number of overrun errors

Last Reception Error

Last occurred reception error

RX, wrong character received in
idle state

Number of wrong received character in idle state

RX, Frame too long

Number of frames, which were too long

RX, DLE not doubled

Number of DLE not doubled (second DLE was not received)

RX, Character Delay Time
elapsed

Number of elapsed character delay time

RX, Checksum error

Number of checksum errors occured while receiving

RX, No memory segment
available

Number of 'no receive buffer available’ while receiving

Last Transmission Error

Last occurred send error

TX, Received NAK at connection
cleardown

Number of received NAK at connection cleardown

TX, Received NAK at connection
buildup

Number of received NAK at connection buildup

TX, Transmission aborted by
receiver

Number of transmission aborted by receiver

TX, Acknowledge timeout
(connection buildup)

Number of acknowledge timeout during connection buildup

TX, Acknowledge timeout
(connection cleardown)

Number of acknowledge timeout during connection cleardown

TX, Data transmission interrupted

Number of interrupted data transmission

TX, received wrong character
(connection buildup)

Number of wrong received character during connection buildup

TX, received wrong character
(connection cleardown)

Number of wrong received character during connection cleardown

Table 140: Extended Diagnosis R3964 Slave > P3964R Stack > Stack State and Error
Diagnosis

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices

DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Extended Diagnosis

217/266

8.4.1.4

P3964R Stack/Stack Command Diagnosis

Task skates

Marne

Yalue

Set Config Requests

Set Config Cnf Posikiy

Set Config Cnf Megative
heck Config Requests
Check Canfig Cnf Positive
Check Caonfig Cnf Megative
Reset Requests

Reset Znf Positive

Reset Cnf Megative

Send Data Requesks

Send Data Cnf Positive
Send Data Cnf Megative
Receive Data Indications
Receive Data Res Positive
Receive Data Res Megative
hange State Regquests
“hange Stake Cnf Positive
Change Stake Cnf Megative
Receive Error Indications
Receive Errar Cnf Positive
Receive Error Cnf Megative

—
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Figure 112: Extended Diagnosis R3964 Slave > P3964R Stack > Stack Command

Diagnosis

Name

Description

Set Config Requests

Number of received 'Set Config Requests’ packets

Set Config Cnf Positiv

Number of send 'Set Config Confirmation Positiv’ packets

Set Config Cnf Negative

Number of send 'Set Config Confirmation Negative’ packets

Check Config Requests

Number of received 'Check Config Requests’ packets

Check Config Cnf Positiv

Number of send 'Check Config Confirmation Positiv’ packets

Check Config Cnf Negative

Number of send 'Check Config Confirmation Negative’ packets

Reset Requests

Number of received 'Reset Requests’ packets

Reset Cnf Positiv

Number of send 'Reset Confirmation Positiv’ packets

Reset Cnf Negative

Number of send 'Reset Confirmation Negative’ packets

Send Data Requests

Number of received 'Send Data Requests’ packets

Send Data Cnf Positiv

Number of send 'Send Data Confirmation Positiv’ packets

Send Data Cnf Negative

Number of send 'Send Data Confirmation Negative’ packets

Receive Data Indications

Number of send 'Receive Requests’ packets

Receive Data Res Positiv

Number of received 'Receive Confirmation Positiv’ packets

Receive Data Res Negative

Number of received 'Receive Confirmation Negative’ packets

Change State Requests

Number of received 'Change Requests’ packets

Change State Cnf Positiv

Number of send 'Change State Confirmation Positiv’ packets

Change State Cnf Negative

Number of send 'Change State Confirmation Negative’ packets

Receive Error Indications

Number of send 'Receive Indications’ packets

Receive Error Res Positiv

Number of received ' Receive Error Response Positiv’ packets

Receive Error Res Negative

Number of received 'Receive Error Response Negative’ packets

Table 141: Extended Diagnosis R3964 Slave > P3964R Stack > Stack Command Diagnosis
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8.4.1.5

P3964R App/Application Command Diagnhosis

Task skates

Marne Yalue

=

Resek Requests

Resek Cnf Positive

Reset Znf Megative

Buffer Space Requests

Buffer Space Cnf Positive
Buffer Space Cnf Megative
Channel Init Requests
Channel Init Cnf Positive
Channel Init Cnf Megative

Set Config Requests

Set Config Cnf Positive

Set Config Cnf Negative

Send Daka Reguests

Send Daka Cnf Positive

Send Daka Cnf Megative
Receive Data Indicakions
Receive Data Res Positive
Receive Dakta Res Megative
Receive Error Indications

R Lock)Unlock Requests

R Stark/Stop Requests

Fox Gek WD kirne Requesks
F.cx Sel WD Lime Reguests
Rrx Regisker Application Requests
R Unregisker Application Requests
Rcx Gek DPM IO Size Requests
Rrx Delete Config Requests

oo oo oo oo o o000 00— = O = oO0000

Figure 113: Extended Diagnosis R3964 Slave > P3964R App > Application Command

Diagnosis

Name

Description

Reset Requests

Number of received 'Reset Requests’ packets

Reset Cnf Positiv

Number of send 'Reset Confirmation Positiv’ packets

Reset Cnf Negative

Number of send 'Reset Confirmation Negative’ packets

Buffer Space Requests

Number of send 'Buffer Space Requests’ packets

Buffer Space Cnf Positiv

Number of send 'Buffer Space Confirmation Positiv’ packets

Buffer Space Cnf Negative

Number of received 'Buffer Space Confirmation Negative’ packets

Channel Init Requests

Number of received 'Channel Init Requests’ packets

Channel Init Cnf Positiv

Number of send 'Channel Init Confirmation Positiv’ packets

Channel Init Cnf Negative

Number of send 'Channel Init Confirmation Negative’ packets

Set Config Requests

Number of received 'Set Config Requests’ packets

Set Config Cnf Positiv

Number of send 'Set Config Confirmation Positiv’ packets

Set Config Cnf Negative

Number of send 'Set Config Confirmation Negative’ packets

Send Data Requests

Number of send 'Send Data Requests’ packets

Send Data Cnf Positiv

Number of received 'Send Data Confirmation Positiv’ packets

Send Data Cnf Negative

Number of received 'Send Data Confirmation Negative’ packets

Receive Data Indications

Number of received 'Receive Data Indications’ packets

Receive Data Res Positiv

Number of send 'Receive Data Response Positiv’ packets

Receive Data Res Negative

Number of send 'Receive Data Response Negative’ packets

Receive Error Indications

Number of received 'Receive Error Indications’ packets
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Name Description

Rcx Lock/Unlock Requests Number of received 'Rcx Lock/Unlock Requests’ packets

Rcx Start/Stop Requests Number of received 'Rcx Start/Stop Requests’ packets

Rcx Get WD time Requests Number of received 'Rcx Get WD time Requests’ packets

Rcx Set WD time Requests Number of received 'Rcx Set WD time Requests’ packets

Rcx Register Application Number of received 'Rcx Register Application Requests’ packets

Requests

Rcx Unregister Application Number of received 'Rcx Unregister Application Requests’ packets

Requests

Rcx Get DPM IO Size Requests | Number of received 'Rcx Get DPM 10 Size Requests’ packets

Rcx Delete Config Requests Number of received 'Rcx Delete Config Requests’ packets
Table 142: Extended Diagnosis R3964 Slave > P3964R App > Application Command
Diagnosis
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8.5 Descriptions for Tasks with similar Functions

8.5.1 Overview on the Descriptions
The following table provides an overview on the descriptions of the dialog
panes Extended Diagnosis for tasks with similar functions
Task Group Task or Description Manual
Page
Task Information Task Information 220
IniBatch Status IniBatch Status 221
General Diagnosis Information General Diagnosis Information 222
Code Diagnosis Code Diagnosis 223
TCPUDP IP Information 224
IP Packet Counter 225
IP Code Diagnosis 226
TCP_UDP Information 227
TCP_UDP Code Diagnosis 228
Table 143: Descriptions of the Dialog Panes Extended Diagnosis for Tasks with similar
Functions
8.5.2 Descriptions
8.5.2.1 Task Information
Task states
Mare YWalue
Identifier
m;]s: :::rr:il;';' I'The displaved vaines depehd frok the
Maxirmum Packet size Correspanding taskf
Cefault Que
Inique identifier
Init result
Figure 114: Extended Diagnosis > [Folder Name] > Task Information, Example
Name Description
Identifier Identification number of the task

Major version

Task version, contains incompatible changes

Minor version

Task version, contains compatible changes

Maximum package size Maximum package size, which the task sends

Default Queue

Queue handle, which is accessible via DPM by mailbox.

UuID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g.
to a stack (therein different identification data are coded in).
Init result Error Code, 0= no Error

The description of the error codes can be found in this manual or in the
corresponding software reference manuals.

Table 144: Extended Diagnosis > [Folder Name] > Task Information
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8.5.2.2 IniBatch Status

Task-Status
Mame | Yalue
Communication Channel
Current Skake Error
IniBatch Resulk Mo DEM File
CpenDbm Resulk 24975
SendPacket Result n
Caonfirmation Resulk 1]
Last Packet Mumber 1]
Last Packet Command 1]
Lask Packet Length n
Last Packet Destination 1]

Figure 115: Extended Diagnosis > [Folder Name] > IniBatch Status, Example

Name Description

Communication Channel

Number of the communication channel used by the device.

Current State

Idle;
IniBatch packets in progress;
Retrying to send last packet;
Error

IniBatch Result

Ok;

No DBM file;

No Packet table;

No data set available;

Data set is shorter than packet length;
Packet Buffer is shorter than Packet length;
Invalid packet destination;

Logical queue not defined

Send packet failed;

Too many retries;

Error in confirmation packet status

OpenDbm Result

Error when opening the IniBatch data base

Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM
file" (1) is.

SendPacket Result

Error when sending a packet

Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send
packet failed" (8) is.

Confirmation Result

Confirmation error when sending packets

Under "Confirmation Result" the package specific error code from the ulSta is typed in,
when "IniBatch Result " == "Error in confirmation packet status" (10) is.

Last Packet Number

Value depends by the communication system

Last Packet Command

Value depends by the communication system

Last Packet Length

Value depends by the communication system

Last Packet Destination

Value depends by the communication system

Table 145: Extended Diagnosis > [Folder Name] > IniBatch Status, Example Display

The task status "Confirmation Result" is bus specific. The other task

statuses are rcx-related error codes.
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8.5.2.3 General Diagnosis Information
Task skates
Marne | Yalue
Last TLR. Error Code Cperation succeeded.,

Lask PMIO error code

active PM Counter

Mallac Errar Counter

Calls of PoolPacketGet

Send Packet Error Counter

ErrExternal (Received unsupported Requests)
ErrInternal (Received unsupported Confirmations)

Calls of PoolPacketRelzase
Mazimunn Mumber of Poaol Packets in simultaneous use
Actual number of Pool Packets in use

Cperation succeeded,

TLR. Error Counter {maw count single error several times!) n
PMIC Error Counker (may count singe errar several bimes

[ I s I o O o I o R e e R e Y Y e

Figure 116: Extended Diagnosis > [Folder Name] > General Diagnaosis Information

Name

Description

Last TLR error code

Error code of the last internally occurred error

Last PNIO error code

Error code of the last externally occurred error which has been reported by an 10
Device.

TLR Error Counter (may count
single error several times!)

Counts the number of occurred TLR error codes.

PNIO Error Counter (may count
single error several times!)

Counts the number of occurred PNIO error codes.

Active PM Counter

Counter of the active protocol machines in the task.

Send Packet Error Counter

Counts how often a task sends a packet to another task and this fails.

Malloc Error Counter

Counts how often storage capacity is requested in the operating system and the
operating system cannot follow this demand.

ErrExternal (Received
unsupported Requests)

Counts how often an unknown request packet was received.

Errinternal (Received
unsupported Confirmations)

Counts how often an unknown confirmation packet was received.

Calls of PoolPacketGet*

Counts how many packets are retrieved from the pool.

Calls of PoolPacketRelease*

Counts how many packets are given back to the pool.

Maximum Number of Pool
Packets in simultaneous use*

Counts how many pool elements were used simultaneously as a maximum.

Actual number of Pool Packets
in use*

Counts how many pool elements are used currently.

*Not used for the diagnosis task ,T_RPC".

Table 146: Extended Diagnosis > [Folder Name] > General Diagnosis Information

netSLAVE DTM for Hilscher netX Slave Devices | Configuration of Hilscher Slave Devices

DOCO0808010I19EN | Revision 19 | English | 2017-03 | Released | Public

© Hilscher, 2008-2017



Extended Diagnosis

223/266

8.5.24

Code Diagnosis

Task states

Marme | Yalue

Info counker
\Warning counker

Error lewvel covrespohding task]
Error code

Parameter

Line number

Module

Error counter I'The displayved vaines depend from the

Figure 117: Extended Diagnosis > [Folder Name] > Code Diagnosis, Example

Name

Description

Info Counter

Counter for information reports

Warning Counter

Counter for warning reports

Error Counter

Counter for errors

Error Level Level of the last occurred error

Error Code Code of the last occurred error
Parameter Additional information to the error

Line number Line number inside the software module
Module Software module

Table 147: Extended Diagnosis > [Folder Name] > Code Diagnosis
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8.5.25 IP Information
IP Information
Task states

Mame Value

Task State 1

Error Count 4

Last Error 0xCO070150

IF Address 10.11.5.17

Met Mask 255,255.0.0

Gateway 10.11.0.10

IF Config source DHCP server

Figure 118: Extended Diagnosis > [Folder Name] > IP Information, Example

Name

Description

Task State

Actual state of the protocol process:

0 = Task not initialized
1 = Task is running

2 = Task initialized

3 = Initialization error

Error Counter

Counter for errors

Last Error Last occurred error (Description see appropriate manual)
IP Address IP address of the Slave station

Net Mask Network mask of the Slave station

Gateway Gateway address of the Slave station

IP Config source

Possible source:

- None

- DHCP server

- BOOTP server

- Database, Warmstart packe
- ICMP (Ping)

- Hilscher Netldent Protocol

Table 148: Extended Diagnosis > [Folder Name] > IP Information
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8.5.2.6 IP Packet Counter

Task skates

Mame YWalue

Packet Recy TCP 0
Packet Recy LDP

Packet Recy ICMP

Packet Recy IP Header Err
Packet Recy ARP

Packet Recy Unknown

o oo oo

Figure 119: Extended Diagnosis > [Folder Name] > IP Packet Counter, Example

Name Description

Packet Recv TCP Counter for received TCP packets

Packet Recv UDP Counter for received UDP packets

Packet Recv ICMP Counter for received ICMP packets

Packet Recv IP Header Err Counter for received IP packets with errors
Packet Recv ARP Counter for received ARP packets

Packet Recv Unknown Counter for received packets of an unknown type

Table 149: Extended Diagnosis > [Folder Name] > IP Packet Counter
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8.5.2.7 IP Code Diagnosis

Task skates

Mame Yalue
Information Counker 1

\Warning Counter 0

Error Counker 0

Severity Level Infarmation
Code 1]
Parameter 691

Module TcpTaskF
Line Mumber A9l

Figure 120: Extended Diagnosis > [Folder Name] > IP-Code Diagnosis, Example

Name Description

Information Counter Counter for information reports

Warning Counter Counter for warning reports

Error Counter Counter for errors

Severity Level Level of the last occurred error

Code Code of the last occurred error
Parameter Additional information to the error
Module Software module

Line number Line number inside the software module

Table 150: Extended Diagnosis > [Folder Name] > IP-Code Diagnosis
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8.5.2.8 TCP_UDP Information
Task states
Mame Yalue
Task State 1
Error Counker 10
Lask Errar OxC00s00352

Figure 121: Extended Diagnosis > [Folder Name] > TCP_UDP-Information, Example

Name Description

Task State Actual state of the protocol process:

0 = Task not initialized
1 = Task is running

2 = Task initialized

3 = Initialization error

Error Count Counter for errors

Last Error Last occurred error (Description see appropriate manual)

Table 151: Extended Diagnosis > [Folder Name] > TCP_UDP-Information
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8.5.2.9 TCP_UDP Code Diagnosis

Task skates

Mame Yalue
Information Counter 0
‘Warning Counter 1]
Error Counker 1]
Severity Level Mone
Code i}
Patarneker 1]
Module

Line Mumber n

Figure 122: Extended Diagnosis > [Folder Name] > TCP_UDP Code Diagnosis Example,

Display
Name Description
Information Counter Counter for information reports
Warning Counter Counter for warning reports
Error Counter Counter for errors
Severity Level Level of the last occurred error
Code Code of the last occurred error
Parameter Additional information to the error
Module Software module
Line number Line number inside the software module

Table 152: Extended Diagnosis > [Folder Name] > TCP_UDP Code Diagnosis
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Tools
9 Tools
9.1 Overview Tools

Under Tools the Packet Monitor and the IO Monitor are provided for test

and diagnosis purposes.

Tools Panes

The table below gives an overview for the individual Tools dialog panes

descriptions:

netSLAVE DTM Folder Name / Section

Manual Page

230

E Packet Monitor
10 Monitor

M avigation area
|7 piagnosis
|7 Extended Diagnosis
=3 additional taals
= P acket monitar
I Manikar
Navigation Area - Tools

233

Table 153: Descriptions of the Diagnosis Panes

Online Connection to the Device

device. For further information, refer
Connecting/Disconnecting Device on page 123.

Note: Accessing the Tools panes of the netSLAVE DTM requires an
online connection from the netSLAVE DTM to the PROFIBUS DP Slave

section  section
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9.2 Packet Monitor

The Packet Monitor serves for test and diagnosis purposes.

Data packets, i. e. messages are self-contained blocks of defined data
length. The packets are used to communicate with the firmware and they
are exchanged between the application (configuration software) and the
firmware in the device. Packets can be sent once or cyclically to the
connected device controlled by the user and packets received can be
displayed.

Data packets comprise from a Packet Header and the Send Data or from
a Packet Header and the Receive Data. The packet header can be
evaluated by the receiver of the packet and contain the sender and receiver
address, the data length, an ID number, status and error messages and the
command or response code. The minimum packet size amounts 40 Byte
for the packet header. The sending and receiving data are added.

For further information to the packet description refer to the Protocol API
Manual.

» Open the Packet Monitor via Tools > Packet Monitor.

Display mode:  |Hexadecimal j

Send

Packet header Send data: Counter: 0

Disk: ||:||:||:||:||:||:||:||:| ﬂ 00 01|02 03|04 05|06 07 08 09|
i Goooooms Gonooooo {000 K.

Sk [l ufniuluuln} Skate: Qooooooo 0004

Dest ID: | 00000000 Crnd: 00000000 0014

SrcID: | 00000000 Exk: 00000000 ome
n0za
Len: Qoooona Rouk: oooooooa 003z
ID: Doo000o0 fuko Increment I0 W |003C b’
Puk cyilic | | Put packet

Receive
Facket header Receive data: Counker: 0

Desk: | 00 m 020304 05 08 07 02 03 ~

Skc: Skate: gggﬁ o

Desk 10 Zrnd: a4
Exck: 0mnE
R.ouk: ILEs

St ID:
Len:
10

no0zz

no3Cc w

Figure 123: Packet Monitor

Display Mode switches the representation of the send and reception data
between decimal and hexadecimal.

» Select Reset Counter to reset the packet counter.
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9.2.1 Sending Packet
Send
Packet header Send data: Counter: 0
Dist: | Q0000001 j I:IL 1 (2 |3 [4 |5 |6 [7 |8 |9 |~
ook
Src: Qooaoooo Stake: Qoooaooa 10
Dest ID: | 00000000 Cmd: 0000ZF00 a0
SrcID: | OOO00000 00000000 30
a0
Len: oooooo12 Foowk: Qoooaooa e
ID: 00000001 Auko Increment 100 W |B0 bt
Puk cylic | | Puk packet
Figure 124: Send > Packet Header and Send Data
Packet Header
Under Send > Packet Header the elements of the packet header of the
sending packet are displayed, which is transmitted from the application
(configuration software) to the device. The packet header of the sending
packets contain the elements described in the following table.
Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task
queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest Destination Queue Reference | Contains an identifier for the receiver of unsolicited sent packets from the
ID firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in Bytes) | Length of the send respectively receive data.
ID Packet Identification As Identifies identical data packets among each other.
Unique Number
State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 154: Descriptions Packet Header

» Under Dest select the receiver (destination task queue).
» Under Cmd select the command identification (Request).

Auto Increment ID is an increment for the identifier of the data packets
and increments the ID by 1 for each newly sent packet.

Send Data

» Under Send > Send data enter the send data of the packet, which shall
be transmitted from the application (configuration software) to the
mailbox of the device. The meaning of the transmitted data depends on
the command or response code.
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Sending Packets once or cyclic
» To send packet once, select Put packet.
» To send packet cyclic, select Put cyclic.
9.2.2 Receiving Packet
Receive
Facket header Receive data: Counter; 0
Dest: | 00000001 0 J1 [2]3 [4 15 [6 |7 |8 |9 |4
Sect 0ooooooa Stake: |IIIIIIEIIIIIIIEIEIIII 0 #2000 00 00 00 00 00 00 00 04
10 |00 00 01 00 01 00 0o oo
Dest ID: | Q0000000 Crnd: |EIEIEIEIEFEII 20
Src I uluinlulnluinln] Exk: | u/uluulnululn] 30
Len: 0ooooo12 Rout: | 00o0aooa ;g
ID: 0000003E &0 3
Figure 125: Packet Header and Receive Data
Packet Header
Under Receive > Packet Header the elements of the packet header of the
receiving packet are displayed, which are transmitted back from the device
to the application (configuration software). The packet header of the
receiving packets contain the elements described in the following table.
Element Description
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task
queue of the firmware).
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).
Dest ID Destination Queue Reference | Contains an identifier for the receiver of unsolicited sent packets from
the firmware to the application (configuration software).
Src ID Source Queue Reference Contains an identifier of the sender.
Len Packet Data Length (in Bytes) | Length of the send respectively receive data.
ID Packet Identification As Identifies identical data packets among each other.
Unique Number
State Status / Error Code Transmits status or error codes to the packet sender.
Cmd Command / Response Code Command or respond code.
Ext Extension Field for extensions (reserved).
Rout Routing Information Internal value of the firmware.

Table 155: Descriptions Packet Header

Receive Data

Under Receive > Receive Data the receiving data of the packet, which is
transmitted back from the device to the application (configuration software)

are displayed.
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9.3 10 Monitor

The IO Monitor serves for test and diagnosis purposes. It provides to view
data of the process data image and to change output data easily. The
display is always in a Byte manner.

_) Note: Only change and write output data if you know that no plant
disturbances are caused by this. All output data written by the IO Monitor
are transmitted at the bus and have effect on subordinate drives, IO etc.

Caolumns: ﬂ Display mode:  |Decimal ﬂ

Intput data
Offset: 0 @0

iIS

=
=

10
20
a0
40

a0
i

s IR e Y e Y e Y e } D:K:';;_n.
o0 o O O O Ong
o0 O O O OOy
s N e e Y e I R s Y e SO
R e e Y e [ e Y e e R
oo o oo o oOm
e [ e R e N O s Y e P
s N e e Y e I e O s Y e
R e i e Y e [ e Y e R e T

0
0
0
0
0
n

Output data

Offsek: | 0 G0

0 0
20 0
30 0
40 0
1]
n

50
Fil

DDDDDDIEI_L
T e T s Y e s Y e Y e Y
s I T s e Y s I s Y s Y
oo oo o O O
R e s e ) e Y e Y e R
oo o oo o aOm
s I T s e Y I s Y s P
oo oo oo O m
R e s e ) e Y e Y e T

W

Update

Figure 126: 10 Monitor

Columns switches the number of columns.

Display mode switches the representation of the input and output data
between decimal and hexadecimal.

Offset / Go moves the indication of the data to the entered offset value.
» Enter the output value and select Update.

2 Always the data of the process image are displayed, also when these
Bytes have not been reserved by the configuration.
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10 Error Codes

10.1 Error Code Definition

For COM based application, like the ODM Server and ODM drivers, a
common error definition is used, similar to the Microsoft Windows®
HRESULT definition.

Error Code Structure:

COM Errors are HRESULTSs, which are 32 bit values using the following
layout:

3322222222221111111111
10987654321098765432109876543210

e e RS = +
|Sev|C|R] Facility | Code |
e e RS = +
where

Sev - is the severity code:

00 - Success
01 - Informational

10 - Warning

11 - Error
C - is the Customer code flag
R - is a reserved bit
Facility - is the facility code

Code

is the facility"s status code

In this common error definition, several error code regions are already
reserved by Windows® itself, the ODM and some other modules.
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10.2 Overview Error Codes

Overview Error Codes Range
General Hardware Errors | RCX General Task: 0xC02B0001 to 0OxC02B4D52
RCX Operating System " gy common Status & Errors Codes: 0x00000000 to 0xC002000C
RCX Status & Error Codes: 0x00000000 to 0xC0000008
ODM Server General ODM Error Codes: 0x8004C700 to 0x8004C761
General ODM Driver Error Codes: 0x8004C7A0 to 0x8004C7C2
ODM Drivers cifX Driver Specific ODM Error; 0x8004C001 to 0x8004C0A4
cifX Device Driver Generic Error: 0xX800A0001 bis 0x800A0017
and netX Driver Generic Driver Error: 0x800BO0O1 bis0x800B0042
Generic Device Error: 0x800C0010 his0x800C0041
netX Driver CIFX API Transport: 0x800D0001 bis 0x800D0013
CIFX API Transport Header State Error: 0xX800E0001 bis 0xX800EO00B
DBM ODM Error Codes: 0xC004C810 to 0xC004C878

Table 156: Overview Error Codes and Ranges
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10.3 General Hardware Error Codes

10.3.1 RCX General Task Errors

Error Code (Definition) Value Description
RCX_E_QUE_UNKNOWN 0xC02B0001 Unknown Queue
RCX_E_QUE_INDEX_UNKNOWN 0xC02B0002 Unknown Queue Index
RCX_E_TASK_UNKNOWN 0xC02B0003 Unknown Task
RCX_E_TASK_INDEX_UNKNOWN 0xC02B0004 Unknown Task Index
RCX_E_TASK_HANDLE_INVALID 0xC02B0005 Invalid Task Handle
RCX_E_TASK_INFO_IDX_UNKNOWN 0xC02B0006 Unknown Index
RCX_E_FILE_XFR_TYPE_INVALID 0xC02B0007 Invalid Transfer Type
RCX_E_FILE_REQUEST_INCORRECT 0xC02B0008 Invalid File Request
RCX_E_TASK_INVALID 0xC02B000E Invalid Task

RCX_E_SEC_FAILED 0xC02B001D Security EEPROM Access Failed
RCX_E_EEPROM_DISABLED 0xC02B001E EEPROM Disabled
RCX_E_INVALID_EXT 0xC02BO001F Invalid Extension
RCX_E_SIZE_OUT_OF_RANGE 0xC02B0020 Block Size Out Of Range
RCX_E_INVALID_CHANNEL 0xC02B0021 Invalid Channel
RCX_E_INVALID_FILE_LEN 0xC02B0022 Invalid File Length
RCX_E_INVALID_CHAR_FOUND 0xC02B0023 Invalid Character Found
RCX_E_PACKET_OUT_OF_SEQ 0xC02B0024 Packet Out Of Sequence
RCX_E_SEC_NOT_ALLOWED 0xC02B0025 Not Allowed In Current State
RCX_E_SEC_INVALID_ZONE 0xC02B0026 Security EEPROM Invalid Zone
RCX_E_SEC_EEPROM_NOT_AVAIL 0xC02B0028 Security EEPROM Eeprom Not Available
RCX_E_SEC_INVALID_CHECKSUM 0xC02B0029 Security EEPROM Invalid Checksum
RCX_E_SEC_ZONE_NOT_WRITEABLE 0xC02B002A Security EEPROM Zone Not Writeable
RCX_E_SEC_READ_FAILED 0xC02B002B Security EEPROM Read Failed
RCX_E_SEC_WRITE_FAILED 0xC02B002C Security EEPROM Write Failed
RCX_E_SEC_ACCESS_DENIED 0xC02B002D Security EEPROM Access Denied
RCX_E_SEC_EEPROM_EMULATED 0xC02B002E Security EEPROM Emulated
RCX_E_INVALID_BLOCK 0xC02B0038 Invalid Block
RCX_E_INVALID_STRUCT_NUMBER 0xC02B0039 Invalid Structure Number
RCX_E_INVALID_CHECKSUM 0xC02B4352 Invalid Checksum
RCX_E_CONFIG_LOCKED 0xC02B4B54 Configuration Locked
RCX_E_SEC_ZONE_NOT_READABLE 0xC02B4D52 Security EEPROM Zone Not Readable

Table 157: RCX General Task Errors
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10.3.2 RCX Common Status & Errors Codes

Error Code (Definition) Value Description

RCX_S _OK 0x00000000 Success, Status Okay
RCX_E_FAIL 0xC0000001 Fail
RCX_E_UNEXPECTED 0xC0000002 Unexpected
RCX_E_OUTOFMEMORY 0xC0000003 Out Of Memory
RCX_E_UNKNOWN_COMMAND 0xC0000004 Unknown Command
RCX_E_UNKNOWN_DESTINATION 0xC0000005 Unknown Destination
RCX_E_UNKNOWN_DESTINATION_ID 0xC0000006 Unknown Destination ID
RCX_E_INVALID_PACKET_LEN 0xC0000007 Invalid Packet Length
RCX_E_INVALID_EXTENSION 0xC0000008 Invalid Extension
RCX_E_INVALID_PARAMETER 0xC0000009 Invalid Parameter
RCX_E_WATCHDOG_TIMEOUT 0xC000000C Watchdog Timeout
RCX_E_INVALID_LIST_TYPE 0xC000000D Invalid List Type
RCX_E_UNKNOWN_HANDLE 0xCOO00000E Unknown Handle
RCX_E_PACKET_OUT_OF_SEQ 0xCO000000F Out Of Sequence
RCX_E_PACKET_OUT_OF MEMORY 0xC0000010 Out Of Memory
RCX_E_QUE_PACKETDONE 0xC0000011 Queue Packet Done
RCX_E_QUE_SENDPACKET 0xC0000012 Queue Send Packet
RCX_E_POOL_PACKET_GET 0xC0000013 Pool Packet Get
RCX_E_POOL_GET_LOAD 0xC0000015 Pool Get Load
RCX_E_REQUEST_RUNNING 0xCO000001A Request Already Running
RCX_E_INIT_FAULT 0xC0000100 Initialization Fault
RCX_E_DATABASE_ACCESS_FAILED 0xC0000101 Database Access Failed
RCX_E_NOT_CONFIGURED 0xC0000119 Not Configured
RCX_E_CONFIGURATION_FAULT 0xC0000120 Configuration Fault
RCX_E_INCONSISTENT_DATA_SET 0xC0000121 Inconsistent Data Set
RCX_E_DATA_SET_MISMATCH 0xC0000122 Data Set Mismatch
RCX_E_INSUFFICIENT_LICENSE 0xC0000123 Insufficient License
RCX_E_PARAMETER_ERROR 0xC0000124 Parameter Error
RCX_E_INVALID_NETWORK_ADDRESS 0xC0000125 Invalid Network Address
RCX_E_NO_SECURITY_MEMORY 0xC0000126 No Security Memory
RCX_E_NETWORK_FAULT 0xC0000140 Network Fault
RCX_E_CONNECTION_CLOSED 0xC0000141 Connection Closed
RCX_E_CONNECTION_TIMEOUT 0xC0000142 Connection Timeout
RCX_E_LONELY_NETWORK 0xC0000143 Lonely Network
RCX_E_DUPLICATE_NODE 0xC0000144 Duplicate Node
RCX_E_CABLE_DISCONNECT 0xC0000145 Cable Disconnected
RCX_E_BUS_OFF 0xC0000180 Network Node Bus Off
RCX_E_CONFIG_LOCKED 0xC0000181 Configuration Locked
RCX_E_APPLICATION_NOT_READY 0xC0000182 Application Not Ready
RCX_E_TIMER_APPL_PACKET_SENT 0xC002000C Timer App Packet Sent

Table 158: RCX Common Status & Errors Codes
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10.3.3 RCX Status & Error Codes

Error Code (Definition) Value Description

RCX_S_OK 0x00000000 SUCCESS, STATUS OKAY
RCX_S_QUE_UNKNOWN 0xC02B0001 UNKNOWN QUEUE
RCX_S_QUE_INDEX_UNKNOWN 0xC02B0002 UNKNOWN QUEUE INDEX
RCX_S_TASK_UNKNOWN 0xC02B0003 UNKNOWN TASK
RCX_S_TASK_INDEX_UNKNOWN 0xC02B0004 UNKNOWN TASK INDEX
RCX_S_TASK_HANDLE_INVALID 0xC02B0005 INVALID TASK HANDLE
RCX_S_TASK_INFO_IDX_UNKNOWN 0xC02B0006 UNKNOWN INDEX
RCX_S_FILE_XFR_TYPE_INVALID 0xC02B0007 INVALID TRANSFER TYPE
RCX_S_FILE_REQUEST_INCORRECT 0xC02B0008 INVALID FILE REQUEST
RCX_S_UNKNOWN_DESTINATION 0xC0000005 UNKNOWN DESTINATION
RCX_S_UNKNOWN_DESTINATION_ID 0xC0000006 UNKNOWN DESTINATION ID
RCX_S_INVALID_LENGTH 0xC0000007 INVALID LENGTH
RCX_S_UNKNOWN_COMMAND 0xC0000004 UNKNOWN COMMAND
RCX_S_INVALID_EXTENSION 0xC0000008 INVALID EXTENSION

Table 159: RCX Status & Error Codes

10.3.3.1 RCX Status & Error Codes Slave State

Error Code (Definition) Value Description
RCX_SLAVE_STATE_UNDEFINED 0x00000000 UNDEFINED
RCX_SLAVE_STATE_OK 0x00000001 OK
RCX_SLAVE_STATE_FAILED 0x00000002 FAILED (at least one slave)

Table 160: RCX Status & Error Codes Slave State
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10.4 ODM Error Codes

10.4.1 General ODM Error Codes

Error Code (Definition) Value Description
CODMS3_E_INTERNALERROR 0x8004C700 Internal ODM Error
ODM3_E_DESCRIPTION_NOTFOUND 0x8004C701 Description not found in ODM database
CODM3_E_WRITEREGISTRY 0x8004C710 Error writing to the registry
CODM3_E_BAD_REGULAR_EXPRESSION 0x8004C711 Invalid regular expression
CODM3_E_COMCATEGORIE_MANAGER_ 0x8004C712 Component Category Manager could not
FAILED be instantiated
CODM3_E_COMCATEGORIE_ENUMERATION_ 0x8004C713 Driver could not be enumerated by the
FAILED Category Manager
CODM3_E_CREATE_LOCAL_BUFFER 0x8004C714 Error creating local buffers
CODM3_E_UNKNOWNHANDLE 0x8004C715 Unknown handle
CODM3_E_QUEUE_LIMIT_REACHED 0x8004C717 Queue size limit for connection reached
CODM3_E_DATASIZE_ZERO 0x8004C718 Zero data length passed
CODMS3_E_INVALID_DATA 0x8004C719 Invalid data content
CODM3_E_INVALID_MODE 0x8004C71A Invalid mode
CODM3_E_DATABASE_READ 0x8004C71B Error reading database
CODM3_E_CREATE_DEVICE_THREAD 0x8004C750 Error creating device thread
CODM3_E_CREATE_DEVICE_THREAD_STOP_ 0x8004C751 Error creating device thread stop event
EVENT
CODM3_E_CLIENT_NOT_REGISTERED 0x8004C752 Client is not registered at the ODM
CODM3_E_NO_MORE_CLIENTS 0x8004C753 Maximum number of clients reached
CODM3_E_MAX_CLIENT_CONNECTIONS _ 0x8004C754 Maximum number of client connections
REACHED reached
CODM3_E_ENTRY_NOT_FOUND 0x8004C755 Driver/device not found
CODM3_E_DRIVER_NOT_FOUND 0x8004C757 The requested driver is unknown to the
ODM
CODM3_E_DEVICE_ALREADY_LOCKED 0x8004C758 Device is locked by another process
CODM3_E_DEVICE_UNLOCKED_FAILED 0x8004C759 Device could not be unlocked, lock was
set by another process
CODM3_E_DEVICE_LOCK_NECCESSARY 0x8004C75A Operation requires a device lock to be set
CODM3_E_DEVICE_SUBSCRIPTIONLIMIT 0x8004C75B Maximum number of servers registered for
this device reached
CODM3_E_DEVICE_NOTSUBSCRIBED 0x8004C75C Process is not registered as a server on
this device
CODM3_E_DEVICE_NO_MESSAGE 0x8004C75D No message available
CODM3_E_TRANSFERTIMEOUT 0x8004C760 Message transfer timeout
CODM3_E_MESSAGE_INSERVICE 0x8004C761 Message in service
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10.4.2 General ODM Driver Error Codes

Error Code (Definition) Value Description
CODM3_E_DRV_OPEN_DEVICE 0x8004C7A0 Packet type unsupported by driver
CODM3_E_DRV_INVALID_IDENTIFIER 0x8004C7A1 Invalid device identifier
CODM3_E_DRV_DEVICE_PARAMETERS _ 0x8004C7A3 Parameters differ from requested device
MISMATCH

CODM3_E_DRV_BROWSE_NO_DEVICES 0x8004C7A4 No devices found
CODM3_E_DRV_CREATE_DEVICE_INST 0x8004C7A5 Device instance could not be created
CODM3_E_DRV_DEVICE_NOMORE_TX 0x8004C7A6 Device connection limit reached
CODM3_E_DRV_DEVICE_DUPLICATE_TX 0x8004C7A7 Duplicate transmitter ID
CODM3_E_DRV_DEVICE_NOT_CONFIGURED 0x8004C7A8 Device is not configured
CODM3_E_DRV_DEVICE_COMMUNICATION 0x8004C7A9 Device communication error
CODM3_E_DRV_DEVICE_NO_MESSAGE 0x8004C7AA No message available
CODM3_E_DRV_DEVICE_NOT_READY 0x8004C7AB Device not ready
CODM3_E_DRV_INVALIDCONFIGURATION 0x8004C7AC Invalid driver configuration
CODM3_E_DRV_DLINVALIDMODE 0x8004C7CO Invalid download mode
CODM3_E_DRV_DLINPROGRESS 0x8004C7C1 Download is active
CODM3_E_DRV_ULINPROGRESS 0x8004C7C2 Upload is active

Table 162: ODM Error Codes - General ODM Driver Error Codes
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10.4.3

cifX Driver Specific ODM Error Codes

cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_BOARD_NOT_INITIALIZED 0x8004C001 DRIVER Board not initialized
DRV_E_INIT_STATE_ERROR 0x8004C002 DRIVER Error in internal init state
DRV_E_READ_STATE_ERROR 0x8004C003 DRIVER Error in internal read state
DRV_E_CMD_ACTIVE 0x8004C004 DRIVER Command on this channel is
active
DRV_E_PARAMETER_UNKNOWN 0x8004C005 DRIVER Unknown parameter in function
DRV_E_WRONG_DRIVER_VERSION 0x8004C006 DRIVER Version is incompatible with DLL
DRV_E_PCI_SET_CONFIG_MODE 0x8004C007 DRIVER Error during PCI set configuration
mode
DRV_E_PCI_READ_DPM_LENGTH 0x8004C008 DRIVER Could not read PCI dual port
memory length
DRV_E_PCI_SET_RUN_MODE 0x8004C009 DRIVER Error during PCI set run mode
DRV_E_DEV_DPM_ACCESS_ERROR 0x8004C00A DEVICE Dual port ram not
accessable(board not found)
DRV_E_DEV_NOT_READY 0x8004C00B DEVICE Not ready (ready flag failed)
DRV_E_DEV_NOT_RUNNING 0x8004C00C DEVICE Not running (running flag failed)
DRV_E_DEV_WATCHDOG_FAILED 0x8004C00D DEVICE Watchdog test failed
DRV_E_DEV_OS_VERSION_ERROR 0x8004CO0O0E DEVICE Signals wrong OS version
DRV_E_DEV_SYSERR 0x8004CO0F DEVICE Error in dual port flags
DRV_E_DEV_MAILBOX_FULL 0x8004C010 DEVICE Send mailbox is full
DRV_E_DEV_PUT_TIMEOUT 0x8004C011 DEVICE PutMessage timeout
DRV_E_DEV_GET_TIMEOUT 0x8004C012 DEVICE GetMessage timeout
DRV_E_DEV_GET_NO_MESSAGE 0x8004C013 DEVICE No message available
DRV_E_DEV_RESET_TIMEOUT 0x8004C014 DEVICE RESET command timeout
DRV_E_DEV_NO_COM_FLAG 0x8004C015 DEVICE COM-flag not set. Check if Bus is
running
DRV_E_DEV_EXCHANGE_FAILED 0x8004C016 DEVICE I/O data exchange failed
DRV_E_DEV_EXCHANGE_TIMEOUT 0x8004C017 DEVICE 1/O data exchange timeout
DRV_E_DEV_COM_MODE_UNKNOWN 0x8004C018 DEVICE 1/O data mode unknown
DRV_E_DEV_FUNCTION_FAILED 0x8004C019 DEVICE Function call failed
DRV_E_DEV_DPMSIZE_MISMATCH 0x8004CO01A DEVICE DPM size differs from
configuration
DRV_E_DEV_STATE_MODE_UNKNOWN 0x8004C01B DEVICE State mode unknown
DRV_E_DEV_HW_PORT_IS_USED 0x8004C01C DEVICE Output port already in use
DRV_E_USR_OPEN_ERROR 0x8004CO1E USER Driver not opened (device driver not
loaded)
DRV_E_USR_INIT_DRV_ERROR 0x8004CO1F USER Can't connect to device
DRV_E_USR_NOT_INITIALIZED 0x8004C020 USER Board not initialized (DevinitBoard
not called)
DRV_E_USR_COMM_ERR 0x8004C021 USER IOCTRL function failed
DRV_E_USR_DEV_NUMBER_INVALID 0x8004C022 USER Parameter DeviceNumber invalid
DRV_E_USR_INFO_AREA_INVALID 0x8004C023 USER Parameter InfoArea unknown
DRV_E_USR_NUMBER_INVALID 0x8004C024 USER Parameter Number invalid
DRV_E_USR_MODE_INVALID 0x8004C025 USER Parameter Mode invalid
DRV_E_USR_MSG_BUF_NULL_PTR 0x8004C026 USER NULL pointer assignment
DRV_E_USR_MSG_BUF_TOO_SHORT 0x8004C027 USER Message buffer too small
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cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_USR_SIZE_INVALID 0x8004C028 USER Parameter Size invalid
DRV_E_USR_SIZE_ZERO 0x8004C02A USER Parameter Size with zero length
DRV_E_USR_SIZE_TOO_LONG 0x8004C02B USER Parameter Size too long
DRV_E_USR_DEV_PTR_NULL 0x8004C02C USER Device address null pointer
DRV_E_USR_BUF_PTR_NULL 0x8004C02D USER Pointer to buffer is a null pointer
DRV_E_USR_SENDSIZE_TOO_LONG 0x8004CO02E USER Parameter SendSize too large
DRV_E_USR_RECVSIZE_TOO_LONG 0x8004CO2F USER Parameter ReceiveSize too large
DRV_E_USR_SENDBUF_PTR_NULL 0x8004C030 USER Pointer to send buffer is a null
pointer
DRV_E_USR_RECVBUF_PTR_NULL 0x8004C031 USER Pointer to receive buffer is a null
pointer
DRV_E_DMA_INSUFF_MEM 0x8004C032 DMA Memory allocation error
DRV_E_DMA_TIMEOUT_CH4 0x8004C033 DMA Read I/O timeout
DRV_E_DMA_TIMEOUT_CH5 0x8004C034 DMA Write 1/O timeout
DRV_E_DMA_TIMEOUT_CH®6 0x8004C035 DMA PCI transfer timeout
DRV_E_DMA_TIMEOUT_CH7 0x8004C036 DMA Download timeout
DRV_E_DMA_DB_DOWN_FAIL 0x8004C037 DMA Database download failed
DRV_E_DMA_FW_DOWN_FAIL 0x8004C038 DMA Firmware download failed
DRV_E_CLEAR_DB_FAIL 0x8004C039 DMA Clear database on the device failed
DRV_E_DEV_NO_VIRTUAL_MEM 0x8004C03C DMA USER Virtual memory not available
DRV_E_DEV_UNMAP_VIRTUAL_MEM 0x8004C03D DMA USER Unmap virtual memory failed
DRV_E_GENERAL_ERROR 0x8004C046 DRIVER General error
DRV_E_DMA_ERROR 0x8004C047 DRIVER General DMA error
DRV_E_WDG_IO_ERROR 0x8004C048 DRIVER I/0 WatchDog failed
DRV_E_WDG_DEV_ERROR 0x8004C049 DRIVER Device Watchdog failed
DRV_E_USR_DRIVER_UNKNOWN 0x8004C050 USER Driver unknown
DRV_E_USR_DEVICE_NAME_INVALID 0x8004C051 USER Device name invalid
DRV_E_USR_DEVICE_NAME_UKNOWN 0x8004C052 USER Device name unknown
DRV_E_USR_DEVICE_FUNC_NOTIMPL 0x8004C053 USER Device function not implemented
DRV_E_USR_FILE_OPEN_FAILED 0x8004C064 USER File could not be opened
DRV_E_USR_FILE_SIZE_ZERO 0x8004C065 USER File size zero
DRV_E_USR_FILE_NO_MEMORY 0x8004C066 USER Not enough memory to load file
DRV_E_USR_FILE_READ_FAILED 0x8004C067 USER File read failed
DRV_E_USR_INVALID_FILETYPE 0x8004C068 USER File type invalid
DRV_E_USR_FILENAME_INVALID 0x8004C069 USER Invalid filename
DRV_E_FW_FILE_OPEN_FAILED 0x8004C0O6E USER Firmware file could not be opened
DRV_E_FW_FILE_SIZE_ZERO 0x8004C06F USER Not enough memory to load
firmware file
DRV_E_FW_FILE_NO_MEMORY 0x8004C070 USER Not enough memory to load
firmware file
DRV_E_FW_FILE_READ_FAILED 0x8004C071 USER Firmware file read failed
DRV_E_FW_INVALID_FILETYPE 0x8004C072 USER Firmware file type invalid
DRV_E_FW_FILENAME_INVALID 0x8004C073 USER Firmware file name not valid
DRV_E_FW_DOWNLOAD_ERROR 0x8004C074 USER Firmware file download error
DRV_E_FW_FILENAME_NOT_FOUND 0x8004C075 USER Firmware file not found in the
internal table
DRV_E_FW_BOOTLOADER_ACTIVE 0x8004C076 USER Firmware file BOOTLOADER active
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cifX Driver Specific ODM Error Codes

Error Code (Definition) Value Description
DRV_E_FW_NO_FILE_PATH 0x8004C077 USER Firmware file no file path
DRV_E_CF_FILE_OPEN_FAILED 0x8004C078 USER Configuration file could not be
opend
DRV_E_CF_FILE_SIZE_ZERO 0x8004C079 USER Configuration file size zero
DRV_E_CF_FILE_NO_MEMORY 0x8004CO7A USER Not enough memory to load
configuration file
DRV_E_CF_FILE_READ_FAILED 0x8004C07B USER Configuration file read failed
DRV_E_CF_INVALID_FILETYPE 0x8004C07C USER Configuration file type invalid
DRV_E_CF_FILENAME_INVALID 0x8004C07D USER Configuration file name not valid
DRV_E_CF_DOWNLOAD_ERROR 0x8004CO7E USER Configuration file download error
DRV_E_CF_FILE_NO_SEGMENT 0x8004CO7F USER No flash segment in the
configuration file
DRV_E_CF_DIFFERS_FROM_DBM 0x8004C080 USER Configuration file differs from
database
DRV_E_DBM_SIZE_ZERO 0x8004C083 USER Database size zero
DRV_E_DBM_NO_MEMORY 0x8004C084 USER Not enough memory to upload
database
DRV_E_DBM_READ_FAILED 0x8004C085 USER Database read failed
DRV_E_DBM_NO_FLASH_SEGMENT 0x8004C086 USER Database segment unknown
DEV_E_CF_INVALID_DESCRIPT_VERSION 0x8004C096 CONFIG Version of the descript table
invalid
DEV_E_CF_INVALID_INPUT_OFFSET 0x8004C097 CONFIG Input offset is invalid
DEV_E_CF_NO_INPUT_SIZE 0x8004C098 CONFIG Input size is 0
DEV_E_CF_MISMATCH_INPUT_SIZE 0x8004C099 CONFIG Input size does not match
configuration
DEV_E_CF_INVALID_OUTPUT_OFFSET 0x8004C09A CONFIG Invalid output offset
DEV_E_CF_NO_OUTPUT_SIZE 0x8004C09B CONFIG Output size is 0
DEV_E_CF_MISMATCH_OUTPUT_SIZE 0x8004C09C CONFIG Output size does not match
configuration
DEV_E_CF_STN_NOT_CONFIGURED 0x8004C09D CONFIG Station not configured
DEV_E_CF_CANNOT_GET_STN_CONFIG 0x8004C09E CONFIG Cannot get the Station
configuration
DEV_E_CF_MODULE_DEF_MISSING 0x8004C09F CONFIG Module definition is missing
DEV_E_CF_MISMATCH_EMPTY_SLOT 0x8004C0A0 CONFIG Empty slot mismatch
DEV_E_CF_MISMATCH_INPUT_OFFSET 0x8004C0A1 CONFIG Input offset mismatch
DEV_E_CF_MISMATCH_OUTPUT_OFFSET 0x8004C0A2 CONFIG Output offset mismatch
DEV_E_CF_MISMATCH_DATA_TYPE 0x8004CO0A3 CONFIG Data type mismatch
DEV_E_CF_MODULE_DEF_MISSING_NO_SI 0x8004C0A4 CONFIG Module definition is missing,(no

Slot/ldx)

Table 163: cifX Driver Specific ODM Error Codes
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10.5 Error Codes cifX Device Driver and netX Driver

10.5.1 Generic Error Codes

Error Code (Definition) Value Description
CIFX_INVALID_POINTER 0x800A0001 Invalid pointer (NULL) passed to driver
CIFX_INVALID_BOARD 0x800A0002 No board with the given nameindex
available
CIFX_INVALID_CHANNEL 0x800A0003 No channel with the given index available
CIFX_INVALID_HANDLE 0x800A0004 Invalid handle passed to driver
CIFX_INVALID_PARAMETER 0x800A0005 Invalid parameter
CIFX_INVALID_COMMAND 0x800A0006 Invalid command
CIFX_INVALID_BUFFERSIZE 0x800A0007 Invalid buffer size
CIFX_INVALID_ACCESS_SIZE 0x800A0008 Invalid access size
CIFX_FUNCTION_FAILED 0x800A0009 Function failed
CIFX_FILE_OPEN_FAILED 0x800A000A File could not be opened
CIFX_FILE_SIZE_ZERO 0x800A000B File size is zero
CIFX_FILE_LOAD_INSUFF_MEM 0x800A000C Insufficient memory to load file
CIFX_FILE_CHECKSUM_ERROR 0x800A000D File checksum compare failed
CIFX_FILE_READ_ERROR 0x800A000E Error reading from file
CIFX_FILE_TYPE_INVALID 0x800A000F Invalid file type
CIFX_FILE_NAME_INVALID 0x800A0010 Invalid file name
CIFX_FUNCTION_NOT_AVAILABLE 0x800A0011 Driver function not available
CIFX_BUFFER_TOO_SHORT 0x800A0012 Given buffer is too short
CIFX_MEMORY_MAPPING_FAILED 0x800A0013 Failed to map the memory
CIFX_NO_MORE_ENTRIES 0x800A0014 No more entries available
CIFX_CALLBACK_MODE_UNKNOWN 0x800A0015 Unkown callback handling mode
CIFX_CALLBACK_CREATE_EVENT_FAILED 0x800A0016 Failed to create callback events
CIFX_CALLBACK_CREATE_RECV_BUFFER 0x800A0017 Failed to create callback receive buffer
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10.5.2 Generic Driver Error Codes

Error Code (Definition) Value Description
CIFX_DRV_NOT_INITIALIZED 0x800B0001 Driver not initialized
CIFX_DRV_INIT_STATE_ERROR 0x800B0002 Driver init state error
CIFX_DRV_READ_STATE_ERROR 0x800B0003 Driver read state error
CIFX_DRV_CMD_ACTIVE 0x800B0004 Command is active on device
CIFX_DRV_DOWNLOAD_FAILED 0x800B0005 General error during download
CIFX_DRV_WRONG_DRIVER_VERSION 0x800B0006 Wrong driver version
CIFX_DRV_DRIVER_NOT_LOADED 0x800B0030 CIFx driver is not running
CIFX_DRV_INIT_ERROR 0x800B0031 Failed to initialize the device
CIFX_DRV_CHANNEL_NOT_INITIALIZED 0x800B0032 Channel not initialized (xOpenChannel not
called)
CIFX_DRV_IO_CONTROL_FAILED 0x800B0033 I0Control call failed
CIFX_DRV_NOT_OPENED( 0x800B0034 Driver was not opened
CIFX_DRV_DOWNLOAD_STORAGE_UNKNOWN | 0x800B0040 Unknown download storage type
(RAMFLASH based) found
CIFX_DRV_DOWNLOAD_FW_WRONG_CHANNE | 0x800B0041 Channel number for a firmware download
L not supported
CIFX_DRV_DOWNLOAD_MODULE_NO_BASEOS | 0x800B0042 Modules are not allowed without a Base

OS firmware

Table 165: Generic Driver Error Codes
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10.5.3 Generic Device Error Codes

Error Code (Definition) Value Description
CIFX_DEV_DPM_ACCESS_ERROR 0x800C0010 Dual port memory not accessable (board
not found)
CIFX_DEV_NOT_READY 0x800C0011 Device not ready (ready flag failed)
CIFX_DEV_NOT_RUNNING 0x800C0012 Device not running (running flag failed)
CIFX_DEV_WATCHDOG_FAILED 0x800C0013 Watchdog test failed
CIFX_DEV_SYSERR 0x800C0015 Error in handshake flags
CIFX_DEV_MAILBOX_FULL 0x800C0016 Send mailbox is full
CIFX_DEV_PUT_TIMEOUT 0x800C0017 Send packet timeout
CIFX_DEV_GET_TIMEOUT 0x800C0018 Receive packet timeout
CIFX_DEV_GET_NO_PACKET 0x800C0019 No packet available
CIFX_DEV_MAILBOX_TOO_SHORT 0x800C001A Mailbox too short
CIFX_DEV_RESET_TIMEOUT 0x800C0020 Reset command timeout
CIFX_DEV_NO_COM_FLAG 0x800C0021 COM-flag not set
CIFX_DEV_EXCHANGE_FAILED 0x800C0022 10 data exchange failed
CIFX_DEV_EXCHANGE_TIMEOUT 0x800C0023 10 data exchange timeout
CIFX_DEV_COM_MODE_UNKNOWN 0x800C0024 Unknown IO exchange mode
CIFX_DEV_FUNCTION_FAILED 0x800C0025 Device function failed
CIFX_DEV_DPMSIZE_MISMATCH 0x800C0026 DPM size differs from configuration
CIFX_DEV_STATE_MODE_UNKNOWN 0x800C0027 Unknown state mode
CIFX_DEV_HW_PORT_IS_USED 0x800C0028 Device is still accessed
CIFX_DEV_CONFIG_LOCK_TIMEOUT 0x800C0029 Configuration locking timeout
CIFX_DEV_CONFIG_UNLOCK_TIMEOUT 0x800C002A Configuration unlocking timeout
CIFX_DEV_HOST_STATE_SET_TIMEOUT 0x800C002B Set HOST state timeout
CIFX_DEV_HOST_STATE_CLEAR_TIMEOUT 0x800C002C Clear HOST state timeout
CIFX_DEV_INITIALIZATION_TIMEOUT 0x800C002D Timeout during channel initialization
CIFX_DEV_BUS_STATE_ON_TIMEOUT 0x800C002E Set Bus ON Timeout
CIFX_DEV_BUS_STATE_OFF_TIMEOUT 0x800C002F Set Bus OFF Timeout
CIFX_DEV_MODULE_ALREADY_RUNNING 0x800C0040 Module already running
CIFX_DEV_MODULE_ALREADY_EXISTS 0x800C0041 Module already exists
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10.6 Error Codes netX Driver

10.6.1 CIFX API Transport Error Codes

Error Code (Definition) Value Description
CIFX_TRANSPORT_SEND_TIMEOUT 0x800D0001 Time out while sending data
CIFX_TRANSPORT_RECV_TIMEOUT 0x800D0002 Time out waiting for incoming data
CIFX_TRANSPORT_CONNECT 0x800D0003 Unable to communicate to the deviceno
answer
CIFX_TRANSPORT_ABORTED 0x800D0004 Transfer has been aborted due to keep
alive timeout or interface detachment
CIFX_CONNECTOR_FUNCTIONS_READ_ERRO 0x800D0010 Error reading the connector functions from
R the DLL
CIFX_CONNECTOR_IDENTIFIER_TOO_LONG 0x800D0011 Connector delivers an identifier longer
than 6 characters
CIFX_CONNECTOR_IDENTIFIER_EMPTY 0x800D0012 Connector delivers an empty dentifier
CIFX_CONNECTOR_DUPLICATE_IDENTIFIER 0x800D0013 Connector identifier already used

Table 167: CIFX API Transport Error Codes

10.6.2 CIFX API Transport Header State Error Codes

Error Code (Definition) Value Description
CIFX_TRANSPORT_ERROR_UNKNOWN 0x800E0001 Unknown error code in transport header
CIFX_TRANSPORT_CHECKSUM_ERROR 0x800E0002 CRC16 checksum failed
CIFX_TRANSPORT_LENGTH_INCOMPLETE 0x800E0003 Transaction with inclomplete length
detected
CIFX_TRANSPORT_DATA_TYPE_UNKOWN 0x800E0004 Device does not support requested data
type
CIFX_TRANSPORT_DEVICE_UNKNOWN 0x800E0005 Device not availableunknown
CIFX_TRANSPORT_CHANNEL_UNKNOWN 0x800E0006 Channel not availableunknown
CIFX_TRANSPORT_SEQUENCE 0x800E0007 Sequence error detected
CIFX_TRANSPORT_BUFFEROVERFLOW 0x800E0008 Buffer overflow detected
CIFX_TRANSPORT_RESOURCE 0x800E0009 Device signals out of resources
CIFX_TRANSPORT_KEEPALIVE 0x800E000A Device connection monitoring error (Keep
alive)
CIFX_TRANSPORT_DATA_TOO_SHORT( 0x800E000B Received transaction data too short

Table 168: CIFX API Transport Header State Error Codes
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10.7 ODM Error Codes DBM V4

ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_E_MD5_INVALID 0XC004C810 Checksum invalid
CDBM_E_INTERNALERROR 0XC004C811 Internal Error
CDBM_W_WRITEREGISTRY 0X8004C812 Error writing to the registry
CDBM_E_UNEXPECTED_VALUE_ 0XC004C813 Error in a file containing the old DBM
IN_OLD_HEADER_FORMAT Header format.
CDBM_E_CHECKSUM_INVALID 0XC004C814 The Checksum of the old Header is invalid
CDBM_E_DB_ALREADY_LOADED_ FORMAT 0XC004C815 A database is already loaded
CDBM_E_NO_VALID_TRANSACTION 0XC004C816 No valid transaction handle given
CDBM_E_STD_STRUCT_ERROR 0XCoo04C817 An error occurred during validation of data
CDBM_E_UNSUPPORTED_ 0XC004C818 Unsupported DataType
DATA_TYPE_FORMAT
CDBM_W_CLASS_DELETED_ FORMAT 0X8004C819 Using an Object which is marked as
(Warning) deleted
CDBM_W_CLIENT_DISCONNECTED 0X8004C81A A Client has already an outstanding
(Warning) ﬁgcvnggg?rg;gdé Table. The connection is
CDBM_E_STRUCTURE_DEFINITION_ INVALID 0XC004C81B A structure definition of an Element in a
Table is invalid
CDBM_E_NO_DATA_AVAILABLE 0XCoo4cs81C No data available for this operation
CDBM_E_NO_VALID_STRUCTURE 0XC004C81D No valid structure available for this
operation
CDBM_E_NO_TOGGLE_STRING_ FOUND 0XCO004C81E No Toggle string found for this number
CDBM_E_ELEMENT_OUT_OF_RANGE 0XCO004C81F An element wasn’t found in the Record of
a Table
CDBM_E_ELEMENT_NOT_IN_ TABLE 0XC004C820 The element is not part of the Table
CDBM_E_CANNOT_CONVERT_ 0XC004C821 The data can't be converted into the Client
INTO_CLIENT_TYPE type
CDBM_E_TRANSACTION_ ALREADY_OPEN 0XC004C822 A transaction is already open. Please
close this one first before opening a new
one.
CDBM_|_OLD_WITHOUT_HEADER 0X4004C823 Use of an old DBM file Format without
(Informational) | Header
CDBM_E_HR_FROM 0XC004C824 An HRESULT was received from a
Subroutine
CDBM_E_PARAMETER 0XC004C825 A Parameter is invalid
CDBM_E_NOTIMPL 0XC004C826 Method is currently not implemented
CDBM_E_OUTOFMEMORY 0XC004C827 Out of memory
CDBM_E_NO_OPEN_TRANSACTION 0XC004C828 No transaction open
CDBM_E_NO_CONTENTS 0XC004C829 No contents available
CDBM_REC_NO_NOT_FOUND 0XCO004C82A Record not found
CDBM_STRUCTURE_ELEMENT_ NOT_FOUND 0XC004C82B Element of the Structure not found
CDBM_E_NO_MORE_RECORDS_ IN_TABTYPE 0XCo004C82C Table type 3 can contain only one record
CDBM_E_WRITE 0XC004C82D The data in the VARIANT must be given in
a SafeArray
CDBM_E_WRITE_NO_PARRAY 0XC004C82E The VARIANT contains no valid [parray]

element
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ODM Error Codes DBM V4

Error Code (Definition) Value Description

CDBM_E_WRITE_CANT_ ACCESS_DATA 0XC004C82F Unable to access SafeArray Data in the
VARIANT

CDBM_E_WRITE_DATA 0XC004C830 To write the data of this Element it must be
given as a BSTR, or as an Array of
VT_UILNVT_I1

CDBM_E_WRITE_BSTR_E1 0XC004C831 The BSTR string must have an even
length.

CDBM_E_WRITE_BSTR_E2 0XC004C832 The BSTR string must contain only hex
digits (0..9 and a/A..f/F).

CDBM_E_WRITE_CANT_ INTERPRET_ARRAY 0XC004C833 Unable to interpret data in the SafeArray.

CDBM_E_WRITE_VT_ERROR 0XC004C834 Data type in the SafeArray is not VT_UI1
or VT_I1.

CDBM_E_WRITE_LENGTH 0XC004C835 Data length is invalid for write operation of
this type.

CDBM_WRITE_ELEMENT 0XC004C836 Element not found in the Record of the
Table

CDBM_MIN_MAX_ERROR 0XC004C837 Can't write data because of min underflow
or max overflow

CDBM_TABLE_EXIST 0XC004C838 Table already exist in the database

CDBM_MIN_MAX_INVALID 0XC004C839 The Min value is greater than the Max
Value

CDBM_DEF_MIN_MAX_INVALID 0XCO004C83A The Default Value is not in the range
between the Min value and the Max Value

CDBM_CANT_CHANGE_STRUCTURE_ 0XC004C83B It's not allowed to change the structure

WHILE_RECORDS_EXIST while Records exist in the Table

CDBM_NEW_STRUCT_NEEDS_TYPE 0XC004C83C In a newly added structure the data type
must be set also

CDBM_VALUE_ERROR 0XC004C83D Range error while validating a value

CDBM_DATATYPE_ UNSUPPORTED_IN_RCS 0XC004C83E The data type is unsupported in the RCS
file format

CDBM_I_COUNT_OF_TABLES _ 0X4004C83F The count of Tables exceeds the RCS

EXCEEDS_RCS_RANGE

(Informational)

range of Tables. This can cause problems
if the file is downloaded to RCS Systems

CDBM_|_COUNT_OF TABLES_
EXCEEDS_OLDDBM_RANGE

0X4004C840
(Informational)

The count of Tables exceeds the
DBM32.DLL range of Tables. This can
cause problems if the file is used with older
Tools using the DBM32.DLL

CDBM_UNSUPPORTED_DATATYPE_ 0XC004C841 The Data type is not compatible with the
IN_RCS_MODE old database format
CDBM_WRITE_UNSTRUCTURED_1 0XC004C842 The data of an unstructured record can
only be written with the "Write' Method not
with ‘WriteElement'.
CDBM_READ_UNSTRUCTURED_1 0XC004C843 The data of an unstructured record can
only be read with the 'Read' Method not
with '‘ReadElement'
CDBM_WRITE_DATA_LENGTH_ INVALID 0XC004C844 The given data length doesn’t correspond
with the expected data length.
CDBM_UNKNOWN_VIEW_MODE 0XC004C845 The View Mode is unknown.
CDBM_E_DIAG_TABLE 0XC004C846 It doesn’t make much sense to add or

delete records from a diagnostic table
because those changes are never saved.
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ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_E_ADR_STRING_ERROR 0XCo004C847 The given Address string doesn't fit the
required format of this type where all
address bytes must be in the range
between 0 and FF
CDBM_ERROR_FROM_VAR_ CHANGE_TYPE 0XC004C848 Function VariantChangeType return an
error when trying to convert the Parameter
CDBM_E_MINERROR 0XC004C849 Error while comparing the Value with the
lower range
CDBM_E_MAXERROR 0XC004C84A Error while comparing the Value with the
upper range
CDBM_E_RANGE_ERROR 0XC004C84B Value out of Range
CDBM_E_TABLE_TYPE1 0XCo004C84C Table type 1 doesn’'t have a unique record
length over all records
CDBM_E_TABLE_TYPE3_ ADDREC 0XC004C84D Table type 3 doesn't allow to insert more
than one Record
CDBM_E_TABTYPE1 0XC004C84E It's not allowed to insert more Records
than structure definitions in Table Type 1
CDBM_E_TOGGLE_NOT_FOUND 0XC004C84F Could not find the string for this value in
the list of valid toggle strings
CDBM_E_TOGGLE_VALUE_IS_EMPTY_STRING | 0XC004C850 The toggle string for this value is empty.
CDBM_VARIANT2BYTEARRAY_ ERROR 0XC004C851 Error during conversion of Variant to byte
array
CDBM_E_SET_ELEM_PROP_ DEPENDENCY 0XC004C852 The Toggle Type needs also the additional
string and the additional number entries in
the Method
CDBM_E_TABTYPE1_REC_ 0XC004C853 When reading the records of Table type 1
DOESNT_CORRESPOND_ WITH_ELEMENT elementwise the record number must
correspond with the element number
CDBM_TABTYPE1_NO_DATA_ 0XC004C854 When reading the records of Table type 1
FOUND_FOR_RECORD and structure definitions are present it's
assumed that for each structure element a
corresponding record must exist
CDBM_E_TABTYPE1l_WRITE_ 0XC004C855 When writing the records of Table type 1
ELEMENT_NE_RECORD elementwise and structure definitions are
present it's only allowed to write the
corresponding element number in each
record
CDBM_E_TABTYPE1l_WRITE_ 0XC004C856 When writing the records of Table type 1
ELEMENT_NOT_FOUND with an array and structure definitions are
present it's assumed that a corresponding
element number of this record exist
CDBM_I_TABLE_NAME_EXCEEDS _ 0X4004C857 The Table name exceeds the maximum
RCS_RANGE (Informational) length of RCS compatible Table names
CDBM_W_CUT_STRING 0X8004C858 The string exceeds the maximum length
(Warning) and will be limited to the maximum length
CDBM_I_STRING_TOO_SHORT 0X4004C859 The string is below the minimum length.
(Informational) The minimum length will be reduced.
CDBM_I_STRING_TOO_LONG 0X4004C85A The string is exceeding the maximum. The
(Informational) maximum length will be extended.
CDBM_E_STRING_TOO_SHORT 0XC004C85B The string is below the minimum length.
(Error)
CDBM_E_STRING_TOO_LONG 0XC004C85C The string is exceeding the maximum
(Error) length
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ODM Error Codes DBM V4

Error Code (Definition) Value Description
CDBM_E_WRONG_TYPE_ FOR_WRITE 0XC004C85D Writing on the Element type with the given
Data type is not implemented
CDBM_E_NO_APPEND_IN_ 0XC004C85E Method IDbmRecord::AppendData is not
STRUCTURED_RECORDS allowed for structured records
CDBM_E_DATA_UNAVAILABLE 0XC004C85F No data available
CDBM_E_CANT_CONVERT_ INTO 0XC004C860 Unable to convert the value into the
Element type
CDBM_E_DBM_FILE_OVERFLOW 0XC004C861 You try to write a RCS like database which
needs too much bytes
CDBM_E_PW_ERROR 0XC004C862 Password not correct
CDBM_E_FILELENGTH_CORRUPT 0XC004C863 The file length doesn’t correspond to the
length given in the Header.
CDBM_E_STRUCT_TYPE 0XC004C864 Error in the file.
CDBM_E_MD5SUM_INVALID 0XC004C865 MD5 sum invalid
CDBM_E_STRUCT_LENGTH 0XC004C866 Error in the expected and given structure
length at a specific offset in the file.
CDBM_E_APPEND 0XC004C867 Append of data is only allowed if the
Record contains only one data field and
the field type will support this
CDBM_APPEND_NOT_ SUPPORTED 0XC004C868 Append of Data not supported by this filed
type
CDBM_DATA_TYPE_APPEND_ ERROR 0XC004C869 Can't append Data of this type.
CDBM_E_UNSTRUCTURED_TABLE_ 0XCO004C86A A Table without structure information
DOESNT_SUPPORT_LENGTH doesn’t support a record length
CDBM_E_DISABLED_WHILE_ 0XC004C86B The Method is disabled while a transaction
TRANSACTION_IS_OPEN is open. Please close this one first and call
the Method again.
CDBM_E_UNABLE_TO_CALL_ 0XCo004C86C The Method is disabled on a LinkedList
READ_ON_LINKED_LIST type. Please use the IRecordCollection on
this type.
CDBM_E_ELEMENT_HAS NO_ 0XC004C86D An Element from a Table has no
SUBSTRUCTURE substructure
CDBM_STRUCT_ERROR_FROM _ 0XC004C86E Error from calling VariantChangeType
VAR_CHANGE_TYPE
CDBM_E_FOREIGNKEY_DEF 0XC004C86F The definition of a FOREIGNKEY must
contain the name of the related Table in
the description and this Table must exist at
this time
CDBM_E_FOREIGNKEY_ REF_TAB 0XC004C870 The description of a FOREIGNKEY must
refer to a Table of type
‘eDbmTableTypeLinkedList'
CDBM_E_KEY 0XC004C871 To create a Record Collection with a KEY
it's necessary to have the data type KEY at
the first position in all Records of the
searched Table
CDBM_E_KEY_TABLE_TYPE 0XC004C872 This Method needs a Table of type
‘eDbmTableTypeLinkedList'
CDBM_DATATYPE_NOT_ IMPLEMENTED 0XC004C873 This data type is currently not implemented
CDBM_INSERT_POS_NOT_ FOUND 0XC004C874 The position of the Record where the new
one should be inserted wasn't found
CDBM_E_INSERT_REC_QI 0XC004C875 Error during insertion of a Record
CDBM_E_TAB_PROP 0XC004C876 Invalid Property in Table
CDBM_E_KEY_NOT_FOUND 0XC004C877 The KEY wasn’t found in the Table
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ODM Error Codes DBM V4

Error Code (Definition)

Value

Description

CDBM_E_KEY_INVALID

0XC004C878

The KEY is invalid for this operation

Table 169: ODM Error Codes DBM V4
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11 Appendix

11.1 User Rights

User-rights are set within the FDT-container. Depending on the level the
configuration is accessible by the user or read-only.

To access the Settings, Configuration and Diagnosis panes of the
netSLAVE DTM you do not need special user rights. Also all users can
select the decimal or hexadecimal Display mode or sort table entries.

Note: To edit, set or configure the parameters of the Settings and
Configuration panes, you need user rights for Maintenance, for Planning
Engineer or for Administrator.

The following tables give an overview of the user right groups and which
user rights you need to configure the single parameters.

11.1.1 Settings

Observer Operator Maintenanc Planning Adminis-
e Engineer trator
Driver D D X X X
Verify or adapt Driver - - X X X
Settings
Configuring netX Driver - - X X X
Device Assignment D D X X X
Scanning for Devices - - X X X
Selecting the Device (with or - - X X X
without firmware)
Selecting the Device once more - - X X X
(with Firmware)
Firmware Download D D X X X
Table 170: Settings (D = Displaying, X = Editing, Configuring)
11.1.2 Configuration
Observer Operator Maintenanc Planning Adminis-
e Engineer trator
Configuration D D X X X

Table 171: Configuration (D = Displaying, X = Editing, Configuring)
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11.5 Glossary

Auto-Negotiation

Baud rate

Coil

cifxX

CSP

Auto-Negotiation is a feature of an interface: An interface with Auto-
Negotiation will automatically determine a set of correct communication
parameters.

Data transmission speed of a communication channel or interface.

A coil (in the meaning defined by Modbus terminology) is a single bit in
memory that can be accessed (i.e. read or write) via Modbus.

Communication InterFace based on netX

electronic device data sheet, required for each CC-Link device

Device Description File

DHCP

DPM

DTM

EDS

EDS file

A file containing configuration information about a device being a part of a
network that can be read out by masters for system configuration. Device
Description Files use various formats which depend on the communication
system. Often these formats are based on XML such as EDS files or
GSDML files. Contains configuration information

Dynamic Host Configuration Protocol

This is a protocol simplifying the configuration of IP networks by
automatically assigning IP addresses.

Dual-Port Memory

Device Type Manager

The Device Type Manager (DTM) is a software module with graphical user
interface for the configuration and/or for diagnosis of devices.

Electronic Data Sheet

XML based device description file.

A special kind of Device Description File used by EtherNet/IP.
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EtherCAT

EtherNet/IP

EtherNet/IP Scanner

EtherNet/IP Adapter

A communication system for industrial Ethernet designed and developed by
Beckhoff Automation GmbH.

A communication system for industrial Ethernet designed and developed by
Rockwell. It partly uses the CIP (Common Industrial Protocol).

A Scanner exchanges real-time 1/0O data with Adapters and Scanners. This
type of node can respond to connection requests and can also initiate
connections on its own.

An Adapter emulates functions provided by traditional rack-adapter
products. This type of node exchanges real-time 1/0O data with a Scanner
Class product. It does not initiate connections on its own.

Ethernet POWERLINK

FDT

Full duplex

Function code

Gateway

GSD

GSD file

A communication system for industrial Ethernet designed and developed by
B&R. It partly uses CANopen technologies.

Field Device Tool

FDT specifies an interface, in order to be able to use DTM (Device Type
Manager) in different applications of different manufacturers.

Full duplex denominates a telecommunication system between two
communication partners which allows simultaneous communication in both
directions is called a full-duplex telecommunication system. At such a
system, it is possible to transmit data even if currently data are received.
Full-duplex is the opposite of Half _duplex.

A function code (in the meaning defined by Modbus terminology) is a
standardized method to access (i.e. read or write) coils or registers via
Modbus.

A device interfacing between two different communication standards.

Generic Station Description, Device description file

A special kind of Device Description File used by PROFIBUS (GSD =
Generic Station Description).
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GSDML

GSDML file

Half duplex

Hub

Industrial Ethernet

Master

netSCRIPT

netxX

Object Dictionary

ODMV3

Open Modbus/TCP

Generic Station Description Markup Language

XML based device description file.

A special kind of XML-based Device Description File used by PROFINET.

Half duplex denominates a telecommunication system between two
communication partners which does not allow simultaneous, but
alternating, communication in both directions is called a half-duplex
telecommunication system. At such a system, receiving data inhibits the
transmission of data. Half-duplex is the opposite of _Full_duplex.

A network component connecting multiple communication partners with
each other. A hub does not provide own intelligence, thus it does not
analyze the data traffic and sends received data to all connected
communication partners. A hub can be used for setting up a star topology.

See Real-Time Ethernet

Master devices initiate the data traffic on the bus. In the communication
protocol Master devices are called active participants. A master may send
messages without external request.

Is a script-based programming language for communication devices of
Hilscher GmbH, witch allows users themselves to program flows to program
/ protocol conversions into sights.

networX on chip, next generation of communication controllers

An obiject dictionary is a storage area for device parameter data structures.
It is accessed in standardized manner.

The Online-Data-Manager Version 3 (ODMV3) is an application interface.
The ODMV3 works as a server, which can be run as an out-proc server or
system service. lIts task is to provide different applications (e.g.
SYCON.net), access to multiple devices and even share one device
amongst several applications.

A communication system for Industrial Ethernet designed and developed by
Schneider Automation and maintained by the Modbus-IDA organization
based on the Modbus protocols for serial communication.
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PROFINET

A communication system for Industrial Ethernet designed and developed by
PROFIBUS & PROFINET International (PI). It uses some mechanisms
similar to those of the PROFIBUS field bus.

PROFINET IO Controller

PROFINET 10 Device

RE

Real-Time Ethernet

Register

Sercos

Slave

Switch

A PROFINET control unit responsible for the defined run-up of an I/O
subsystem and the cyclic or acyclic data exchange.

A PROFINET field device that cyclically receives output data from its 10-
Controller and responds with its input data.

RE stands for Real Time Ethernet

Real-Time Ethernet (Industrial Ethernet) is an extension of the Ethernet
networking technology for industrial purposes with very good Real-Time
features and performance. There is a variety of different Real-Time
Ethernet systems on the market which are incompatible with each other.
The most important systems of these are

e EtherCAT

e EtherNet/IP

e Ethernet POWERLINK
e Open Modbus/TCP

e PROFINET
e Sercos
e VARAN

A register (in the meaning defined by Modbus terminology) is a 16-bit wide
storage area for data which can be accessed and addressed as a unit by
some of the Modbus Function Codes.

A communication system for industrial Ethernet designed and developed by
Bosch-Rexroth and supported by Sercos International.

Slave devices are peripheral devices, like for example 1/O devices or
drives. Slave devices are also called passive participants. They do not
receive the bus access authorization. That means, they may only accept
received messages from the Master or send a message to the Master after
enquiry of the Master.

A network component connecting multiple communication partners (or even
entire branches of a network) with each other. A switch is an intelligent
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SYNC

TCP/IP

VARAN

Watchdog Timer

XDD file

XML

network component which analyzes network traffic in order to decide on its
own. For the connected communication partners a switch behaves
transparently.

Sychronisation cycle of the master

Transport Control Protocol/Internet Protocol connection-orientated, secure
transfer protocol as basis for the Internet-protocols

Versatile Automation Random Access Network

A communication system for industrial Ethernet based on the DIAS-BUS
developed by Sigmatek. The system is supported by the VARAN-BUS-
NUTZERORGANISATION (VNO).

A watchdog timer provides an internal supervision mechanism of a
communication system. It supervises that an important event happens
within a given timeframe (the watchdog time which can be adjusted
accordingly, for instance by a parameter in the _Warmstart message) and
causes an alarm otherwise (usually this is accomplished by changing the
operational state of the communication system to a more safe state).

A special kind of Device Description file used by Ethernet POWERLINK.

XML means Extended Markup Language. It is a symbolic language for
structuring data systematically. XML is standard maintained by the W3C
(World-wide web consortium). Device Description Files often use XML-
based formats for storing the device-related data appropriately.
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11.6 Contacts

Headquarters

Germany

Hilscher Gesellschaft fiir
Systemautomation mbH
Rheinstrasse 15

65795 Hattersheim

Phone: +49 (0) 6190 9907-0
Fax: +49 (0) 6190 9907-50
E-Mail: info@hilscher.com

Support
Phone: +49 (0) 6190 9907-99
E-Mail: de.support@hilscher.com

Subsidiaries

China

Hilscher Systemautomation (Shanghai) Co. Ltd.

200010 Shanghai
Phone: +86 (0) 21-6355-5161
E-Mail: info@hilscher.cn

Support
Phone: +86 (0) 21-6355-5161
E-Mail: cn.support@hilscher.com

France

Hilscher France S.a.r.l.

69500 Bron

Phone: +33 (0) 4 72 37 98 40
E-Mail: info@hilscher.fr
Support

Phone: +33 (0) 4 72 37 98 40
E-Mail: fr.support@hilscher.com

India

Hilscher India Pvt. Ltd.
Pune, Delhi, Mumbai
Phone: +91 8888 750 777

E-Mail: info@hilscher.in

Italy

Hilscher ltalia S.r.l.

20090 Vimodrone (MI)

Phone: +39 02 25007068
E-Mail: info@hilscher.it
Support

Phone: +39 02 25007068
E-Mail: it.support@hilscher.com

Japan

Hilscher Japan KK

Tokyo, 160-0022

Phone: +81 (0) 3-5362-0521
E-Mail: info@hilscher.jp
Support

Phone: +81 (0) 3-5362-0521
E-Mail: jp.support@hilscher.com

Korea

Hilscher Korea Inc.

Seongnham, Gyeonggi, 463-400
Phone: +82 (0) 31-789-3715
E-Mail: info@hilscher.kr

Switzerland

Hilscher Swiss GmbH

4500 Solothurn

Phone: +41 (0) 32 623 6633
E-Mail: info@hilscher.ch

Support
Phone: +49 (0) 6190 9907-99
E-Mail: ch.support@hilscher.com

USA

Hilscher North America, Inc.
Lisle, IL 60532

Phone: +1 630-505-5301
E-Mail: info@bhilscher.us

Support
Phone: +1 630-505-5301
E-Mail: us.support@hilscher.com
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